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Notices

You must accept the FirstClass License Agreement before you can use this product. If you do not
accept the terms of the License Agreement, do not install the software and return the entire
package within 30 days to the place from which you obtained it for a full refund. No refunds will
be given for returned products that have missing components.

Information in this document is subject to change without notice. Certain features and products
described in this document may not be currently available in all geographic regions. Distribution
or reproduction of this document in whole or in part must be in accordance with the terms of the
License Agreement.

All rights reserved. FirstClass is a registered trademark of a Centrinity Inc. subsidiary used under
license. Centrinity, the Centrinity logo, and the FirstClass logo are trademarks of Centrinity Inc.
All other trademarks are property of their respective owners.

This edition applies to Release 7 of FirstClass and to all subsequent releases and modifications
until otherwise indicated in new editions. This document is bound by international copyright law
and the FirstClass Software License Agreement and Limited Warranty included with every
FirstClass product.

Technical support

Telephone technical support is available to registered administrators at the following numbers:
Toll free in North America: 1-800-346-9108

Toronto: 905-762-6060.

International: +353-61-725-200

Online support questions may be directed to support@centrinity.com.
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Overview

FirstClass Business Edition (FirstClass) is an easy to use,
advanced communication and information system that
integrates Internet mail and services with group conferencing,
access to existing corporate databases, forms processing, real-
time discussions, and online communications functions. Because
FirstClass takes care of modem and file transfer protocols
automatically, remote access is as easy as network access.

Depending on your objectives, you may be interested in

developing add-on applications for FirstClass systems. You can

use a variety of different Centrinity tools to achieve this end,

including: 1

» Database Toolkit
» Client Extension Toolkit
» Gateway Toolkit

* FirstClass Rapid Application Developer.

You can find these toolkits on your CD-ROM, and/or the latest
versions on Centrinity’s web site.

About this book

This book explains the procedures involved in planning, creating
and maintaining a FirstClass server environment. The book is
partitioned into the following five sections:

 Introduction

This section provides conceptual information about the
FirstClass product and the administrator’s role.

* Installing and configuring FirstClass

FirstClass 7 Administrator's Guide Business Edition 3
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This section provides requirements and instructions for
installing the various FirstClass components. It explains how
to configure your system, making it ready to be customized
for your needs.

 Planning your FirstClass environment

This section provides conceptual information about the
foundations your FirstClass system will be built upon: groups,
organizational units, privileges, Directory filtering, and Model
Desktops.

 Creating your FirstClass environment

This section provides detailed information about adding the
objects to your FirstClass system that will help you create a
unique environment that meets your organizational needs:
user groups, conferences and conference groups, group and
resource calendars, users, gateways to other FirstClass
systems, and multiple volumes.

e Maintaining your FirstClass server.

This section provides the information required for day-to-day
operation of your FirstClass server: the Server Monitor, using
log and statistics files, backups, restores, and selective
restores.

FirstClass 7 Administrator’s Guide Business Edition provides a
walkthrough of a simple system for an example company called
Husky Planes, a multi-site international company that prides
itself on its use of technology and on the combination of sound
business and communication principles.

You might find it useful to follow along in the creation process.
You can use this book as a simple tutorial, following the
procedures and creating your own copy of the Husky Planes
system. If you do so, you will end up with working versions of
key features and the experience of having created them. If you
prefer a different configuration, you can always delete the
objects you created.This is a simple setup created for illustrative
purposes. While it should help you understand some of the
principles involved in setting up a FirstClass system, it will not
provide you with a fully developed system.
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For detailed how-to descriptions of features and forms, see our
online help.

This book is meant for FirstClass administrators responsible for
maintaining a FirstClass server and Internet Services on Mac™
OS or Windows® platforms. For information on planning,
creating and maintaining Internet Services, see FirstClass
Internet Services Administrator’s Guide. For information about
FirstClass Voice Services, see FirstClass Voice Services
Administrator’s Guide.

This book is essential for administrators planning a new system
or introducing a new feature to an existing system.

You should be familiar with the capabilities and terminology for
your:

* FirstClass software (including server, client, Internet Services,
Voice Services (if applicable), and additional components)

* Mac OS or Windows operating system
 expansion cards

* Palm Computing® Connected Organizers (organizers,
handhelds, or devices) if applicable

 network protocols

 peripherals such as modem, CD-ROM, printer, hard drive,
tape drive and diskette drive.

Each level of menu items is separated by >. For example, the
Clear item under the Edit menu is shown as Edit > Clear.

Text in italics represents variables for which you must type your
own value.

FirstClass 7 Administrator's Guide Business Edition 5
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Lotus Notes/Domino Connector

The FirstClass server is now available on Mac OS X and
FirstClass clients have been introduced for Mac OS X and
Linux.

Expanded batch administration functionality.

Enhancements have been made to mirroring to make it more
efficient.

Introduction of mail rules allow you to set up rules for
automatic message handling in your Mailbox, conferences,
and calendars.

Enhanced calendar functionality and views.
Improvements to content editing using FirstClass documents.
New redirect feature improves autoforwarding capabilities.

Ability to create documents that sync to Palm(TM) Computing
connected organizers in a Memos folder

Enhancements to Explore view of the client.

The IP Network Notifier is now bundled directly with the
client installer.

Many enhancements to the web browser interface making the
experience more like the client experience.

High-performance COBRA Rules engine used to provide full
server-side rules processing with no change in server
performance.
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You can use the administrator account to send and receive mail
in your official capacity as administrator. To avoid data loss, we
recommend that you add a personal user account for yourself for
day-to-day use, and use the administrator account only for your
official duties as administrator.

You can share your administration responsibilities, if you wish.
For more information, see “Subadministrators” on page 11.

Your responsibilities as administrator

Installing and
configuring FirstClass

The icons on the administrator’s Desktop represent most of the
functions you will perform in your FirstClass system. For
information about the special objects on the administrator’s
Desktop, see “The administrator’s Desktop” on page 40. Don’t
forget, however, that you have several other responsibilities not
represented by those icons. As FirstClass administrator, your
responsibilities fall into the following four categories:

« installing and configuring the FirstClass server, and its
required components and modules

 planning your FirstClass environment
* creating your FirstClass environment

» maintaining your FirstClass environment.

The initial installation and configuration of your FirstClass
server is a quick and straightforward process. Installing and
configuring FirstClass and its components and modules involves
the following tasks:

« installing the FirstClass server, client, and Internet Services

FirstClass 7 Administrator's Guide Business Edition 7
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Your responsibilities as administrator

Planning your FirstClass

environment

Creating your FirstClass

environment
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This is described in Chapter 4, “Installing FirstClass”.
If applicable, installation instructions for Voice Services is
described in our online help.

« configuring the FirstClass server

This is described in Chapter 6, “Configuring your system”.

 adding user licenses and additional required connection
services

This is described in FirstClass Tools Reference.

« distributing FirstClass to users.

This is described in “Installing the FirstClass client” on
page 34.

The first step in creating your FirstClass online environment is

planning. You need to plan your environment so it will be easy
for users to work together securely in an interactive way. When
planning, you must consider who your users are, how they will
interact, and what types of information they will communicate
between each other. Planning a secure, easy-to-use environment
involves the following tasks:

» understanding privileges and groups and how to classify users
in your FirstClass environment.

This is described in Chapter 7, “Understanding groups,
organizational units, and privileges”.

» understanding Directory filtering and applying effective
Directory filters to the group structure you planned in the
previous task to create a secure environment

This is described in Chapter 9, “Understanding Directory
filtering”.

 understanding Model Desktops and planning and creating
effective Model Desktops for your group structure

This is described in Chapter 8, “Understanding Model
Desktops”.

Once you have planned your environment and used groups,
privileges, Directory filters and Model Desktops to ensure you
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have planned a secure FirstClass system, you will be ready to
populate your collaborative environment and then think about
expanding your FirstClass system. Creating your FirstClass
environment involves some or all of the following tasks:

 using batch administration to populate your FirstClass
environment (if necessary)

This is described in Chapter 10, “Using batch administration”.

» adding conferences, conference groups, group and resource
calendars, and users

This is described in Chapter 12, “Adding conferences and
conference groups”, Chapter 13, “Using group and resource
calendars”, and Chapter 14, “Adding users”.

» adding gateways to other FirstClass servers and modules (if
necessary)

This is described in Chapter 16, “Adding gateways”.
* partitioning your FirstClass server into multiple volumes (if
necessary) 2

This is described in Chapter 17, “Working with multiple
volumes”.

* creating a customized settings document and distributing it to
users (if necessary)

This is described in FirstClass Designer.

* creating forms and stationery (if necessary)

This is described in FirstClass Designer.

 customizing web templates (if necessary)

This is described in our online help and in FirstClass Internet
Services Administrator’s Guide.

» administrating Voice Services (if necessary).

This is described in FirstClass Voice Services Administrator’s
Guide.

Maintaining your FirstClass server maintenance involves performing a set of tasks
FirstClass environment ¢ are quick and simple to do, but can save you many hours of
worKk if there is an unexpected emergency. These tasks are:

FirstClass 7 Administrator's Guide Business Edition 9
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Checking the administrator’s email

* monitoring your system using the Server Monitor, the Session
Monitor and the various statistics and log files automatically
generated by the FirstClass server

This is described in Chapter 18, “Monitoring your system”.
» understanding trash collection

This is described in Chapter 19, “Trash collection”.
 performing regular server backups

This is described in Chapter 20, “Backing up your server”.
* restoring your FirstClass system in case of emergency

This is described in Chapter 21, “Restoring your post office”.

* selectively restoring objects in your post office using the batch
administration Export command as required

This is described in Chapter 21, “Restoring your post office”.

Checking the administrator’s email

10

Introduction

When certain events occur, FirstClass sends a message to the
FirstClass administrator. These events include:

« failure to reset a modem after 50 attempts
» gateway problems

* autoregistration of a new user

» gateway license conflicts

 duplicate aliases

 mirror failures

» messages regarding exceeding text-to-speech licensing limits
for FirstClass Unified Communications customers.

You should log into the administrator account regularly to check
for mail. The frequency you choose will depend on your system
configuration and size.

If you wish, you can set the preferences for the administrator’s
account to autoforward or redirect mail to your personal
account. To do so, choose Edit > Preferences > Messaging >
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Mail Rules. You can choose to redirect or forward items to your
personal Mailbox, or a subadministrator’s Mailbox.

Subadministrators

Subadministrator
restrictions

As administrator, you have to perform many tasks to set up and
run your FirstClass system. While you are starting out, you may
want to perform all these tasks on your own. Later on, however,
you may want to share these responsibilities by adding
subadministrators.

You can even add a subadministrator account for yourself, under
a different name. You might find this useful if you want to work
in the system without appearing in Who’s Online as
“Administrator”.

Note If you are using FirstClass client software from an
earlier release than your FirstClass server, upgrade
your client software. To log in as a user with
administrator privileges your client software must
be from the same release as your server.

Although subadministrators can perform many administrative
functions, they are limited in several ways:

» A subadministrator has access to the administrator menu but
not to the administrator’s Desktop.

* A subadministrator cannot change the administrator’s
account or assign administrator privileges to other users.

* Only the administrator can turn off the Secure All Desktops
feature.

» Some batch administration commands can be issued only by
the administrator.

* A subadministrator can use batch administration only with a
password designated by the administrator. (The
administrator can use batch administration without a
password.)

FirstClass 7 Administrator's Guide Business Edition 11
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You can assign subadministrator privileges to all members of a
user group, or to an individual person. For information about
user groups, see Chapter 7, “Understanding groups,
organizational units, and privileges”.

The default FirstClass post office contains a pre-configured user
group called Sub Admin. This group is in the Configuration
Groups section of the Groups folder on the administrator’s
Desktop. To give a user subadministrator privileges, simply
make the user a member of the Sub Admin group. This will add
the Subadministrator and Does not expire features to the user,
which gives him the ability to perform most administrative tasks,
and guarantees that his account will not expire. Adding a user to
the Sub Admin group will add the Sub Admin folder to the user’s
Desktop, giving him all the privileges required to perform his
duties as subadministrator.

The following is what the subadministrator will see when he
opens the Sub Admin folder:
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This folder contains all of the objects on the administrator’s
Desktop that a subadministrator requires. Objects that exist only
on the administrator’s Desktop are the administrator’s Mailbox
and Address Book, the hard disk folder, the FC Resource
Registry folder, the Gateways folder, and the Multi-site setup
folder. These objects contain passwords to perform the functions
associated with them and have been left off. If you want to
include any of these objects in the Sub Admin folder, do the
following:

1. Select the object you want to add to the Sub Admin folder.
2. Choose Collaborate > Add to Desktop.

3. Drag the copy of the object into the Sub Admin folder and
arrange it where you like.

Note You can delete any object, or add any objects in the
Sub Admin folder, as required.

Subadministrators can see everything on the system. Their view
of the Directory cannot be filtered. However, there are ways to
make access more difficult.

To add some additional security, you can remove two objects
from the Sub Admin folder: the Groups and General Conferences
folders. This way, subadministrators cannot readily see
confidential conferences (like management and human
resources areas). However, they can still see these objects using
the List Directory function available to all subadministrators.

Additionally, subadministrators do not have the authority to
change the Secure field on the Group Privileges or User
Information forms, nor do they have the authority to user the
EXPORT command to retrieve conference or Mailbox items.

There are two ways to find existing subadministrators:

 If you created a subadministrators by adding them to the Sub
Admin group, simply search the Directory to list all members
of that group.

FirstClass 7 Administrator's Guide Business Edition 13
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To find users who have the subadministrator privilege
selected on their User Information forms, view the Disk Usage
report (double-click Reports, then Statistics Folder, and
choose DISKUSE.TXT). The last field describing a
subadministrator contains an “A” (this report will only show
those users who were specifically granted the
subadministrator privilege on their User Information form,
not those who are granted this privilege through group
membership).

B DiskUse. txt

File Edit Format Message Collaborate ‘Wiew Admin  Help

A |B [ =lo [E |F s s
hgreen L 1] 1] 1] o

BStewvart 03 a a a u]

chorg o 1] 1] 1] a

green o 1] 1] 196 G1
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Introduction

Note Hold down the Shift key while opening the report to
open it with the table manager. Then click on the
column header to group all the As together.

In this Disk Usage report, for example, user jgerbhas
administrator privileges. For more information about the Disk
Usage report, and the meaning of the fields, see our online
help.
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FirstClass server concepts

Before you can begin working as an administrator, you must
understand the structure of the administrator’s account and how
users communicate with your server.

In this chapter, we will discuss:

» how users communicate with the server

» how sessions work

» how users connect to your system

» how to organize people and communications on your system

* how gateways can expand your FirstClass system. 3

How users communicate with the server

Users can communicate with your FirstClass server and access its
features in a variety of ways: over a network using TCP/IP, IPX,
or AppleTalk, over the telephone system using modems, over the
Internet using a variety of Internet protocols, and, if you are a
FirstClass Unified Communications customer, over the
telephone using Voice Services and its associated hardware and
software. Taking this into consideration, you should remember
a few things:

» These communication methods are all optional. You only
need to configure your system for the methods you actually
intend to use.

* Internet Services requires TCP/IP. If you do not install TCP/IP
you will not be able to run Internet Services and users will not
be able to access your server over the Internet. For informa-
tion about Internet Services, see FirstClass Internet Services
Administrator’s Guide.

FirstClass 7 Administrator's Guide Business Edition 15
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« Regular users can have the option to work offline using
FirstClass Personal. For complete details, see our online help.

* Voice Services requires additional hardware and software to
enable users to connect to the server by telephone. These are
explained in detail in FirstClass Voice Services Administrator’s
Guide.

Understanding sessions

Network sessions

Modem sessions

16

Introduction

When users log into your FirstClass server, they use sessions.
Each login is one session. The session type a user uses depends
how she logs in. If a user uses a modem to access the server, she
will use a modem session. All other access methods use network
sessions.

Network sessions are used by every user who logs into your
system, except by those who log in using a modem. Any user
logged into your FirstClass server will use a network session for
as long as they are connected. Network sessions are configured
by you and are limited by the following factors:

 your hardware capacity
 the amount of memory you have

* the type of licence you purchased:

Regular licenses allow up to 250 concurrent sessions. If you
require more network sessions, you should have the MP
option.

For minimum and recommended requirements, see “Installing
FirstClass” on page 29 and FirstClass Tools Reference.

For information about configuring network sessions, see
FirstClass Tools Reference.

The number of modem sessions is simply the number of modems
available. A modem session is the way in which you configure
the modem to work with the FirstClass server. When a user logs
in remotely through a modem configured on the FirstClass
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server, he will be using a modem session for as long as he is
connected to the modem.

For information about configuring modem sessions, see
FirstClass Tools Reference.

Understanding how users connect

There are two classes of user: Regular and Remote. When you
add a new user, you define the class on the User Information
form. For more information about adding users, see Chapter 14,
“Adding users”.

Users configured as Regular users require regular user licenses.
You can only add as many Regular users as you have regular
user licenses. When using FirstClass in a business environment,
employees must be Regular users. You can buy additional
Regular user licenses at any time.

Users configured as Remote users require session licenses. You

can add as many Remote users as you wish, but the number that 3
can log in concurrently is limited by the number of session

licenses you have. Session licenses are shared by Remote users

and you can buy more at any time. When using FirstClass in a

business environment, customers must be Remote users.

For information on all license purchases, contact your Centrinity
sales representative.

For licensing instructions, see FirstClass Tools Reference.

Both Regular and Remote users can connect using any protocol.
Access method does not affect the class of user or the type of user
license required. A Regular user logging in from home with a
modem will be accepted as a Regular user and will use a regular
user license. A Remote user logging in over a local network will
be accepted as a Remote user and will use a session license. No
matter how you connect, you use the licensing appropriate to
your class.

FirstClass 7 Administrator's Guide Business Edition 17
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Now that you understand sessions, classes of users, and user
licenses, we can look at how Regular and Remote users are
treated slightly differently:

A Regular user can always log in if a network session is
available. (Remember, a Regular user has a regular user
license that was purchased specifically for him, and the
number of network sessions is limited by the level of licensing
you purchased (regular or MP option), and your hardware.)

A Remote user can only log in if a network session is available
and there is an unused session license available. (Remember,
a Remote user shares a number of session licenses with all
other Remote users, and the number of network sessions is
limited by the level of licensing you purchased (regular or MP
option), and your hardware.)

Consider the following scenario:

You have 200 employees who have regular licenses and are
defined as Regular users on their User Information forms.

You have 5000 customers who are defined as Remote users on
their User Information forms.

You have 30 session licenses.

You have 200 network sessions defined.

Under this scenario, you could have the following possible
situations:

All 200 of your employees are logged in. No customers will be
able to log in since all network sessions are in use.

30 customers are logged in. Only 170 employees will be able
to connect.

20 customers are logged in. Only 180 employees will be able
to connect.

150 employees are logged in. Only 30 customers will be able
to connect. Even though there will be network sessions
available, the customers (Remote users) can only connect if a
session license is available and there are only 30 of those.
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We will use an analogy to explain this concept. Consider your
system as a power bar:

Regular user licenses are like two-pronged plugs. When you buy
a new license, you get a plug to connect to your server.

Remote users are like three-pronged plugs. Your server comes
with an unlimited supply of these plugs, but you need an adapter
to fit them into your power bar.

.

The outlets in the power bar represent the network sessions. You
can increase the number of sessions by adding power bars. The
number you can add is limited by the capacity of your electrical
system — or in the case of your server, the amount of memory
and disk space you have. In the following example, you have
Regular users (two-pronged plugs) plugged into your network
sessions (outlets on the power bar).

e

In the next example, you have purchased some session licenses.
This converts some of your network sessions (outlets) so they
can support Remote or Regular users (three-pronged or two-
pronged plugs). Note that Remote users can only take as many
slots as you have session licenses.
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Even if only two Regular users (two-pronged plugs) were
connected, the Remote users could still only use the three
licenses (three-pronged outlets) available to them. However, the
Regular users can use any network session (outlet).

TR
H

Organizing people and communications on your system
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Before you start adding users to your system, you should take
some time to think about how they will use the system and what
you want them to do or not do. You need to think about the
different groups of users you’ll have, their needs, your system
needs (like performance and security), and your system
limitations (like disk space, memory, and number of sessions).

Once you understand what your users need and what your limits
are, you can start considering how FirstClass can meet those
needs. Here we’ll be looking at the communications and
information sharing needs of users — probably the most
significant use they’ll be making of your system. We will
introduce the privileges, permissions, and Model Desktop
features of FirstClass. Privileges let you control a user’s access to
FirstClass features and the FirstClass Directory. Permissions let
you control who uses conferences and calendars and how they
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use them. Model Desktops let you control what users will see
when they log in.

This section is merely an introduction to the concepts we will
discuss in detail later. The examples we’ll be walking through in
the planning and creating sections of this book are relatively
simple, but they contain the basics that you’ll need no matter
how complex your system. By combining these basics in
different ways, you’ll be able to create quite sophisticated
structures.

Your organization probably already has groups defined. For
example, the groups of people who will use your system might
be Employees, Managers, Customers, and Suppliers. You might
also group them based on the department they are in or the
building where they are located. Some people might belong to
more than one group — for example, members of the Managers
group are also members of the Employees group. Whatever
group structure you choose, it should reflect the logical divisions
within your organization and how those divisions are reflected
in privileges.

If there is no existing structure in your organization, think about
the kinds of people who will be using your FirstClass system and
their particular communication needs. Find the common factors,
and establish a suitable name for each group of people.
Determine how you want your system to meet the needs of each
group.

Once you have such a structure in place, you can assign
privileges to the groups rather than to the individual users. This
process provides you with two advantages:

» It’s easier and more efficient to set the privileges for a user
group and then add users to that group than it is to set
privileges individually for each user.

* You can be sure that all users in a specific user group have the
same privileges. You'll probably need this kind of consistency
since all users in, for example, the same department will need
the same privileges.
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Note Privileges can be overridden at the user level, if
required.

In Chapter 7, “Understanding groups, organizational units, and
privileges”, we will discuss how to define groups and
organizational units. We will also learn about setting privileges
at the group level. In Chapter 9, “Understanding Directory
filtering”, we will learn about using Directory filters to make
your system secure and to allow user groups to see or not see
other groups in the Directory.

So far, we’ve thought about how people are organized in Husky
Planes. Now we have to think about how people will
communicate on our system. Do we want one-to-one
communication, one-to-many, many-to-many, or a combination
of these? To put it in more technical terms, we have to decide
whether our users will be relying on direct email, mail lists, or
conferences to meet their communication needs.

When we were first setting up our groups, we decided that
customers would communicate with us through conferences. So
we know that we need to set up some customer conferences that
all customers and some employees have access to.

Different employees are involved in different projects. Some of
those will probably use conferences for communications. Setting
them up and subscribing employees will be an ongoing process.
However, there are some conferences that all employees should
have access to. These will be conferences dealing with company
policy, company announcements, and a general discussion
conference where employees can communicate with each other
about various job related issues.

Managers will also require some conferences. These will be used
to collaborate about personnel issues, company policy, budgets,
and business plans. Since these conferences will contain
confidential material, as will the managers’ Mailboxes, we’ll
have to set them up so no employees can access them. The only
exception to this will be some of our IT personnel. Since we are
giving them administration authority, we can’t stop them from
seeing conferences. But we can make it difficult for them by
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implementing some security measures we discussed earlier. See
“Adding additional security” on page 13.

Since projects run on timetables with interrelated key dates,
each project will need a group calendar so everyone involved
can see critical dates. Managers and employees will also need
personal calendars so they can book meetings and track their
individual work activities.

In addition, we want a mail list with the email addresses of our
resellers so we can send them regular updates.

In the planning section of this book (chapters 7 - 9) we will
revisit these requirements and decide how best to implement
them. In the creating section (chapters 10 - 16) we will create
the FirstClass objects that will help our users use their FirstClass
environment most effectively.

Model Desktops control what users see when they log in. Since
all of our groups have different needs, we want them to see
different things when they log in.

For example, in Husky Planes:

e Wwe want customers to communicate through conferences, so
their Desktops will have those conferences clearly visible

» employees will need to see the conferences important to them

» managers’ Desktops will have both employee and
management conferences on them

 IT personnel will need the same features as employees with a
few extra items to help them do their jobs.

We will return to these examples when we discuss Model
Desktops in Chapter 8, “Understanding Model Desktops” and we
will walk through examples of adding objects to Model Desktops
in Chapter 12, “Adding conferences and conference groups”.

Understanding gateways

A gateway is a bridge between your system and another device
or system. FirstClass supports several types of gateways:
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24  Introduction

AdConcept71.fm

* server-to-server gateways
» gateways to other email systems
» outbound gateways

 inbound gateways.

Gateways are configured from the Gateways folder on the
administrator’s Desktop. There are a number of third-party
gateways supporting other systems and hardware. This
document explains how to configure a server-to-server gateway.
Information on configuring other gateway types will be found in
the documentation accompanying those products.

Server-to-server gateways connect multiple FirstClass servers
and FirstClass servers with FirstClass add-on modules, like
Internet Services and Voice Services. Using server-to-server
gateways, you can set up a large, integrated mail and
conferencing network supporting conference replication,
Directory synchronization, and multi-hop delivery. Your
FirstClass server has built-in server-to-server gateway software.

The main reason for setting up a server-to-server gateway is so
users on one server can communicate with users on another.
Although the users could connect to the remote server by having
a user account on that remote server, it is much more efficient
to have users always connect to their local server, and have the
servers handle the message exchange. If your users have Internet
access, sending messages directly to the receiver’s email address
is the easiest option.

Gateways to other email systems connect your FirstClass server
to other mail systems such as Microsoft Mail, and cc:Mail.

Outbound gateways allow users to send messages out, but not to
receive incoming messages. Fax gateways, pager gateways, and
printer gateways are examples of outbound gateways.

Inbound gateways accept messages from the remote system, but
do not allow your users to send replies. Newswire gateways and
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gateways that retrieve satellite weather map pictures are
examples of inbound gateways.

Gateways will be discussed in detail in Chapter 16, “Adding
gateways”.
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Installing FirstClass

You can install the FirstClass server and Internet Services on
separate machines, or together on a single computer with either
a single or multiple processors. The minimum requirements for
each scenario are listed below, but, keep in mind, the actual
performance of your system will vary depending on how
powerful your hardware is and on how busy your system gets.

If you install the FirstClass server and Internet Services on two
dissimilar machines, we suggest using the more powerful
machine to run Internet Services.

System requirements for FirstClass server and Internet 4
Services on Windows

FirstClass server and  Pentium class processor
Internet Services
together * Windows NT 4.0 with Services Pack 6a, or Windows 2000

Advanced Server
For MP servers running 1,000 or more concurrent sessions,
Windows 2000 Advanced Server is required.

For sites using network-mounted drives for FirstClass post
offices, Windows 2000 Advanced Server is required.

* 64 MB available RAM plus 100 KB for each concurrent session
(128 MB plus 250 KB per session recommended)

» minimum 50 MB free disk space, plus additional storage for
mail and user data (recommend fast disk subsystems for
heavier use)

« Dial-Up Networking for dialup connection support if you do
not have a full-time Internet connection (recommend
intelligent serial controller for external modems)
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Note Modems take away from the system CPU.

FirstClass server only  Pentium class processor

» Windows NT 4.0 with Services Pack 6a, or Windows 2000
Advanced Server

For MP servers running 1,000 or more concurrent sessions,
Windows 2000 Advanced Server is required.

For sites using network-mounted drives for FirstClass post
offices, Windows 2000 Advanced Server is required.

» 32 MB available RAM plus 100 KB for each concurrent session
(64 MB plus 250 KB per session recommended)

« minimum 50 MB free disk space, plus additional storage for
mail and user data

« Dial-Up Networking for dialup connection support (if you do
not have a full-time Internet connection)

Internet Services only  Pentium class processor

» Windows NT 4.0 with Services Pack 6a, or Windows 2000
Advanced Server

» 32 MB available RAM (64 MB recommended)
» 8 MB free disk space

« Dial-Up Networking for dialup connection support (if you do
not have a full-time Internet connection)

System requirements for FirstClass server and Internet
Services on Mac OS

FirstClass server and * Macintosh PowerPC
Internet Services
together * Mac OS 8.6 or higher (for servers running more than 50

sessions 9.0 recommended)

» 32 MB available RAM, 100 KB for each concurrent session
(128 MB plus 250 KB for each concurrent session
recommended)
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additional memory required if you are mirroring volumes (see
“FirstClass server only” on page 31)

minimum 14 MB free disk space, plus additional storage for
mail and user data

Open Transport 1.3 or higher

a third-party software router (such as the Vicom Internet
Gateway) on the Internet Services machine to handle routing
of network and IP traffic for dialup connection support (if you
do not have a full-time Internet connection)

Macintosh PowerPC

Mac OS 8.6 or higher (for servers running more than 50
sessions 9.0 recommended)

32 MB available RAM, plus 100 KB for each concurrent
session (32 MB plus 250 KB for each concurrent session
recommended)

additional memory required if you are mirroring volumes
(amount of additional memory depends on the number of
items (files and folders) in your FirstClass post office,
approximately 300 bytes per item)

minimum 12 MB free disk space, plus additional storage for
mail and user data

Open Transport 1.3 or higher (set to Classic Networking
mode)

PowerPC

Mac OS 8.6 or higher

32 MB available RAM (64 MB recommended)
8 MB free disk space

Open Transport 1.3 or higher (set to Classic Networking
mode)

a third-party software router (such as the Vicom Internet
Gateway) on the Internet Services machine to handle routing
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of network and IP traffic for dialup connection support (if you
do not have a full-time Internet connection).

Installing the FirstClass server and Internet Services

To install the FirstClass server in a Windows or Mac OS
environment, insert the FirstClass installation CD and follow the
instructions.

While installing the FirstClass server, you will be asked whether
to install FirstClass server and Internet Services, FirstClass server
only, or FirstClass Internet Services only.

« If you wish to install the FirstClass server and Internet
Services on the same computer, select the FirstClass server
and Internet Services option.

« Ifyou plan to install the FirstClass server and Internet Services
separately, on different machines, select the FirstClass server
only option when installing the FirstClass server. Install
Internet Services separately by repeating the installation on
the other computer. Select the FirstClass Internet Services
only option when prompted.

System requirements for FirstClass client on Windows

32

» 80386 DX processor or higher

» Windows 95 or higher, Windows 2000, Windows NT
Workstation, Windows NT Server, or Windows XP

* 4 MB available RAM

+ disk space requirements (4 MB for a full installation):
* FirstClass client software 2.8 MB
* FirstClass Network Notifier 65 KB

* FirstClass Personal Application 650 KB (only available in 32
bit)
 Personal Post Office 35 KB (only available in 32 bit)
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Connection
requirements
IPXorTCP/IP » a Network Interface Card (NIC) and the

appropriate NIC drivers

* the most up-to-date IPX or TCP/IP network
drivers available

Modem » Hayes-compatible modem, 1200 bps or faster

* ifyou are using a high-speed external modem
a cable with hardware handshaking capability

+ a 16550AFN UART chip

System requirements for FirstClass client on Mac OS
» PowerPC processor or higher
e Mac OS System 8.5 or higher

* Color QuickDraw

Without FirstClass Personal Application:

e a minimum of 10 MB available RAM (10 MB for Power Mac 4
OS with Virtual Memory off)

+ a minimum of 6 MB free disk space.

With FirstClass Personal Application:

e a minimum of 12 MB available RAM (12 MB for Power Mac
OS with Virtual Memory off)

+ a minimum of 8 MB free disk space.

Connection
requirements
TCP/IP e MacTCP or Open Transport

AppleTalk » A network card or cables for AppleTalk
» Hayes-compatible modem, 1200 bps or faster

» Ifyou are using a high-speed external modem
a cable with hardware handshaking capability.
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Installing the FirstClass client

As administrator, you can choose to install the FirstClass client
on users’ Windows or Mac OS machines in any of the following
ways:

1. To install the FirstClass client software insert the FirstClass
installation CD and follow the instructions.

2. When you install or upgrade to FirstClass 7, a
ClientDownloads folder will be created within the Internet
Services > WWW folder. Inside this folder are links to the
client installers and the readme documents.

The document uses an X-FC tag to update the home.fc
settings file with the Domain name from the System Profile.
Once the domain name is added to the home.fc settings file
users will be able to connect to your server without further
configuration. Users do not need to know the server IP
address to connect.

3. If you have a company home page created, the home page
document in the WWW folder inside the Internet Services
folder can be used by users to link to the downloads page on
the Centrinity Inc. web site and download the client.

Once the client is installed, for the initial login, users should
click the login link on the home page to login. An X-FC tag
will update the home.fc settings file with the Domain name
from the System Profile. Once the domain name is added to
the home.fc settings file, users will be able to connect to
your server without further configuration. Users do not need
to know the server IP address to connect.

For more information about the FirstClass client, see our online
help, or A Business Professional’s Guide to FirstClass.

The FCServer/FirstClass Server folder

The FCServer (Windows) or FirstClass Server (Mac OS) folder
contains the server and FirstClass Tools applications, as well as
all supporting files.
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If you installed Internet Services on the same machine as the
FCServer (Windows)/FirstClass Server (Mac OS) server, the
Internet Services files will also be in the folder. Otherwise, they
will be in a FCServer (Windows) or FirstClass Server (Mac OS)
folder on the Internet Services machine.

This folder contains the following folders and files:

e FCS.exe (Windows) or FirstClass Server (Mac OS)

The server application executable.

e FCTools.exe (Windows) or FirstClass Tools (Mac OS)

The FirstClass Tools application executable. You use
FirstClass Tools to license and configure your server, and
configure sessions. For information about FirstClass Tools, see
FirstClass Tools Reference.

* ADMIN.FC

A settings file that you can use to log into the server as
administrator.

e Readme.txt (Windows) or ReadMe (Mac OS) 4

A text file containing documentation changes and last-minute
information about the server and Internet Services.

» FCP

A folder containing FCP files. FCP is the protocol used to
communicate between the FirstClass client or module and the
FirstClass server.

» FCUtil.exe (Windows only)

The FCUtil application executable, used to automate certain
Windows applications.

 Stats files

A folder containing statistics files built during trash collection.

Internet Services The following folders and files are also in the FCServer
(Windows) /FirstClass Server (Mac OS) folder if you installed
Internet Services on this machine:
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fcintsrv.exe (Windows) or FirstClass Internet Services (Mac
0S)

The Internet Services application executable.

INETSVCS.FC

The settings file for Internet Services.

CONFIG

A folder containing configuration files for Internet Services.
PORTLIST.TXT

A list of standard ports.

cgi-bin

A folder for CGls, if you’ve made any available. The Internet
Services administrator will create this file. For information,
see FirstClass Internet Services Administrator’s Guide.

Installing and configuring FirstClass



AdStrt71.fm

Starting your server and logging in

Starting your server and logging in

In order to do any system administration, whether from the
server level, or from the client, the server must be running. Most
administrative functions you perform will be done when you are
logged into the client as the administrator.

Starting your server

The FirstClass server application resides in your FCServer
(Windows) or FirstClass Server (Mac OS) folder. It is called
FirstClass server and has the following icon on your Desktop:

Double-click the icon or the file to start your FirstClass server.

On a Windows machine, you can also start the application by
choosing Start > Programs > FirstClass server.

Server console

When you start the FirstClass server, the server console appears
on your screen. There are a number of menu items you can use
from this console screen. The same menus exist on Windows and
Mac OS with the exception of the Edit menu, which is not
available on Mac OS. The Help menu has the usual system
specific help options. The following information describes the
menu item functions:

File

Exit (Windows) The same as Server > Polite shutdown.
Quit (Mac0S)
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Edit (Windows only)

The standard system edit items.

Fast shutdown

Polite shutdown

Broadcast
Force logoff

Force trash
collection

Reset modems
Start gateway

Show session
status

Show statistics

Priority

Hide server
window / Show
server window
(Mac 0S only)

Console to file

Server

Forces off all users and shuts down
immediately.

Sends a message to users and waits until they
have all logged off before shutting down.

Send a message to all users logged on.
Disconnect users without shutting down.

Cause immediate trash collection. See “Manual
trash collection” on page 208.

Reset all modems.
Start a gateway immediately.

Display the status, on the console, of all
sessions.

Display Telecom, Network, CLUI, and server
statistics on the console.

Set the server’s priority. For information, see
our online help.

Hide or reveal the server console.

Save the console to a file.

Diagnostics

The Diagnostics menu is intended for use by your reseller, or
Centrinity Customer Support to resolve technical problems you
may encounter. If required, they will explain the use of the

menu items.

Logging in as administrator

The FirstClass installation application adds a special user
account for the administrator:

¢ the user ID is admin
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* the password is admin

e the name is Administrator.

Warning: To preserve the security of your system, you should
change the password for the administrator account
as soon as you log in by choosing Collaborate >
Change Password. Keep the new password
confidential. We recommend that you not save the
password in your settings file.

Warning: You can change the name, password, and user ID
associated with the administrator account, but
never delete this account. If you do, you won’t be
able to log in as the administrator, and you will
have to re-install your server.

While you can log into the administrator account using a web-
based client, you must use a FirstClass client to perform all
administrative tasks.

When you log in as administrator for the first time, the online
registration form will be on the administrator’s Desktop. Click
the following icon to open it:

You must complete and send this form to Centrinity to get access
to online software and documentation updates and to be
allowed to post support questions to our customer conferences.
You can either email the completed preaddressed form or print
the form and mail it to one of the addresses indicated in the
message body.

You do not have to complete all the fields on the form and some
will already be filled in for you. The help text on the form
explains which fields are optional. A copy of this form will be left
on your Desktop for your future reference.
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Once Centrinity receives your registration, you will be sent
information on accessing our online system and given access to

customer conferences.

The administrator’s
Desktop

The administrator’s Desktop looks like this:

The administrator's Desktop

74 Desktop

In addition to the standard objects that all users see, the
administrator's Desktop contains its own set of standard objects.

File Edit Format Message Collaborate Wiew Admin  Help
-: . oo BB | i=a oam, b2
Ep m‘d’ Engum‘gis::‘?:-_v QQF %
TH Desktop 0 Files 21 Folders  Husky Planes com : Administrator v
FIRSTCLASS’
Start here % 2 gﬂ,; ag.‘a (=
il B Addr. =5 Book Calendar
L
& &4 W
Groups General Conferences hiail Lists
¢ v @
Monitors Reports Hard Disk
v ¢ VW
Irternet Services “olumes FC Rezource Registry Gateweays
Help CLUIHelp Admin Help
Multti-Site Setup hultivol Conferences
< b
21 ftems.

Do not delete or rename any objects on the administrator’s
Desktop. If you do, you might not be able to perform necessary
administrative tasks. These objects are protected by default to

avoid mistakenly deleting them.

Warning If you delete one of the standard user icons from the

administrator's Desktop, that object and all its
contents will be deleted and it may be impossible to
restore the administrator's link. If you accidentally
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delete an object, you can recover it using the
undelete feature before trash collection runs.

Start here folder

A folder containing inportant information about setting up
and configuring your FirstClass system.

Mailbox

This is the administrator’s Mailbox where system messages
will be automatically sent. We suggest the administrator
create a personal user account for non-administrative duties
and personal email.

Address Book

This is the address book for the administrator’s account, for
use in sending messages in your official capacity as
administrator. Again, we suggest the administrator create a
personal user account for non-administrative duties and
personal email.

Calendar

This is the calendar for the administrator’s account. Again, we
suggest the administrator create a personal user account for
non-administrative duties and personal email and scheduling.

Groups

A folder containing all the user and conference groups defined
on your server.

General Conferences

A folder in which you can add conferences so users can
collaborate effectively. These conferences are only visible to
users when you subscribe a user to a conference, add a
conference to a user group’s Model Desktop, or put a link to a
conference in a public place.

Mail Lists

A folder containing all the public mail lists on your server.

Monitors
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A folder containing the Server Monitor, Session Monitor. and
Internet Monitor.

Reports (Statistics and Billing on legacy systems)

A folder containing Statistics folder, the Log Files folder, and
the Statistics Control form. For more information about the
statistics and log files contained in these folders, see
Chapter 18, “Monitoring your system”, and our online help.

Hard Disk

An external folder that gives you access to the other files on
the hard disk containing the post office.

Internet Services

A folder where you configure your Internet connections and
services.

Volumes

Folders containing a list of all the volumes mounted on the
server computer.

FC Resource Registry

A folder which allows you to store resources such as forms,
icons, and sounds on the server, for all your users to access.

Gateways

A folder containing the gateways defined on your server.

Help

A folder containing the online help files. You can add
information to this folder if your users require additional
online help material for your system setup.

The administrator’s help is only accessible from the
administrator’s Desktop, and by users in the Sub Admin and
Webmasters groups.

CLUI Help

A folder containing the Command Line User Interface (CLUI)
help text files.

Multi-Site Setup
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A folder containing forms used in setting up networks
consisting of two or more servers, using the Directory
synchronization feature.

MultiVol Conferences

Folders containing a list of all the secondary volumes
mounted on the server computer.

Registration form.

The online registration form. You must complete and send in
this form to get access to product and documentation updates
and support conferences. You can either email the
preaddressed form via the Internet or print it and mail it to
one of the addresses indicated in the message body.
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Configuring your system

Much of the information we will need in this chapter you will
already have recorded in the table in the “Basic server setup”
section of FirstClass Getting Started. If you didn’t complete that
table, you might want to take a moment to do so now or
complete it as we go through a basic setup. If you completed all
the fields during the server installation process, much of the
system setup will already be done.

Configuring the System Profile

System Profile Server
tab

To configure your system, you must complete the System Profile
form. For a complete explanation of all fields on this form, see
our online help. In this chapter, we will complete this form for
our company Husky Planes.

Note You have to log in as administrator using the
FirstClass client in order to configure your system.

Many of the settings we will set here can be overridden in other
areas. These settings are meant to meet the needs of the majority
of users. To access the System Profile, select Admin > System
Profile from the administrator’s Desktop.

We'll put some basic system information on this tab. We will set
a priority level to maximize the efficiency of the FirstClass server
and we will learn about the Disable all logins field.
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System Profile - Server

5. System Profile

File Edit Format Message Collaborate Wiew Admin  Help

Server ]Timers] Uszage Limits] Users] Other Defaults]

Use this tab to set up your server.

Yersion: 6.2 Serial number: 9985570
Metvwork name:  |Husky Planes The name P2 and AppleT alk
users specify when connecting to
thiz senver
Site name: Husky Planes.com The name by which other

FirstClass servers know this server
Domain name: fo huskyplanges.com FirstClass server domain name
Example: fo.centrinity.com
Server priority
The priority of server aperations an this machine

'l High Thisserver has its owun dedicated
processor
& Medium The processor is shared with other
programs
= Low Significantly reduces parformance
Minimum free disk space: 10000 & KB The minimum amaunt of free disk

space required on 3 wolume for
messaging and gateway activity to
continue on thatwolume

Dizahle all logins Prevents everyone except the
administrater and
Time zone: subadministrators fram logging in
(FMT-5:00) Eastern Time (US & Canada) j Local time zone of the server.

Cancel | [0].4 |

For Husky Planes, we will complete the form as follows:

Network name Husky Planes, the name of our company.
This is the name network users will specify
in their settings files to connect to our
server. For more information on modifying
settings files, see our online help.

Site name Husky Planes.com, this identifies us to other
FirstClass servers we establish gateways
with. For information about gateways, see
Chapter 16, “Adding gateways”.

Domain name fc.huskyplanes.com, this is our registered
domain name and it resolves to the IP
address of the computer we have our
FirstClass server installed on.
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Server priority Medium, since we have decided to install
both the FirstClass server and Internet
Services on the same machine.

Minimum freedisk  10000. When the available disk space falls

space below this level, the volume will go into
write protect mode and basic tasks, like
creating new messages, will not be
performed by the server. We set this value at
a point low enough so it won’t often be
reached, but high enough to allow us some
maneuvering room on the volume.

Your setting will depend on your hardware
configurations.

Disablealllogins ~ We leave this unchecked.

If we ever want to perform administrative

functions while no users are logged in (for

example, major changes to user groups,
permissions, or directories), we will check

this box. Remember to clear the box or

restart the server when you have finished. 6
Since most administrative functions can be
performed with users logged in, we won’t be

using this feature frequently.

Time zone (GMT-5:00) Eastern Time (US & Canada)
This is the local time zone of the FirstClass
server.

This must be the same as the time zone
selected in the server machine’s operating
system.

System Profile Timers On this tab, we set some rules about deletion and about
tab disconnecting users.
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€ System Profile

File Edit Format Message Collaborate Wiew Admin  Help

Server TIMErs |Usage Limits] Users] Cther Defaults]

Use thiz tab to settimeout and expiny defaults.

Conference item expiry: 90 ﬂ days The .default time an item will
stay in a conference before
expinng

Trazh collection time: 300 am ﬂ The time when trash collection
will start in the senvers time

4£28/2002 3:00:00 Ak zZane

Logoff warning interval; 120 #]seconds Thetime betmeen a logoff

Moadem login timeout: 45 il zeconds  The maximum time FirstClass

a0 ﬂ days The defaulttime a meszage
will stay in a users Mailbox
before expiring

warning and the actual lagoff

will wait for a login message
after a modem connects to the
senver

Canecel | oK |

For Husky Planes, we will complete the form as follows:

Private mail expiry 90 days, this is long enough that valuable

mail won’t be quickly lost but short enough
that Mailboxes are not overloaded and we
don’t run out of disk space. Your setting
should reflect the usefulness of old mail on
your system and the amount of disk space
you have available. You can set mail expiry
also for individual users or user groups, and
you can allow users to change the expiry
period of individual messages. See

Chapter 7, “Understanding groups,
organizational units, and privileges”.
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Conferenceitem 90 days, many of our conferences contain

expiry notices, policies, and procedures that need to
be saved for a while. Again, this number
should reflect the importance of old mail in
conferences and the amount of disk space
you have available. The expiry period can be
overridden for individual conferences and
conference groups. See Chapter 12, “Adding
conferences and conference groups”.

Trash collection 3 AM, because no one is working at that

time time. Although the server continues to
function during trash collection, it’s best to
schedule it when use is minimal. See
Chapter 19, “Trash collection”.

Last collection This is the date and time of the most recent
trash collection.

Logoff warning 120 seconds, we don’t want to wait a long

interval time before logging people off. The server
issues warning messages when a user’s time
limit is about to expire, or if a user is inactive. 6
For more information, see our online help.

Modem login 45 seconds, we don’t want our modems

timeout unavailable for a long time due to a bad
connection.

System Profile Usage On this tab, we will enter some settings that will affect users in

Limits tab their day-to-day system use.
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€ System Profile

File Edit Format Message Collaborate Wiew Admin  Help

Server] Timers Usage Limits ]USers] Other Defaults]

Use this tab to set usage limit defaults.

Draily connection limit:

Inactivity limit hefore logoff:

Inactivity limit hefare deletion:

FirstClass Motifier limit:

Login limit per user:

minutes The maximum daily connection
time for each user

The maximum time persession
that a uzer can be inactive
before being logged off

a0

#| minutes

The maximum time a users
account zan be inactive {not
connected to a sencen before
being deleted

Mo Limit | *| days

250 il The maximum number of uzars
who can enable FirstClass
Matifier

Mo Limit %]« The maximum number of

seszions d user ¢an have open at
once using the same user Ik

Cancel | [0].4 |

For Husky Planes, we will complete the form as follows:

Daily connection limit

Inactivity limit before

logoff

Inactivity limit before
deletion
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1440, unlimited access (24 hours). Most
of our users are employees and we want
them to have continual access. We will be
limiting specific users’ access elsewhere.

30 minutes, we know employees often log
into the server and then attend to other
tasks. We don’t want them logged off.

No limit, we don’t want employees on
extended leave or long vacations to have
their accounts deleted. Nor do we want
customers, who might only log in a few
times a year, having their accounts
deleted.
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FirstClass Notifier 250, the number of employees we expect
limit to be using FirstClass Notifier. For
information, see our online help.

Login limitperuser ~ No Limit, FirstClass supports multiple
logins to the same account. Employees
don’t often have a need for this, but there’s
no reason to limit it.

System Profile Userstab  On this tab, we will make some decisions about how users can
access the system and where their data is stored.

System Profile - Users

6‘ System Profile
File Edit Format Message Collaborate Wiew Admin  Help

Server] Timers] Usage Limits  Users ]Other Defaults]
Use this tab to set user defaults and wiew license usage

Create users and conferences on volume:

-0- [-D-] j The volume an which you want to add
new uzers and conferences

Prevents the ereation of user accounts
with duplicate names

Remote autaregistration Allows userswho connect using remaote
seszions to register when they log in

Metwork autoregistration Allows users who connect over a LAN
to registerwhen they lag in

Avtoregister notification Sends the administrator notification
when 3 user autoregisters

Guest access Allows peaple to lag in as quest users

Guest uzer ID: |Guest The user account to be used when

someone logsin as a guest

» Command line access Allovs users to acoess the serwer using
aterminal or terminal emulatar

Licenze usage statistics

Allovwved Uszed Avvailable
Regular users: 53] 35 17
Remate users: Unlimitec 1 Unlimitec
Remate sessions: 2
Text-to-speech engines u]

Cancel | [0].4 |

For Husky Planes, we will complete the form as follows:

Create users and D, the volume we’re currently using. For
conferences onvolume more information, see “Multiple volume
considerations” on page 182.
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Require unique user
names

Remote
autoregistration

Network
autoregistration

Autoregister
notification

Guest access

Guest user ID

Command line access

System Profile Other

Defaults tab space.
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Yes. Duplicate user names can create
confusion and they will make it difficult if
we use one of the automatically
generated Internet alias options. For
more information, see FirstClass Internet
Services Administrator’s Guide.

If you are using organizational units and
want to permit multiple users with the
same name (as long as they are in
separate organizational units), clear this
checkbox. For information about
organizational units, see “Organizational
units” on page 76.

No. If we want people to use our system
we will give them an account. Unless you
have a very good reason to use this
feature, don’t. It can cause problems since
it allows anyone who can connect to your
system to register and possibly annoy
other users.

No. Again, we don’t want any
autoregistration at all.

This is not necessary since we do not
allow autoregistration.

Yes. This will allow unregistered users to
log in and request an account. This gives
you a lot more control over who uses your
system than allowing autoregistration.

Guest. We just picked something easy to
remember. It can be any valid user ID.
You can create a special Desktop for this
user ID, with the information you feel
guest users need.

Yes. We don’t really expect people to use
it, but there is no good reason to disallow
it.

On this tab, we will make some decisions about security and disk
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System Profile - Other Defaults

= System Profile

File Edit Format Message Collaborate Wiew Admin  Help

Server] Timers] Usage Limits] Users Cther Defaults

Use this tab to set additional system defaults.

Frevents the administrator and
subadministrators from viewing
others' Desdops

Allowy blank password field Lets users leawe pasaword fields blank

Suppress conference history Prevents the collection of some
histony information for conference
and calendar items

Suppress conference receipt notificstion Tums off receipt notification for
messages sant to conferences
Character sets
Legacy character set: Macirtozh Raman
System character set: Windowes Latin

Cancel | [0].4 |

For Husky Planes, we will complete the form as follows:

Secure all Desktops ~ No. Although this is a valuable tool, we
want to use it for specific individuals.

Allow blank password No. Letting users have blank passwords is
field a security risk.

Suppress conference  No. History is a valuable feature and we
history will accept the minimal disk space impact.

Suppress conference  No. Again this is a valuable feature and we
receipt notification ~ will accept the minimal disk space impact.

Running your FirstClass server as a Windows service

You may choose to configure your FirstClass server to run as a
Windows service. If you choose this option, your FirstClass
server will start up and shut down automatically when you start
up or shut down your Windows machine. If you simply log off of
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the Windows machine, your FirstClass server will not shut down,
but will continue to perform normally. This can increase the
security of your FirstClass server.

Internet Services and Voice Services do not run as Windows
services. If you shut down the Windows machine without
correctly shutting down Internet Services and Voice Services,
these modules will not shut down correctly, nor will they start
up automatically when the Windows machine is restarted. If you
log out of your Windows machine where Internet Services and/
or Voice Services are currently running, they will not continue to
run. Therefore, if you opt to run the FirstClass server as a
Windows service, you should install Internet Services and Voice
Services on separate machines.

When you install your FirstClass server on a Windows machine,
a FirstClass Services control panel applet will automatically be
installed in your System32 folder.

How you open the NT Service Options form is dependent on
what Windows operating system you are running:

Windows NT or Control Panel > double-click FirstClass
Windows 2000 Services.

Windows XP (Classic Control Panel > click Administrative Tools >
view) double-click FirstClass Services.

Windows XP Control Panel > click Performance and
(default, Category Maintenance > click Administrative Tools >
view) double-click FirstClass Services.

The FirstClass Services icon looks like this:

FirstClazz
Services
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—NT Service Optio

[V Orly use MT event log when running as an NT service.

|Fetall Seniee Uninztall Service

—MNT Event Log Level
& MNone

" Enars only
 Erorz and wamings
© Errars, warning and jrformation messages

" All messages including debug

™ Include surmary infomation in server congole litehar,

™ Use larger stack sizes [for features like Oracle-bazed DB extensions).

Choose your options from the following table:

OnlyrunasanNT  Check to prevent users from starting the

service FirstClass server by running the executable
directly. It may help avoid accidently
shutting down the server incorrectly when
shutting down Windows. If it is run strictly
as a Windows service, the FirstClass server
will always shut down correctly when
Windows is shut down.

Onlyuse NTEvent  Check this to stop logging of events to the
Log whenrunning  NT Event Log when the FirstClass server has
as an NT service been started manually.

Install Service Click to configure the server to run as a
Windows service. FirstClass server will
appear in the Services list (Start > Control
Panel > Services) where it can be started
and stopped. You can continue to run your
FirstClass server as a normal application by
running the FCS.EXE executable directly
unless you checked Only runasan NT service.

Uninstall Service Click to remove from the list of available
Windows services.

NTEvent Log Level Select the logging level you prefer. For more
information, see “Support for Windows
Event Logs” on page 56.
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Support for Windows
Event Logs

56

Include summar
informationin
server console
titlebar

Use larger stack
sizes

complete with

y  This will display FirstClass server
monitoring information, in an abbreviated
format, on the server console titlebar. You
can also find this information, in greater
detail, by viewing the Server Monitor. See
“Checking the Server Monitor” on page 187.

Do not select this.

FirstClass logfile messages are mapped to Windows events,

severity categorizations, standard FirstClass error

numbers and descriptions. The control panel allows you to
control the severity threshold at which FirstClass messages are
added as Windows events. The severity categories are as

follows:

Category

Information

Warning

Error

Examples of FirstClass error messages in this category
Errors that are normally not logged, such as:

1035 Invalid password

1003 No such user

1040 Can’t forward

1036 Can’t reply

1049 Daily time limit exceeded

1053 Logins are disabled

1080 Name already in use

1084 Object in use

1093 User has reached/exceeded disk space limit
1096 Must read

More significant errors, such as:

1044 Server not found

1027 Communication link has failed
1061 Modem has dropped the connection
1092 User session memory limit reached

All other errors of consequence.

For all information about FirstClass error messages, see
FirstClass Error Messages Reference.

To view the event log, use the standard Windows Event Viewer
by selecting Programs > Administrative Tools > Event Viewer
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from the Taskbar. Select Log > Application. FirstClass server
events will be displayed with a value of "FCS" under the "Source"
column. FirstClass server error codes (for example, 1027, 1035)
will be displayed under the "Event" column as appropriate. For
information about FirstClass error messages, see FirstClass Error
Messages Reference.

When installed as a service, you can use the Windows NET
command to start and stop the server:

NET START FCS
NET STOP FCS

The PAUSE and CONTINUE commands are supported for post
office mirroring. For information on the mirroring feature, see
“Mirroring your FirstClass post office” on page 213, and our
online help.

NET PAUSE FCS
NET CONTINUE FCS
NET CONT FCS

Programs that include more direct support for Windows services
will also automatically include support for controlling the
FirstClass server using this common interface.

When running FirstClass server as a Windows service configured
to start automatically, your server will start automatically when
the Windows machine is started. The machine does not have to
be logged in. If the machine is not logged in, but is started, there
will be no desktop, no current user context, and no windows or
other user interface elements. Still, your FirstClass server will be
running normally (automatically recognizing user logins and
logouts, and acting appropriately). If not running as a Windows
service, a user logging off of the Windows machine where the
FirstClass server is installed will trigger a fast shutdown of the
FirstClass server. When running as a service, it will not have any
noticeable effect, except, of course, that the server's console
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window will not be visible after logout. It is still there, however,
and will be displayed if the user logs back in.

It is important to recognize that all of this user interface related
functionality is dependent on FirstClass being configured as an
interactive service. The FirstClass control panel automatically
configures FirstClass as an interactive service when you click
Install. When in doubt, it is safe to click Uninstall, followed by
Install to reset the server's Windows service configuration to
defaults. It can also be inspected or overridden from the
standard Windows Services list using the following procedure:

1. Open the Control Panel.
2. Double-click Services.
3. Select FirstClass server.
4. Click Startup.

5. To enable interactive support, select Allow serviceto interact
with desktop.

On this same form, you can configure the FirstClass service to
run under the context of a specific Windows user account. This
is not recommended. Instead, select System account and then
select Allow service to interact with desktop, as described above.

Although FirstClass does not support token ring connections,
you can enable client computers connected to a token ring
network to connect to the FirstClass server. To do so, connect the
Ethernet card in the server machine to a router that can route
packets from Ethernet to token ring. You can use the router built
into a NetWare server to do the routing or, for higher
performance, you can use a third-party router, such as a Cisco
router. This pertains to IPX and AppleTalk only.

Working with firewalls

A firewall is a network security tool used to monitor and guard
traffic passing through a network. It usually resides on its own
computer. A true firewall does not scan your system for viruses
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and trojan horses, nor scan incoming packets for a virus.
However, some firewall products are bundled with virus
software providing varying levels of virus protection.

There are different types of firewalls, all of which combine
hardware and software to achieve maximum protection.

To configure a firewall that is right for you, consider the
following:

» What is the security risk to your network?
» Do you wish to reject specific users? Specific protocols?

» Which requests will you allow (for example, HTTP, Telnet)?
Which will you disallow (for example, FTP)?

The basic firewall architecture is always the same, with minor
variations depending upon the type of firewall you use. Every
packet sent from the Internet is first examined on the firewall
server. As well, packets sent from your network are also
examined on the firewall server. Think of this as the main gate
for all traffic, also called the "choke point". It is the computer
between the Internet and your network that maintains the
security of your system:

Your intemal hetwork

When two networks are configured to communicate with each
other, their individual firewalls can use encryption as another
means of keeping your network safe. Therefore, every packet
sent from the firewall will be encrypted. The most popular
encryption type is RSA (Rivest-Shamier-Adleman). The
following is an example of a network communication where the
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message is encrypted on the firewall server at the local network,
then decrypted on the firewall server at the remote network:

Plain
message

@

Intemet

Encrypted message

Plain

Encryption > ™
MESSA0E  Network 2

accurs

Decryption
ocours

Types of firewalls

Network-level firewalls

60

There are three main types of firewalls:
» network-level (first-generation firewall technology)
* circuit-level (second generation)

* application-level (third generation).

Each type of firewall uses a different technique to protect your
network. A network-level (or packet filter) firewall analyzes
network traffic at the transport protocol layer and compares it to
a predefined set of rules that indicates which protocols are
allowed.

A circuit-level firewall takes this one step further and validates
that a packet is either a connection request or a data packet
belonging to a connection between two peer transport layers.
This is done by examining each connection setup, and then
comparing the connection to a table of valid connection that
includes complete session state and sequencing information.

An application-level firewall provides more detail than the other
types. It evaluates individual network packets for data at the
application layer before allowing a connection. It examines the
data in all network packets and maintains complete connection
state and sequencing information.

A network-level firewall is commonly known as a screening
router. This may also be called a screening ritzer or a packet
filter firewall. This is a lower-level firewall that screens packets.
Basically, it examines packet addresses to determine whether to

Installing and configuring FirstClass




AdConfig71.fm

Configuring your system

pass the packet to the local network or to block the packet from
entering.

Because the packet includes both the sender and recipient’s IP
address, you can block all incoming or outgoing packets to that
specific computer. To do this, you would create a file, sometimes
called a black list or an accept and deny list, and populate it with
IP addresses (most common filter). The router will check this file
each time a connection is requested and block the connection if
the incoming IP address matches a listing.

Usually the check will only be performed if the specified user is
trying to connect to a service that is disabled by the firewall. In
most cases, a screening router filters based upon these rules:

 source address from which the data is coming

* destination address to which the data is going

« data protocol (for example, TCP, UDP or ICMP)

* source and destination application port for the desired service

» whether the packet is the start of a connection request.

The network-level firewall, if installed properly, will be almost
transparent to users, unless they try to perform a blocked action.

FirstClass Internet Services has a built-in security feature that
performs filtering, thereby acting as a network-level firewall for
Internet protocols. For more information, see FirstClass Internet
Services Administrator’s Guide.

A network-level firewall resembles the following:

fdemat

P LTI A

In this example, the router rejects specific users based upon an
IP address and host, as well as requests for FTP (File Transfer
Protocol) services, which would include uploading and
downloading files.
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The router performs packet-filtering (based upon rules that you
specify) independent of the application layer. This means that
screening routers let you control your network and its traffic
without making changes to your client/server applications.

Another type of network-level firewall is Stateful Inspection, an
architecture that is an extension of the basic packet filtering
architecture employed by most routers. Stateful Inspection
occurs at the Network Layer, making it fast and preventing
suspect packets from travelling up the protocol stack. Unlike
static packet filtering, however, Stateful Inspection makes its
decisions based on all the data in the packet (corresponding to
all the levels of the OSI stack). The state of the connection is
monitored at all times, allowing the actions of the firewall to
vary based on administrator-defined rules and the state of
previous sessions. In effect, the firewall is capable of
remembering the state of each ongoing session across it,
allowing it to effectively screen all packets for unauthorized
access while maintaining high security, even with
connectionless protocols such as UDP.

A disadvantage of network-level firewalls is the lack of alerting
and auditing applications. Therefore, when the screening router
filters out a packet, it will not notify the administrator. Higher-
level firewalls, such as the application level firewall, are
designed to filter protocols and report rejected requests.

On many systems, the network-level firewall is only the first line
of defense. Because it does not handle many protocols, an
additional filter is required.

A circuit-level firewall usually consists of a host computer
running proxy-server software. This computer is called a proxy
server. Proxy servers communicate with servers outside the
network, thereby controlling traffic between two networks.

A circuit-level firewall is similar to an application-level firewall,
in that both are proxy servers. The difference is that a circuit-
level firewall does not require special proxy-client software
applications. A circuit-level firewall creates a circuit between a
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client and a server without requiring that either application
know anything about the application that is used.

Basically, this means that a client and server can communicate
across the firewall without communicating with the firewall.
This ensures the firewall protects the transaction’s
commencement without interfering with the ongoing
transaction.

The advantages of a circuit-level firewall are:
« it provides service for a wider variety of protocols
« it is faster because it performs fewer evaluations

* you can use it in conjunction with network address translation
to shield internal IP addresses from external users.

The disadvantages of a circuit-level firewall are:
* it cannot restrict access to protocol subsets other than TCP

« it cannot perform strict security checks on a higher-level
protocol

« it has limited audit event generation abilities.

Similar to the network-level firewall, a circuit-level firewall uses
a blacklist, or an accept and deny list that contains valid
connections (including complete session state and sequencing
information). Incoming sessions are first examined to ensure
they use a legitimate transport layer protocol (TCP). After the
handshake is complete, the network packet information is
examined against the accept and deny list. If a match is found in
the accept list, the packet is permitted. The virtual circuit that is
opened upon connection remains open for the duration of the
connection.

A circuit-level firewall resembles the following:
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As previously stated, an application-level firewall consists of a
proxy server communicating with servers outside the network to
control traffic between two networks.

When you use an application-level firewall, your local network
does not directly connect to the Internet. Instead, the proxy
server transfers an isolated copy of each approved packet from
one network to another, whether the packet contains incoming
or outgoing data. The result is that the firewall effectively masks
the original address of the initiating connection and protects
your network from intruders who may attempt to obtain
network information.

In other words, proxy servers are used to hide your IP address,
making you anonymous on the Internet. The downfall is that
hackers can also use this "service" to hide their IP addresses
when attacking a specific server.

Because proxy servers recognize network protocols, you can
configure your proxy server to control which IP services you
want on your network. There are many types of proxy servers
available. Each protocol that you screen for requires a new proxy
server entry (unlike a screening router).

An ideal scenario is one in which the screening router and the
firewall run simultaneously to filter out packets and protocols. A
system that uses both a screening router and a firewall
resembles the following:
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Although positioning the firewall between an external (closest
to the Internet) router and an internal router provides little
additional protection from attacks, it greatly reduces the amount
of traffic that the firewall server must evaluate, which may
increase the firewall’s performance. Without a filtering router
behind the firewall server, the firewall server would have to
process every packet distributed on that subnet, even if the
packet is destined for another internal host.

Proxy servers are a good choice for environments that require
high security. Because the auditing and filtering is performed by
an actual application, the proxy is slower than a network-level
firewall. Therefore, the application-level firewall should be
placed on the fastest computer host in your network (after the
FirstClass server and FirstClass Internet Services computers are
selected).

The FirstClass client supports only the SOCKS4 proxy interface
directly. Client use through a firewall should be in one of two
configurations: NAT (Network Address Translation), or
SOCKS4.

Network Address Translation (NAT) is a facility included in most
recent proxy servers (also called software routers) that
translates an IP address used within one network to a different
IP address known within another network. It is often part of a
corporate firewall; it ensures security, because each outgoing or
incoming request must go through a translation process that also
offers the opportunity to qualify or authenticate the request or
match it to a previous request.

NAT is much more transparent than other proxy mechanisms,
allowing virtually all applications (including proxy-unaware

FirstClass 7 Administrator's Guide Business Edition 65




Working with firewalls

66

S0CKs4

AdConfig71.fm

applications) to connect to other services through the NAT-
based proxy server. It supports both TCP/IP and UDP/IP
(connectionless protocol) communications.

To configure the FirstClass client to use NAT, simply set the
client machine's network gateway to the NAT router machine.
This is an operating system setting; therefore, no FirstClass
configuration is required.

Note NAT is used mostly for outbound client machines on
a private network that will connect to the Internet.
From a client perspective, NAT is the preferred
approach. However, it would not be appropriate for
a server on a private network.

A SOCKS (also "socks") server handles requests from clients
inside a company's firewall and either allows or rejects
connection requests based on the requested Internet destination
or user identification. Once a connection and a subsequent
"bind" request have been set up, the flow of information
exchange follows the usual protocol (for example, HTTP).

SOCKS4 is a proxy server interface for client programs that
supports TCP/IP only. Under this scenario, the proxy server is
configured to relay SOCKS4 connection requests to a server
machine.

Note FirstClass does not support SOCKS5.
To configure FirstClass under SOCKS4:
1. Click Setup on the Login form.
2. Specify the server machine as usual.
3. Choose TCP/IP.
4. Click Configure.

5. On the Settings tab, choose:
e TCP Default 510 at Port number.
e Default (1080) at Proxy port.
e 0.0.0.0 at Proxy IP address.
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Note Anything other than 0.0.0.0 in the proxy server field
tells the client/outbound connections to be diverted
to that address, informing the proxy server of the
desired address using the SOCKS4 interface.

e Default at Buffer size.

6. Save the settings.

B TCP-Ip.Fop =]

Seftings | advanced |
Use this tab to configure TCPAP and UDF/IF connections.

Port number:
TCP Default (5100 #|¥| The TCPAP or UDPAP port on the serwer

Prowy port:

Defautt (10800 #|¥| lfvou connectthrough a proxy port, the port used to connect to the
Proxy Sener

Proxy IP address:

0.0.0.0 Ifyou connect through a prosy port, the prosy servers IP address
Butfer zize:

Default (10000 el Specify bebween 6000 and G4000
Comments

Cancel | Save |

The proxy server then relays the connection request to the
desired IP address on the client's behalf. In addition to knowing
the proxy server's IP address, the client software also has to
know what port the proxy server is listening on, much like the
client must specify port 510 to talk to our servers (see “Ports
requirements” on page 69).

In order to configure the FirstClass server to work behind a
firewall, it is necessary to open the appropriate connections on
the firewall (see “Ports requirements” on page 69).
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Any ports specified in the NETINFO file, or by the defaults for
the NETINFO port configuration, must be supported by the
SOCKS4 proxy server. This typically means port 510 must be
accepted for relaying by the proxy server (referred to as "open").
To use additional ports (such as both TCPGUIPORT and
TCPRGUIPORT) listed in the NETINFO, the proxy server would
have to be configured to open these ports.

Port 23 is the Internet "telnet" program's port, which is used for
the CLUI interface. To use the CLUI through a proxy server, you
need a telnet program or terminal emulation program (for
example, Procomm Plus or HyperTerminal) that supports proxy
connections to a TCP telnet host. If you use CLUI, the FirstClass
client software and FCP protocol are not involved.
Communication occurs between the terminal program and the
proxy server. For example, the terminal program and proxy
server may support SOCKS5, and they could use that to connect
over the CLUL

If FirstClass Internet Services is on the outside of a firewall, the
proxy server will need to include the Internet ports it supports in
the list of ports opened for external access. This is usually set
already, as it was for telnet, because most proxy servers have
default configurations that open port 25 (SMTP), port 80
(HTTP), port 110 (POP3), port 119 (NNTP) and other common
Internet ports.

Because FirstClass Internet Services and the server can run on

two different machines, it is possible to place Internet Services
on the public/Internet side of the proxy server, leaving the core
server on the private side.

Some sites choose to isolate their server from the Internet,
requiring a SOCKS4 proxy for FirstClass client connections,
including possibly a SOCKS4 connection to the server from
Internet Services over port 510 or another port. This scenario
does not add security; the server is secure in either case.

A common dilemma when deciding upon a firewall is
determining the trade-offs between performance and security.
You must consider the path a packet travels, and the level of
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security checks that are being performed on each packet.
Network-level firewalls generally provide the highest
performance, followed by circuit-level firewalls, and then
application-level firewalls.

The level of security checks generally follows the reverse pattern
because, as network packets pass through more protocol layers,
they are inspected in more detail. As a result, application-level
firewalls are considered more secure than network-level
firewalls, which are considered more secure than circuit-level
firewalls. However, because a circuit-level firewall does not
perform extensive security checks, it often performs faster than
a network-level firewall that contains a large set of accept and
deny rules.

In general, application-level firewalls are the slowest
architecture because each packet is treated as two separate
network sessions and they implement the broadest set of
security data checks, increasing the required processing time.
Throughout the industry, however, application-level firewalls
are generally considered to provide the best security.

The following table lists the port number that must be open for
each connection type when setting up your firewall:

Port Connection type Description

21 FTP Ensure this port is accepted for
relaying (referred to as "open").

23 CLUI/Telnet  Ensure this port is open. This is the

Internet "telnet" program’s port,
which is used for the CLUI interface.

25 SMTP Ensure this port is open on the
firewall for two-way communication.
It is usually the default configuration
on the proxy server.

53 DNS Ensure this port is open. Although
we do not support DNS, we need to
connect to DNS servers on this port.

79 Finger
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Connection type

Description

80

HTTP

Ensure this port is open on the
firewall for two-way communication.
It is usually the default configuration
on the proxy server.

110

POP3

Ensure this port is open on the
firewall for two-way communication.
It is usually the default configuration
on the proxy server.

119

NNTP

Ensure this port is open on the
firewall for two-way communication.
It is usually the default configuration
on the proxy server.

143

IMAP

389

LDAP

443

HTTPS

510

TCP FCP

Ensure this port is open on the proxy
server on firewall for two-way
communication. To use additional
ports (such as both TCPGUIPORT
and TCPRGUIPORT) listed in the
NETINFO, the proxy server would
have to be configured to open these
ports.

810

UDP FCP

This port is used for IP Network
Notifier.

3000

FCP
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Understanding groups, organizational
units, and privileges

FirstClass provides the opportunity to customize user limits and
privileges in the way that best fits your organization. You can set
privileges once to satisfy all users, or you can set privileges at the
group or user level for a more flexible system customized to the
needs of each user or group of users. Privileges are an important
security feature in FirstClass and, if used effectively with
Directory filtering, can help you create a safe and worry-free
collaborative environment.

In this chapter we will discuss the standard user groups and how
privileges are set. Group privileges are set on the Group 7
Privileges form, while individuals’ privileges are set on the

Features and User Limits tabs of the User Information form.

Later, in Chapter 11, “Creating and customizing user groups”,

we will discuss specific user groups’ needs, and in Chapter 14,

“Adding users”, we will give specific privileges to selected users.

Standard user groups and how they work

When you install your FirstClass server, it automatically creates
several standard user groups. FirstClass automatically adds
users to these groups as required. While not all of these groups
are displayed in the User Groups section of the User Information
form, users still belong to them based on eligibility. The
following are the standard user groups and a list of users
belonging to them.

Warning: Do not delete or rename any of the standard user
groups. Deleting these groups can lead to
unpredictable system behavior and system damage.
If you delete one by mistake, recreate it
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immediately with exactly the same name and
restart your server.

Everyone who logs into your system is a member of the All Users
group. It is a good idea to set base system defaults at the All
Users level and then give or remove permissions and privileges
from that starting point. This results in a system which is much
easier to track and administer. The All users group will never be
listed on the Groups tab of a user’s User Information form since
all users belong to this group.

This group is made up of all users defined as Regular in the Class
field of the User Information form. By default, all regular users
will have Regular Users listed first in the list of groups to which
they belong on the Groups tab of the User Information form.

Never delete this entry. Enter all other groups below this entry.

This group is made up of all users defined as Remote in the Class
field of the User Information formBy default, all regular users
will have Regular Users listed first in the list of groups to which
they belong on the Groups tab of the User Information form.
Never delete this entry. Enter all other groups below this entry.

This group is made up of all users using FirstClass Personal. This
is a temporary group and users will only belong to this group for
the time they are using the FirstClass Personal application.

This group is made up of users accessing your system via
unauthenticated HTTP, Finger, or LDAP protocols, or users
accessing your system using a web browser to visit a user’s
website. This is a temporary group and users will only be a
member of this group until they log into FirstClass.

Note If this group is missing from your post office when
you start your server, you will receive a warning. If
this group does not exist in your Groups folder,
create a new group and name it Unauthenticated
Users.

This group is made up of gateways and users on remote servers
only.
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This group contains all conferences configured on your system.
It is a good idea to set default conference permissions at the All
Conferences level and then give or remove permissions for
conferences and conference groups from that starting point. This
results in a system which is much easier to track and administer.
The All conferences group does not apply to any Mailboxes on
your system.

This group contains all calendars configured on your system. It
is a good idea to set default conference permissions at the All
Calendars level and then give or remove permissions for
conferences and conference groups from that starting point. This
results in a system which is much easier to track and administer.

When you install FirstClass, this group may not be created in the
Groups folder by default. If it is not there, we suggest you create
a new conference group in the groups folder and name it All
Mailboxes. This group contains all user Mailboxes configured on
your system. It is a good idea to set default Mailbox permissions
at the All Mailboxes level and then give or remove permissions
for Mailboxes from that starting point. This results in a system
which is much easier to track and administer.

Note All folders on user’s Desktops inherit the user’s
Mailbox permissions. If the user has no personal
Mailbox permissions defined then the folder’s
contents will inherit the expiry period set at
Conference item expiry in the System Profile.

Several more standard user groups were installed by default in
FirstClass systems prior to FirstClass 7. If you want to recreate
these standard groups, simply create a group and give it the
name of the legacy standard group. The group will function the
same way it did previously.

Some standard user groups are specified as override groups.
These are temporary groups to which users are assigned based
on access method.

The override groups are:

¢ Unauthenticated Users
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» Autoregistered Users

o Offline Users.

The Autoregistered Users group can have a Model Desktop,
Offline Users and Unauthenticated Users cannot.

The values set on the Group Privileges form for those groups
override the values that are currently set for the user’s other
groups and the System Profile. The privileges set for these
groups can be overridden on users’ User Information forms.

For example, if you set a connection limit of Unlimited on the All
Users Group Privileges form, but you want all autoregistered
users to be limited to 30 minutes, set this value for the
Autoregistered Users group on the Connection limits tab of the
Group Privileges form.

Keep in mind that anything you enter on a individual’s User
Information form overrides all other settings.

Organizational units

An organizational unit is, quite simply, just another way to use
user groups to organize your system for easier identification of
users and/or to allow duplicate Directory entries (user names or
conferences). Organizational units are not required in setting up
your FirstClass system, but can play an important role in
organization and security, especially in complex FirstClass
systems with many users.

Warning Do not assign organizational units to Standard
groups.

If you are using batch administration to configure your system
and users, the SETOU command can be used to define the
organizational unit. For information, see our online help.

When configuring your system from the administrator’s
Desktop, organizational units are defined on the Group
Privileges form:
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@ Group name: |IT
Comments: | Department group

Organizational unit: |Department #1*| .« Require unigue names within this organizational unit

Organizational units are set at different levels, but the
organizational unit does not determine the hierarchical role of
the members. A user can be a member of several organizational
units. The most user-specific organizational unit is the user’s
Primary organizational unit. The Primary organizational unit
can be (but does not need to be) a member of a larger
organizational unit, like an umbrella structure. Organizational
units classify groups of users according to their role in the
organization, not according to their levels.

Note A user’s privileges and permissions are not inherited
from one organizational unit to another. You must
specifically assign the user to each group in the
proper order on the User Information form.

For example, Husky Planes has the following divisions within its
organization:

» employees

* management
o IT

* finance

* customers.

Management, IT, and finance are distinct departments within
the company and each user belongs to one of them. Therefore,
these groups will all be given the organizational unit level of
Department.

The customers group also fits this model since its members use
Husky Planes’s FirstClass system and communicate with some
Husky Planes employees. Therefore we will also give the
customers group the organizational unit level of Department.

Even though we decided that employees was a logical division in
the company, we still haven’t given the employees group an
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organizational unit level. Since this group contains most, but not
all, of Husky Planes’s users and it contains members of other
organizational units (some, but not all the departments —
customers are not employees, but they are a department on our
system), we will choose the organizational unit level of
Company.

When you list the Directory, the user’s Primary organizational
unit is displayed. A user viewing the Directory, or Who’s Online,
can easily determine what department another user is in.

& Who's Online
File Edit Format Message Collaborate Wiew Admin  Help

|Name =|Organization
¢ Administrator
§ Jjoa customer Customer
¢ joa amployes Emploves
i JoelT IT
§ joe manager Managemerit

In this example, Joe Employee is not a member of any specific
department so his Primary organizational unit is Employee.
Although Joe Manager and Joe IT are both employees (and
members of the Employees organizational unit), their Primary
organizational units are listed.

If a user belongs to two Primary organizational units
(management and finance, for instance), the one listed closer to
the top of the user groups list on the user’s User Information
form will be the one that is displayed. In the following example,
Joe IT is also a manager and is a member of the
Managementorganizational unit:

Planning your FirstClass environment



AdPriv71.fm

Understanding groups, organizational units, and privileges

Duplicate Primary organizational
units

File Edit Format Message Collaborate View Admin  Help

User Information  User Groups |FeaturesiUser Prefs | User Limits/Directory

=
Pl i rt
@ User groups: e | Mail impor

Setup POPS imported

Ces 0| Uzers The list of groups to mailbaxes
@ Fegular Users which this user
&) Employes belangs
- (:]8 | Preferences
gmana emert Membership in the -
. group provides the Edit uzers preferences

features and options
of the group, and

applies the group's

Model Desktop to this @l | Résumé
uzers Desktop B B
Edit uzers resuma

@ Desktop

Open usars Deskdop

In the Directory, Joe IT will be listed as IT, not Management.

Conferencesin Conferences and conference groups created by the administrator
organizational units on the administrator’s Desktop do not belong to an 7
organizational unit. However, administrators can set the
conference or conference group organizational unit using the
batch administration SETOU command. For information, see
our online help.

The user inherits the organizational unit of his Primary
organizational unit. If you have given your users permission to
create conferences, any conference a user creates will inherit the
user’s Primary organizational unit.

Organizationalunitsand  As stated earlier, organizational units allow you to have multiple

::rrlii;:te Directory Directory entries. If you select Require unique names within this
organizational unit, you can have two people with the exact same
name in the Directory as long as they are in separate
organizational units. For instance, if you have a Lisa J. Smith in
Management, you can also have a Lisa J. Smith in Finance.
When you list the search for Lisa J. Smith in the Directory, you
will see the following:
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List Directory

File Edit Format Message Collaborate ‘iew Admin  Help
@ Search for items in the Directory .
Enterthe name of the person oritem and click Search i | Mew User
Pattern: |liza 6| Edt...
Search: By Mame j Stop ﬁf—'é Open Desktop
Showe: |/ Regular users Remote natmes m Delete
-~ Remote users Conferences =
Gateways & routes Cither )| hiewiessage.
{Kl I3|I\Jame Uszer ID |Organizati0n |Aliases
§ lizaj. smith lizas Finance
§ ligaj. smith Izmith Management
< >
2 fems.

You cannot have duplicate names within the same
organizational unit. If Lisa J. Smith is promoted from Finance to
Management, you will have to change her name in the Directory
(Lisa Julie Smith, for instance).

Note You can never have duplicate userids.

The flexibility organizational units adds to your system is best
seen when used in a multi-tenant environment. This is a
configuration in which there is more than one independent
system running on a single FirstClass server. These systems are
entirely independent of one another, and users on one system
can never see users on any other system in the Directory.

The following is an example of using organizational units in a
multi-tenant environment:

Husky Planes is starting a subsidiary company, Malamute
Transport. Malamute Transport will still use Husky Planes’s
FirstClass system. However, management wants Malamute
Transport to be its own independent entity. They do not want to
share information, communication, or Directory listings
between the two companies. While they will share a FirstClass
system, they will be entirely separated from each other. The
FirstClass administrator will use organizational units and
Directory filtering to accomplish this as follows:
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In the Groups folder:

1.

Do not change any of the Standard, Configuration, or
Directory Filtering groups. Any settings or overrides set for
these groups will apply to all applicable users on your
system.

In the Department groups section, create a new group called
HP Users. This will be the master group to which you will
add every Husky Planes user.

Create a new conference group called HP Conferences and
anew calendar group called HP Calendars. These will be the
master groups to which you will add every conference and
calendar respectively for Husky Planes.

Rename all Department groups, Conference groups and
Calendar groups to be specific to Husky Planes. For instance,
rename Employee to HP Employee, and Finance to HP
Finance. You may want to group all Husky Planes groups on
one side of the Groups folder to make organization easier as
your system grows.

At this point, the Groups folder will look something like this:
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File Edit Format Message Collaborate Wiew Admin  Help

+ . = £ He A T
@‘) E&é tﬁ o = K =W p
3 Folder 60Files O Folders 16 Deleted  Husky Planes com © Administrator oL

'C,.. Standard Groups
@ AllUsers

@ Regular Uzers

@ All Conferences

@ Sub Admin
@ Pacific Time Zone

@) wish Names

t.. Department Groups

@) HP Users

® HP Employes
@ HP Marketing
@) HP Customer
@ HP Management

@ HP Employee Send

@) Autoregistered Users ) Offine Users () Cther Sites

'C,.. Configuration Groups

'C.. Directory Fitering Groups

@ HP Human Resources CG @ HP Marketing C @ HP Office Services CG @ HPIT CG

@) HP Sales CG @) HP Maniagement CG @) HP Consultant CG

(@) HP Customers CG @) HP Intermet Newes G @ HP Private Calendar
< *
60 tems.

@) Remote Users (@ Unautherticated Users

@ &l Calendars

(&) High Disk Uzage (@) Help Desk (@) Webmasters @) Suspended
@) Mourtsin Time Zane @) Central Time Zone (%) Esst Coast @) Vaice Users

@& vieh Calendars @ Wb Conferences

@ HP Conferences @ HP Calendars

@) HP Cliert Services (@ HF Finance

@ HP Office Services @ HP Sales

@ HPIT @ HP Human Resources
@) HP Consuttant

@) HP Employee Read @) HP Client Services CG - @) HP Finance CG

5.

Set the organizational unit levels of the HP groups:
Set the HP Users organizational unit level to Company.

Set all other HP groups organizational unit levels to
Division, Department, Group, or Team, as appropriate.

Husky Planes will have a different domain name than
Malamute Transport. On the Services tab of the HP Users
Group Privileges form, enter huskyplanes.com at Domain
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name (this is Husky Planes’s registered domain name). All
the Internet aliases for members of this group will default to
this domain name.

If you will not have separate domain names for your
multiple tenants, do not enter the domain name here.

Notes If a user is a member of multiple organizational
units and more than one of them has a domain
name, the domain name for the user’s Primary
organizational unit will be used.

If you have multiple domain names, remember to
include them on the Multiple Sites and Languages
form. For information see FirstClass Internet Services
Administrator’s Guide and our online help.

Do not set up Directory filtering for HP Users, HP
Conferences and HP Calendars.

Set up Directory filtering for all other HP groups as follows:

On the Directory tab, at Allow this group to view these
groups, enter HP Users, HP Conferences, HP Calendars.

Note You can filter the Directory more if you like, but
ensure these are listed first.

Some things to remember:

 Ensure that any user added to the Husky Planes system is
made a member of the HP Users group. List this directly
after the class of user group on the Groups tab of the User
Information form.

» Ensure that every conference on the Husky Planes system
(and any conferences you add to the Husky Planes system
later) is made a member of the HP Conferences conference
group.

» Ensure that every calendar on the Husky Planes system
(and every calendar you add to the Husky Planes system
later) is a member of the HP Calendars groups.
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* When a user creates a new conference, the user’s
organizational unit is inherited to the conference, so the
Directory filtering rules will be applied automatically.

9. Create a Department group structure for Malamute
Transport using the same principles used for Husky Planes.

Notes Preceed all user, conference, and calendar groups,

as well as all conferences and calendars with MT to
distinguish them as being solely for Malamute
Transport.

The MT Users organizational unit level should be
set to Company (like HP Users).

All other MT groups should have logical
organizational unit levels set.

Remember to make all Malamute Transport users
members MT Users, all Malamute Transport
conferences members of MT Conferences, and all
Malamute Transport calendars members of MT
calendars.

The Husky Planes/Malamute Transport multi-tenant
environment Groups folder looks like this when complete:
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Multi-tenant Groups folder

"f-’"Gruups
File Edit Format Message Collaborate View Admin Help

Mm@ = S P

[0 Folder 77 Files 0 Folders 1 Deleted  Husky Planes.com : Administrator &
Y. Standard Groups
@ Al Users
@ Regular Users @ Remote Users @ Unautherticated Users

@ Autoregistered Users @ Offline Users () Cther Sites
@ All Conferences @ &l Calendars

Y. Configuration Groups
@ Sub Admin @) High Dizk Usage @) Help Desk @) Webmasters @ Suspenced

@) Pacific Time Zone @® Mouritain Time Zone () Certral Time Zone (D East Coast @ Woice Uzers

{ Directary Filtering Groups
) wieh Mames @) wieh Calendars [‘@ Wk Conferences

V7. Department Groups
&) MT Users @ MT Conferences @ MT Calendars

@) HP Users @ HP Conferences @& HP Calendars
@ HP Employes @ HP Client Services (@ HP Finance @ MTEMPIOYEE ) T Consuttant
@ HP Marketing @) HP Office Services @) HP Sales @) MT Finance @) MT Sales
&) HP Customer @ HPIT @ HP Human Resources (@) MT Customer @) MT Human Resources
@) HP Management @ HP Consultant @) MT Marketing @) MT Managemert
@) HP Employze Send g HP Employes Read g HF Cliert Services CG @) HP Finance CG @) MT Employes @)MT Finance 6
HP Hutman Resources CG HP Marketing CG HP Office Services CG HPIT CG
@ @ @ MT Sales CG [@I MT Management CG
@) HP Sales G @) HF Managemert CG (@) HP Consutant £
@) MT Customers CG @ MT Marketing CG
@) HP Customers CG (@) HP Internet News CG @ HP Private Calendar
< ¥
77 tems.

No user configured as a member of HP Users can see any user in
the MT Users group. All Husky Planes conferences and calendars
are hidden from all Malamute Transport users, and vice versa.
With the Directory partitioned in this way, they can function as
two completely independent systems, apart from the server
administration. Any tracking and billing can be done at the
company level (or group, or user level), instead of at the All
Users level, making this a true multi-tenant environment.
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Using Designer to edit
organizational unit
levels

If you want to edit the names of the organizational units, or add
more levels to better fit your organization, use FirstClass
Designer. For basic information about editing forms using
designer, see FirstClass Designer, or our online help.

The server reads the organizational unit as a number only. If you
open the Group Privileges form using Designer and look at the
organizational unit dropdown list, you will see that each level
has a number beside it. You can edit the wording beside the
number, or you can even edit the numbers. As well, you can add
additional choices to this list. The numbers are merely a way for
the server to read the written information. Valid numbers are
between 0 and 800.

How group and user privileges are set

While privileges and how they are set may seem complicated,
they actually follow a few simple rules. First, let’s look at a User
Information form and see how user groups are listed. Since you
haven’t added any users yet, we’ll have to look at the
administrator’s account.

1. Select Admin > List Directory.
2. Enter Admin in the Pattern field.
3. For Search select By Name.

4. Check Regular Users.

5. Click Search.

Since only one name will come up, it will be preselected.
6. Click Edit.

7. Select the User Groups tab.
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Admin user groups

File Edit Format Message Collaborate View Admin Help

User Information  User Groups |Featuresiser Prefs | User LimitsiDirectory

L .
@ User groups: & | Mail import

Setup POP3 imported

Ses Al Lzers The list of groups to X
" " mailboxes
@ Regular Uzers which this user
belongs
<8 | Preferences
tembership in the
group provides the Edit users preferences

features and options
of the group, and
applies the group's

Model Desktop to this @l | Résumé

users Deshitop
Edit uzers résumé

ﬂ Desktop

Open users Desktop

Cancel
Ok, 7

As you can see, the administrator currently belongs to only one
visible user group, Regular Users. However, everyone who logs
into your system is also a member of the All Users group.

Since everyone belongs to All Users, it’s simplest to set system
wide settings there. You can alternatively use the privileges and
the Model Desktops of the class of user groups to control what
users see. Since all users are either Regular or Remote, you can
modify those groups to control features for everyone.

When FirstClass sets features for each user, it looks at the
following items in the following order:

* the System Profile
* the All Users group
* the class of user group (Regular users or Remote users)

* the groups you have created and added the user to in the
order in which they appear in the User Groups field
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 the User Information form.

The key things to remember are:

* every setting in the User Information form overrides what was
set before

« user defined groups override those groups that came before
them.

Therefore, you should take care in the order in which you place
your user groups. The tristate checkboxes on the user group
indicate whether a setting has been changed or left as previously
defined. The User Information form has two checkboxes, one is
a tristate box used to change the setting, the other is a display
only field indicating the current setting. From the User
Information form, you can determine exactly what features each
user has.

Setting the All Users group defaults

88

Before you begin giving privileges and access to groups and
users, you should set your defaults on the All Users form. These
settings will be the default, or unchanged state, in the tristate
boxes for all other groups.

Open the All Users Group Privileges form by double-clicking All
Users in the Groups folder.

Set all overall defaults you want to use for your system, based on
your company’s needs, policies and security. You might find it
helpful to make a note of these settings for future reference.

Warning Never leave checkboxes on the All Users, All
Conferences, or All Calendars forms in the
unchanged (cross hatched) state. They must all be
set to on (checked) or off (cleared).

We will set the following defaults for Husky Planes:

Planning your FirstClass environment
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Features tab

Standard Group

File Edit Format Message Collaborate

@  Group name: |AllUsers

Comments: |Standard Group

COrganizational unit: | None

View Admin  Help

i

Features lUSer Prefs | User Limits ] Directory ] Sec:ur'rty] Services]

Uze this tab to define privileges for this group.

G - Email

Private mail
Conferencing
Unzend

Iake urgent
Mark as unread
Set expiry
Receipt notification
Search

Upload
Dawenload
Address book

SISISISISSISISISTS

<

Ces - Cither privieges
Chat
Calendaring
Wievy rEsUmEs
Puhlish home page

e - Achvanced
Create conferences
Wiewy unlistec
Wiy user information
Edlit user information

e - Special status
Subadminiztr atar
Does nat expire

Ben - Access
« FirstClass access
» Internet access
» Command line access
 Wiark offline
Wioice access

L Require unigue names within this organizational unit

i | model Desktop

Lay out users Deddops

Legend

w  overides the previous
setting to turn on this
privilage

wvernides the previous
setting to turn off thiz
privilage

leaves the status of this
privilege unchanged

Cancel
oK

On the Features tab, we will make some decisions about what

features all users can access and what we will allow users to do
on our FirstClass system. We will also define what methods of

access we will allow our users.

We will turn on all features in the Email section. We will
override some of these settings for specific user groups later. In
the Other privileges, Advanced, and Special status sections, we
will make sure all features are turned off. We will give these
features to specific user groups later, but if we forget, it’s safer
to have them turned off than on. In the Access section, we will
turn on all access methods except for Voice access, since this is
only used with FirstClass Unified Communications (for
information, see FirstClass Voice Services Administrator’s Guide).
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User Prefs tab

tandard Group

@  Group name: |AllUsers
Comments: | Stancard Grougp

COrganizational unit: | None

Uze this tab to define user preferances..

Preconfigurable user preferences

Advanced uzer preferences

W« Mail impart
« Wail rules

w Forweard

File Edit Format Message Collaborate

Features User Prefs | User Limits ] Directory ] Sec:ur'rty] Services]

o userto configure own Freferences, pasavord, and createfedit résumés.
Advanced user preferences may also be required.

Reply preference: Automatic j setting to tumn on this
Time zone: Default = privilege

. . | - o wvernides the previous
Client interface: FirstClass Classic ﬂ setting to tum of this
“Yoicemail Interface: Default ﬂ privilege
Preferred language: | leaves the status of this

These prefarences can be contralled separately.

View Admin  Help

L Require unigue names within this organizational unit

i | model Desktop

Lay out users Deddops

Legend

w  overides the previous

privilege unchanged

Cancel
oK

On the User Prefs tab, we will set system-wide user preferences.

Selecting Edit preferences gives all users the ability to change
their personal preferences. You might want to disable this
privilege for guest accounts to ensure the accounts are always
left in the same state.

We will choose the following values:

Reply preference

Time zone

Client interface

Voicemail interface

Planning your FirstClass environment

Automatic

Default since our users are in the same time
Zone as our server.

FirstClass classic. Our users will quickly
become familiar with this easy-to-use
interface.

Default. This field is described in detail in
FirstClass Voice Services Administrator’s
Guide and is used only for FirstClass Unified
Communications customers.
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Preferred language None. Once again, this is a FirstClass Unified
Communications feature.

Mail import We will select this to allow users to set up
POP3 mail import.

Mail rules We will select this to allow users to define
personal mail rules on the personal
preferences form.

Forward We will select this to allow users to forward
personal mail as well as messages in
conferences.

User Limits tab

Standard Group

File Edit Format Message Collaborate Wiew Admin  Help

@ Group name: |&Users
Comments: | Standard Grougp

Crganizational unit: | Mone il Require unique names within this organizational unit

Features | Lser Prefs  User Limits ]Directory] Secur'rty] Services]

Use this tab to define time and disk space limits for this group. ﬁl"‘é Model Desktop
5 . . Lay aut users Deddops
Private mail expiry: Defaut 27| days v G 7

Daily connection limit: Dy

#|~| minutes

Legend
Session inactivity limit:  Default ¥ minutes ~  overrides the previous
setting to turn on this
Disk space limit: 20000k ]| kiobytes privilage

averrides the previous
setting to turn off this
privilege

leaves the status of this
privilege unchanged

Cancel
Ok

On the User Limits tab we will set the system defaults for Private
mail expiry, Daily connection limit, Session inactivity limit and
Disk space limit. All of these limits, except for Disk space limit
were already set on the System Profile. The value for Default on
the All Users Group Privileges form is the value that you set on
the System Profile. Any value added to a Group Privileges form
will override the System Profile for all users in that group.
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We will allow users 20,000 kb of disk space.

Directory tab

tandard Group

File Edit Format Message ollaborate Wiew Admin Help

@  Group name: |AllUsers
Comments: | Stancard Grougp

COrganizational unit: | None ol Require unique names within this organizationsl unit

Festures | User Prefs | Uzer Limits  Directory lSecur'rty] Services]

Use this tab to define the names that this group's Directany can list. ﬁf-‘é Model Desktop

q 5 Lay out users' Desdops
Allowy this group to views these groups: v e

The Directory is unrestrictad if this
field iz blank or contains the All Users, Legend
All Conferences and All Calendars

w  overides the previous
groups.

setting to turn on this
Note: This may be overridden by privilege

restrictions placed at a higher lewel. averides the previous

setting to turn off thiz
rivilage

Do not allow this group to views these groups: b g

leaves the status of this

privilege unchanged

Cancel
Mazimum number of muttimatch names: Drefault 2
Automatically filter directory to this group L

On the Directory tab we can set system-wide Directory filtering.
By default the Directory is unrestricted for all standard groups
with the following exception:

* the Unauthenticated Users group can see only members of
Web Names, Web Conferences, and Web Calendars groups.

This configuration provides us with a level of security we're
comfortable with for now. We won’t restrict the Directory any
more at this level, but will set Directory filtering for selected
groups of users later. Directory filtering will be described in
detail in Chapter 9, “Understanding Directory filtering”.
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Security tab

Standard group

File Edit Format Message ollaborate Wiew Admin Help

@  Group name: |AllUsers
Comments: | Standard group

COrganizational unit: | None ol Require unique names within this organizationsl unit

Festures | User Prefs | User Limits ] Directory Security lServices]
Use this tab to define the security limits. ﬁf-‘é Model Desktop

Password security Lay out users' Desdops

Pazzword restrictions: Letters and numbers |

Legend
Recent passwords: Block recently used passwords ll

w  overides the previous
Pazswoard expiry period: 12 weeks 6 days j setting to turn on this

o privilage
hinimuim text password length: 4 el
wvernides the previous

Minimum voice passward length: |4 A setting to turn off this

privilage

leaves the status of this
privilege unchanged

Cancel
oK 7

On the Security tab, we will set some important rules about
password use and download limitations.

Password restrictions We have chosen Letters and numbers to
force users to have more complex
passwords, so their accounts aren’t easily
accessed by others.

Recent passwords We block users from reusing any of their
last five (5) passwords used. This gives us
added security.

Password expiry Enter the number of days between

period password expiration, or choose Never.
We entered 90 days (12 weeks 6 days).
This is long enough that users are not
constantly having to change their
password, but short enough to ensure a
secure system.
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Minimum text
password length

Minimum voice

password length

Download limitations
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8. This number is high enough to force
users to choose complex passwords, but
not too long that they will forget.

4. This is a reasonable minimum length for
numeric passwords. You only need to put
a value here if you have FirstClass Unified
Communications.

This field is primarily used to stop viruses
from being sent through your FirstClass
system. If there is a known virus, enter the
exact attachment name in this space.
FirstClass will not allow uploading or
downloading of this specific attachment
name.

This field can also be used to disallow
downloading files of a specific type. Enter
the file extension preceeded by a wild
card. FirstClass will not allow uploading
or downloading of this file type.

You can set attachment limitations for the
All Users group, or any groups you create.
Do not set attachment limitations on any
other Standard user group.
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Services tab

Standard Group

File Edit Format Message ollaborate Wiew Admin Help

@  Group name: |AllUsers
Comments: | Stancard Grougp

COrganizational unit: | None ol Require unique names within this organizationsl unit

Festures | User Prefs | User Limits ] Directory ] Securtty Setvices
Use this tab to define the limits to senvices. ﬁf-‘é Model Desktop
Irternet Services Lay out users' Desdops

Internet mail domain:

Legend
“oice Services W overides the previous
DM prefix setting to turn on this
privilage

Ciperator revert DR
P wvernides the previous

Dialling restrictions: setting to turn off this
privilage

leaves the status of this
privilege unchanged

Cancel
oK 7

The fields on this tab pertain specifically to Internet Services and
Voice Services. They are discussed in our online help.

Optional method for If you have an extremely small system and want to build each

small systems user group’s (or individual user’s) privileges individually, clear
every checkbox on every tab. All corresponding tristate boxes on
any group form in the unchanged state (cross hatched) will
default to the Off setting you set on the All Users form. While this
is a safer method than selecting all checkboxes and then having
to clear unwanted checkboxes on the group forms, neither of
these methods is recommended. This practice will result in a
FirstClass system that is very difficult to monitor and administer
as every user will have custom settings. This method may lead to
problems as your system grows.
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Understanding Model Desktops

As administrator, you can use the Model Desktop feature to
customize the appearance of users’ Desktops. For each user
group, you can design a Model Desktop that determines:

« the icons that appear on the Desktops of members of the
group

* the properties and location of each icon

« the Desktop size, sort order, view, and split bar location for
conferences and other windows.

Each user group has a Model Desktop. Icons for all the

conferences and folders on the Model Desktop appear on the 8
Desktops of all members of the user group in the same location

as they appear on the Model Desktop.

When you add a new user to a user group, you automatically
place all the objects found on the group Model Desktop onto the
user’s Desktop. When you delete a user from a user group, you
delete the objects found on the group Model Desktop from the
user’s Desktop. Similarly, when you add an object to the group
Model Desktop, you add it to the Desktops of all members of the
group. When you delete an object from the group Model
Desktop, you delete it from the Desktops of all group members.

By creating Model Desktops for your user groups, you can
reduce the effort involved in maintaining a complex system.
Instead of customizing each user’s individual Desktop, you
customize the look of a group of users’ Desktops.

Note When a user is added as a member of several
groups, the icons from all of the groups’ Model
Desktops appear on the user’s Desktop. Use careful
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planning to create Model Desktops that can be
easily combined without overlapping icons.

In this chapter, we’ll look at the All Users Model Desktop and the
Model Desktops of user groups in the default post office.

The All Users Model Desktop

The Model Desktop for the All Users group determines the
following characteristics:

« the position and dimensions of all users’ Desktops
« the position of the Mailbox folder on all users’ Desktops

« the icon used for the Mailbox on all users’ Desktops

Double-click the All Users group and click Model Desktop.
Al Users Model Desktop

W A1l Users Model (i=(E3
File Edit Format Message Collaborate View Admin  Help
i 2 + &
=2 a i} £y el
3 Folder OFiles 6 Folders  Husky Planes.com : Administrator W FLE

b,

T

Addr.ess Book

Calendar

Home Page Folder
\&-_.
Bookmarks

&

Help

1 em selected.
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Note that the standard objects are placed along the left of the
Desktop. This will be true for all users, so when we add items to
other groups’ Model Desktops, we will not place them along the
left side. There are six standard objects on the All Users Model
Desktop:

* Mailbox

+ Address Book

» Calendar

* Home Page Folder
» Bookmarks

* Help

Even though we have the option of turning off the email
privilege for the members of a user group, the Mailbox icon will
still appear on their Desktops since it exists on the All Users
Desktop. Even if we deleted the Mailbox from the Model
Desktop it would still appear on users’ Desktops since it is just a
placeholder. Members of the user group will be able to receive
and read email, they just won’t be able to send or reply to private
email. When they send mail to conferences, a copy of the sent
message will be in the user’s Mailbox.

Whether or not users have the Address Book feature enabled, all
users have a personal Address Book on their Desktops. If the
feature is enabled, a user can address mail to anyone in his
Address Book the same way he does for anyone listed in the
Directory. If this feature is not enabled, the Address Book can
still be used as a storage container for personal contacts. For
information about addressing messages, see our online help.

This is the user’s personal calendar for scheduling tasks and
events. If this feature is not enabled, the user cannot open this
object on his Desktop. If you do not enable this feature for all
users, you can delete the calendar from the All Users Model
Desktop and add it to other groups’ Model Desktops so only
selected groups of users will have a calendar on their Desktops.
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Home Page Folder

Bookmarks

Help

Simply create a protected folder called Calendar and give it the
appropriate icon.

Users can create personal home pages in this folder to be
rendered directly to the web.

If this feature is not enabled, either on the Group Privileges form
or on the User Information form, users can still create internal
home pages, which can only be seen by those people who can
see the user’s name in the Directory when using the client.

All users have access to this feature. For information about
creating and using bookmarks, see our online help.

This folder contains help files explaining many of the basic tasks
FirstClass users will want to perform. You can add additional
help material if you wish by adding documents to the Help folder
on the administrator’s Desktop. Users can also access the Help
contents by choosing Help > Help contents, or by pressing F1.

Configuration Groups’ Model Desktops

Sub Admin

Only two of the groups classed as Configuration Groups have
customized Model Desktops. These are:

¢ Sub Admin

» Webmaster.

The Sub Admin Model Desktop contains a Sub Admin folder
containing all the objects a subadministrator requires from the
administrator’s Desktop for his role as subadministrator. For
information about subadministrators, see “Subadministrators”
on page 11. This folder is on the bottom row of the second
column. Remember that there is an icon in this space when
combining Model Desktops for subadministrators.

Jack Gerb is the subadministrator for Husky Planes. By adding
Employee and Sub Admin to the list of groups to which he
belongs, he will see the following Desktop when he logs in:
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W Desktop
File Edit Format Message Collaborate ‘iew Admin  Help
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® @
=
IailEox Employes Lounge

Addr.ess Biook

Calencar

A

Sub Admin
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g
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i ftems.

The Sub Admin folder contains all the Desktop objects from the
administrator’s Desktop that he needs to perform his duties as
subadministrator. The Employee Lounge conference is on all
employees Model Desktops and will be discussed later in
“Department Groups’ Model Desktops” on page 103.

The Webmaster Model Desktop contains a Webmaster folder
containing all the objects required to administer Internet
Services. For information about Internet Services, see FirstClass
Internet Services Administrator’s Guide. This folder is in the
bottom row of the second column. Remember that there is an
icon in this space when combining Model Desktops for Internet
Services administrators.

Michelle Weeks is the webmaster for Husky Planes. By adding
Employee and Webmaster to the list of groups to which she
belongs, she will see the following Desktop when she logs in:
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Webmaster Model Desktop

%W Desktop
File Edit Format Message Collaborate Wiew Help
g P delk @i o @b
T8 Desktop OFiles 8Falders Husky Planes.com : Michelle Weeks o
&did
hiailBox: g

Employee Lounge
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Home Page Folder
g
Bookmarks

&

Help

& ftems.

The Webmaster folder contains all the Desktop objects from the
administrator’s Desktop that she needs to perform her duties as
webmaster.

Web Master folder

¥ Web Master, |
File Edit Format Message Collaborate ‘Wiew Admin  Help

a = o & e

2 Folder 1 File 4 Folders  Husky Planes .com : Administrator @ & &

v v Vv
[ FTF Java  FC Resource Registry
>

Internet Monitor

3 ftems.
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The Employee Lounge conference is on all employees Model
Desktops and will be discussed later in “Department Groups’
Model Desktops” on page 103.

Department Groups’ Model Desktops

Each Department Group contains one or more objects specific to
the group’s users. All members of the Employees group have a
link to the Employee Lounge, an employee collaboration area, in
the top row of the second column of their Desktop. When adding
objects to or combining employees Model Desktops, remember
that there is an icon in this space.

All other Department groups have one or two additional icons
on their Model Desktops. These icons are placed in the second
and/or third row(s) of the second column. When adding objects
to or combining Model Desktops, remember there are icons in
these spaces.

Michael Hill is a member of Husky Planes’ sales team. By adding 8
Employee and Sales to the list of user groups to which he
belongs, he will see the following Desktop when he logs in:
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Sales employee Model Desktop

%4 Desktop
File Edit Format Message Collaborate Wiew Help
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]

Home Page Folder
g
Bookmarks

&

Help

& ftems.

The Sales Area is the main collaboration area for all sales staff.
It contains a Sales calendar to coordinate events specific to sales
staff and it contains a message archive so the main conference

can always be kept current, but no old messages will be lost.

Adding objects to Model Desktops

You can add a link to any FirstClass object (calendar,
conference, folder) to any group’s Model Desktop. In
Chapter 12, “Adding conferences and conference groups” we
will create some custom conferences and then add the
conferences to our groups’ Model Desktops.
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Moving objects on Model Desktops

The position of any object on a Model Desktops can be changed.
This can be done in any of the following ways:

» dragging and dropping the object to a new position on the
Desktop

This can be used if you want the Model Desktop to be in a
creative design. For example, wrapping around a background
image, or representing your organization’s name, initials, or
emblem.

« moving the object to a specific location on the Model Desktop
To do this:

a) Select the item to be moved and choose Edit >
Properties (Windows)/Get Info (Mac OS).

b) Change the horizontal and/or vertical position values to
the exact spot where you want the icon placed on the
Model Desktop.

c¢) Click OK. 8

» moving the object one pixel at a time horizontally or
vertically.

To do this, hold down Ctrl + Shift (Windows)/Option (Mac
0OS) and the appropriate arrow key.
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Understanding Directory filtering

Directory filtering allows the administrator to control what
people can see in your FirstClass Directory. When no Directory
filtering is used, anyone we add to any group can see all the
entries in the Directory. If users can’t see things, it makes it a lot
harder for them to post to them. Filters let us make sure users
only see names they should be able to post to, or at least be
aware of.

Using the FirstClass Directory

The Directory is a database containing the names of all global

objects defined on your FirstClass system (users, conferences, 9
public mail lists, groups, calendars, remote names). The

FirstClass server consults the Directory when a user performs the
following tasks:

* logging in
* addressing mail
 sending mail.

Users can consult the Directory to find the name of a user or
conference to which they want to address mail. You can display
the Directory by choosing Collaborate > Directory.

As the administrator, you have a more powerful search
mechanism, the Admin > List Directory command. This allows
you to filter the Directory listing, selecting the types of objects to
be displayed, and their sort order. The List Directory looks like
this:
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List Directory

List Directory

File Edit Format Message Collaborate ‘Wiew  Admin  Help
@ Search for items in the Directory -
Enterthe name of the person oritem and click Search W | Mew User...
Pattern: 0| Edit...
Search: By Mame ﬂ Stop ﬁlf-‘g Open Desktop
Showe: |/ Regular users Retmote names m Delete
. Remote users Conferences =
Gateways & routes Cither [ | M= HiEesaTe...
{Kl = |Name Uszer I :jOrganizaﬁon |Aliases ~
§ o customer jcust Customer
§ joe employee jemploy Employes
§ Jack Gerb jmerh Employee
i JoeIT Jit IT
¢ ioe manager imanacier hanagement
¢ ioe worker iwvorker Employes
§ ligaj. smith lizasz Finance w
< >
1 tem selected.

You can search by name, User ID, group, Internet alias, or Client
ID, and filter your search by type of user, conference, gateway,
or other object type.

Once you have executed your search, you can manipulate user
data directly from the List Directory. Select the user you want to
change, and then select:

» Edit
to edit this user’s User Information form

* Open Desktop

to open this user’s Desktop

* Delete

to permanently remove this user from your system

* New Message

to address mail to this user.

Select New User to add a new user to your FirstClass system.
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Privacy in your FirstClass system

Creating Directory filters

By default the Directory is unrestricted for all standard groups
with the following exception:

* the Unauthenticated Users group can see only members of
Web Names, Web Conferences, and Web Calendars groups.

You can control how much of your system can be viewed in the
Directory in several ways:

* You can make a user account, conference, or public mail list
unlisted.

Only users with the View Unlisted privilege can see unlisted
users in the Directory.

Making users unlisted is discussed in Chapter 14, “Adding
users”, making conferences unlisted is discussed in
Chapter 12, “Adding conferences and conference groups”,
and making public mail lists unlisted is discussed in
Chapter 15, “Public mail lists and chats”.

* You can allow members of user groups to view only selected
user groups, conference groups, or conferences in the
Directory using the Group Privileges form.

* You can allow specific individual users to view selected user
user groups, conference groups, or conferences in the
Directory using the User Information form.

You can filter the Directory at the user group level, or at the user
level. We recommend setting Directory filters for user groups
instead of individual users since this gives you more uniformity
in your system and makes it easier to administer. Set Directory
filters at the user level for special privileges only.

To set Directory filters at the group level, use the Directory tab
on the Group Privileges form.

To set Directory filters at the user level, use the Directory tab on
the User Information form.
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Group Privileges - Directory tab

tandard Group

File Edit Format Message ollaborate Wiew Admin Help

@  Group name: |AllUsers
Comments: | Stancard Grougp

COrganizational unit: | None ol Require unique names within this organizationsl unit

Festures | User Prefs | Uzer Limits  Directory lSecur'rty] Services]

Use this tab to define the names that this group's Directany can list. ﬁf-‘é Model Desktop

q 5 Lay out users' Desdops
Allowy this group to views these groups: v e

The Directory is unrestrictad if this
field iz blank or contains the All Users, Legend

All Conferences and All Calendars o~ overidesthe previous

groups. setting to turn an this

Mote: This may be overridden by privilege

restrictions placed at a higher lewel. averides the previous
setting to turn off thiz
privilage

Do not allow this group to views these groups:
leaves the status of this
privilege unchanged

Cancel
Mazimum number of muttimatch names: Drefault L

¥

Automatically filter directory to this group L

Allow this group to Use this to include only certain user
view these groups groups and/or conference groups in the
group’s view of the Directory.

Any user group, conference group, or
calendar group listed here will be seen in
the Directory by any user who is a
member of this group. All other user
groups, conference groups, and calendar
groups will not be listed in the Directory
for all members of this user group.
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Maximum numberof  Default is unrestricted. Use this to add

multimatch names security to your system. If this is set to 0,
then users (and unauthorized guests or
autoregistered users) cannot guess partial
names and access the Directory. Users
will have to know the exact name of the
person to whom they want to address
mail.
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Using batch administration

Batch administration is a process for transmitting scripted
commands to the FirstClass server. You can use batch
administration to add large groups of users, conferences, and
groups quickly, or to restore select portions of your post office
from backup.

An organization with a large user base will find that batch
administration can streamline the administration of its system.

If your user base changes constantly, invest some time in

exploring the capability of batch administration. If you are

beginning a new system, batch administration can quickly create

all user groups and users. 1 0

Your Human Resources database is an important part of
managing a site through batch administration scripts. Since user
IDs are needed to add, delete, or modify user accounts, unique
user IDs must be generated from your database. Once you have
produced a delimited flat file from your database, you can use
any spreadsheet program to manipulate the data into the batch
administration commands. With most spreadsheet programs,
the data can be copied from the worksheet and pasted into a
FirstClass message. The columns will be translated to tabs in
FirstClass.

In this chapter, we will look at the following aspects of batch
administration:

» how FirstClass uses batch administration
* setting up batch administration

* tips and reminders.

For batch administration commands, descriptions and syntax,
see our online help.
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How FirstClass uses batch administration

Batch administration provides a batch interface to FirstClass
administration; that is, an interface in which commands are
executed from a file, rather than from manual input.

The Directory synchronization feature uses batch administration
to replicate user information among all the servers in a FirstClass
network. For information about Directory synchronization, see
Chapter 16, “Adding gateways”.

Setting up batch administration

To use batch administration, simply send a message containing
your commands to “Batch Admin”. The batch administration
task executes the commands in the message. By default, only the
administrator can send batch administration requests. Other
users can be given permission to execute batch administration
commands using a password. To allow other users to execute
batch administration commands, see our online help.

warning If you give others this permission, change the
password frequently to prevent unauthorized access
to the Directory. Do not use the administrator
account password.

You can also create a text file with the extensions .ba (for
example, myfile.ba) and place the file in the FCPO\Server\Batch
folder (Windows), or in the FirstClass Post Office\Server\Batch
folder (Mac OS). The next time the server is started, the batch
administration script will execute. After finishing, the text file is
deleted from the folder.

Tips and reminders

When using batch administration, keep the following tips in
mind:

» Many batch administration commands refer to network users
and telecom users. These terms are used for compatibility
with older batch scripts. Network users are Regular users, and
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telecom users are Remote users. For information on classes of
users, see Chapter 3, “FirstClass server concepts”.

Many batch administration commands refer to Remote users
and remote names. Be sure you understand the difference.

» A remote user is classified as such in the Class field on the
User Information form.

» Aremote name is the Directory entry for a user on another
server connected to your server by a gateway.

Batch administration commands are not case-sensitive, except
for the parameters for the LIST and NEW commands. These
must be typed in lowercase.

Parameters that contain spaces must be enclosed in quotes
(either single or double).

A single command line cannot exceed 500 characters.

You can omit trailing fields. For example, when you are
adding a regular user, you can omit the <dept> to <PGn>
fields. However, the batch administration task recognizes
fields by their relative position. For example, in the ADD
NETWORK command, <class> is followed by <userID>,
which is followed by <first>, and so on. If you want to use an
optional field, like <phonel>, you must include all preceding
optional fields, although you can leave them empty by typing
two double quotation marks ("").

You can use some batch administration commands to produce
text files readable in FirstClass. Depending on session
memory limits, however, you might not be able to read the list
in FirstClass if your system is too large. If the file is too large,
you can save it as a text file and view it using a text editor.

All time is stored in seconds. Each hour has 3,600 seconds,
and each day has 86,400 seconds.
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Creating and customizing user groups

When you install FirstClass, there are five sets of groups already
defined in your post office:

 Standard Groups

» Configuration Groups
 Directory Filtering Groups
* Department Groups

» Conference Groups.

These sets of groups already have groups created to help you get

started in setting up your FirstClass environment. The Groups 1 1
folder may look a little overwhelming at first glance, but is very

easy to work in and customize once you are familiar with the

structure of the Groups folder and how the individual user

groups fit into this structure.

In this chapter, we will discuss the Configuration, Directory
filtering and Department groups. We will also discuss how to
create a unique group structure for your organization based on
the decisions we made in “Thinking about your organization’s
structure” on page 21. We discussed the standard user groups in
Chapter 7, “Understanding groups, organizational units, and
privileges”. Conference groups will be discussed in Chapter 12,
“Adding conferences and conference groups”.

The section of the Groups folder we will be dealing with looks
like this:

FirstClass 7 Administrator's Guide Business Edition 119



AdGrps71.fm

Configuration Groups

User groups
Y. Configuration Groups
@ Sub Admin @) High Disk Usage @) Help Desk @ Webmasters @ Suspended
(@) Pacific Time Zone @ Mountain Time Zane ¢ Certral Time Zone &) East Coast (@ Woice Uzers

{ Directary Filtering Groups
) wieh Mames @) ek Calendars @ Wik Conferences

‘7. Department Groups
@) Employee

@ Client Services @ Finance @ T @ Human Resources @) Marketing

@) Office Services @) Sales @) Managemert @ Consuttart @) Customer

[@I Employes Send @ Employee Read

@ Client Services CG @ Finance CG @ ITCG @I Human Resources TG @ Marketing CG @ Internet News CG
@ Office Services CG @ Sales CG @ Management CG @ Conzultant CG @ Customers CG @ Private Calendar

Configuration Groups

Configuration groups are simply groups that define the use some
users make of your FirstClass system, but it does not define their
roles within the organization. The pre-configured groups in this
area are:

* Sub Admin

» High Disk Usage
» Help Desk

* Webmasters

» Suspended

* Time zone groups

Membership in these groups is not based on organizational
identification. Group members may have additional
configurations based on membership in one of these groups, but
these privileges do not define the users’ overall place in the
organization. For example, you may have five members in your
IT department (organizational), but only two of these users are
also subadministrators (additional configuration). The
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organizational classification of these five users is IT, and the
extra duties of two of these users include subadministrator
duties, which require additional configurations. Therefore, they
are added to the Sub Admin configuration group.

You can delete or rename any group in this area, however, we
suggest you do not delete the Sub Admin or Webmasters groups
since they have been configured to contain all the tools and
security required to perform these roles. If you do not use a
subadministrator to help with FirstClass administration, or you
do not use FirstClass Internet Services to connect to the Internet,
leave these groups intact but do not add users to them.

Directory Filtering Groups

You can delete or change the names of any group in this area,
but we suggest you don’t. These groups have been created to
help you build a secure environment, protected from outside
users trying to access your Directory from the Internet.

11

Department Groups

Department groups are used to organize people on your system
into their functional areas. You may want to designate an OU
level for these groups (see “Organizational units” on page 76 for
information).

You can delete or rename any group in this area. You can have
up to 300 groups (unlimited for MP sites) in the Groups folder.

Adding and customizing user groups

As stated earlier, you can choose to delete the existing
Department group structure, and create a department group
structure that more closely fits your organization.

To illustrate how to plan and create a group structure, we’re
going to customize some department groups to align the group
structure more closely with our Husky Planes corporate
structure.
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Adding user groups

Adding group privileges

IT group privileges

Some of the groups Husky Planes is divided into are employees,
managers (who are also employees), and customers. We also
need one more group, IT, for our technical support group.

To create new groups to reflect your organization’s structure, do
the following:

1. Open the Groups folder on the administrator’s Desktop.
2. Choose Admin > Add > User group.

Warning All new groups must be created and reside in the
Groups folder on the administrator’s Desktop. If you
create the group anywhere else, it will not function

properly.

Now we have to think about what we want users in these various
groups to do and how those functions are reflected in FirstClass
features.

IT is the easiest group to deal with, so we’ll start there. Since our
IT department is responsible for maintaining our server and
administering the system, we want them to have access to
almost everything.

First, because the IT group is an organizational division in Husky
Planes, we will give this group an organizational unit
designation of Department. We will also select Allow unique
names within this organizational unit. This will make it easier if
we have another employee with the same name in another
department (another organizational unit).

On the Features tab for the All Users group we enabled all the
features in the Email and Access sections. For the IT group, we
will enable all the privileges in the Other privileges and
Advanced sections so IT members have access to almost all
features.

However, we will not enable the Special status features

(Subadministrator and Does not expire). Since we already have a
user group configured for subadministrators (Sub Admin), we
will add subadministrators to the Sub Admin group instead of
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giving that feature to all IT staff. See “Creating subadministrator
accounts” on page 12.

IT - Features

IT : Husky Planes.com

File Edit Format Message Collaborate View Admin  Help

@ Group name: T
Comments: Department group

Organizational unit:  |Level 6 Department % | Require unigue names within this organizational unit

% | Model Desktop

Lay out users' Deddops

Features |User Prefs | User Limits Direc‘tory]Secur'rty]Services

Uze this tab to define privileges for this group.

Conferencing

Unzend

W Calendaring
W iew résumeés

Etmil Other privileges Special status
Private mail w Chat Subadministrator

Does not expire

Legend

«  overrides the previous
setting to turn on this

HEEESS privilege

Make urgent w Publish home page ]
g = FirstClass access q f
overrides the previous

setting to turn off this

Mark az unread
Advanced Internet access

Set expiry

. Create conferences Command line access privilege
Receipt notificstion ) f
it  Wiew unlisted wark offline InsweE na SES & il
Search i privilege unchanged
« Wiew user information Voice actcess
Uplozd . ) .
« Edit user information
Daovvnload

Address book

11

Cancel
oK

We do not have to alter anything on the User Prefs tab.

We should set user limits high (unlimited where available). We
don’t want our IT staff being automatically logged off or running
out of disk space.
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T - User Limits

gpartment group
File Edit

@ Group name: |IT

COrganizational unit:  |Department ol Require unique names within this organizationsl unit
Festures | User Prefs  User Limits ]Directory ] Sec:ur'rty] Services]
Use this tab to define time and disk space limits for this group. ﬁf-‘é Model Desktop
- . . Lay out users’ Deskdops
Private mail expiry: a0 #| 7| days v e
Diaily connection limit: Unlimited 4| *| minutes
Legend
Sesszion inactivity imt: 120 #| 7| minutes W overides the previous
setting to turn on this
Disk space limit: Unlimited | *| kilobytes privilege

Format Message Collaborate  View Admin Help

Comments: | Department group

wvernides the previous
setting to turn off thiz
privilage

leaves the status of this
privilege unchanged

Cancel
oK

Customers group
privileges

Since IT staff are Regular users and they should be able to see
everything on the system, we won’t set up any Directory filtering
for these groups.

We don’t need to change anything on the Security or Services
tabs since we set these system-wide values on the All Users
Group Privileges form.

We want customers to sign on to our system and participate in
various conferences set up for their use. These conferences will
allow them to talk to Husky Planes about its products. But we
don’t want customers writing directly to employees, since most
employees aren’t in a position to answer customer questions or
to make statements about company policy.

The customer group is an organizational division in Husky
Planes, so we will give this group an organizational unit
designation of Department. We will also select Allow unique
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names within this organizational unit. This will make it easier if
we have an employee with the same name as one of our
customers.

Since we only want customers to use the conferences we will set
up for them, in the Email section of the Features tab, we’ll turn
off all features except Conferencing, Search, Upload and
Download. This will allow customers to search these
conferences for information and upload or download
attachments. We will leave the other sections of the Features tab
unchanged from the values we set for the All Users group.

If you want to give users the ability to send internal email to
other users, but do not want them to send or receive Internet
mail do the following:

1. Select the Private Mail feature for the user group on the
Features tab of the Group Privileges form.

2. Open the Internet Gateway form.
3. Click Permissions. 1 1

4. Enter the user group name at Who, and choose Disallowed
at Access.
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Customer - Features

Customer, :

Husky Planes.com

File Edit

Commerts:

Format Message Collaborate

@ Group name:

Organizationsl unit:

Features |User Prefs | User Limits Diredory]Secur'rty]Services

Uze this tab to define privileges for this group.

View  Admin  Help
Customer

Department group

Level 6 Department bt

Require unicue names within this organizstional unit

fia | Model Desktop
Lay out users' Deditops

Email Cther privileges Special status
Private mail Chiat Subadminiztrator Legend

.~ Conferencing Calend?rlng ) Does not expire Ry
Unzend Wiew résumes Jy— setting to turn on this
Make urgent Publish home page pil=ce

Mark as unresd

» FirstClass access

overrides the previous

Advanced  Internet access setting to turn off this
Set expir e
i Create conferences » Command line access privilege
Receipt notification i
" Wigw unlisted o iark offine leaves the status of this
« Search privilege unchanged
Wi user information Y0ICE ACCESS
» Uplozd y . .
Edit uzer information
» Download

Address hook

Cancel
oK

Since we have fewer session licenses than customers (customers
are Remote users), we want to limit the time any one customer
is logged on so everyone gets a chance. On the User Limits tab,
we’ll set the Daily connection limit to 30 minutes. We'll set the
Session inactivity limit to 5 minutes so if a customer mistakenly
walks away from the computer leaving the connection active,
she will be automatically logged off and won’t use up the entire
daily connection limit. Since customers don’t have private mail,
we’ll leave Private mail expiry unchanged. Finally, we’ll put the
Disk space limit at 10 mb, allowing customers to upload
significantly large files if necessary.
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Customer - User Limits

epartment group

File Edit Format Message Collaborate Wiew Admin  Help

@ Group name: |Customer
Comments: |Department group

Organizational unit: | Department i Require unigue names within this organizational unit

Features | User Prefs  User Limits ]Direc‘tory] Security ] Services

Use this tab to define time and diskspace limits for this group. ﬁf-‘é Model Desktop
L. t 1= Desht
Private mail expiry: Defaut  #[~| days = O RS
; I - .
Daily connection limit: 2| minutes Legand
Session inactivity limit: |5 2| minutes « overrides the previous
setting to turn on this
Dizk space limit: 10000k #[w| kilokbytes privilage

overides the previous
setting to turn off this
privilege

leaves the status of this
privilege unchanged

Cancel
ok | 11

While we want customers to have easy access to information
about Husky Planes and its services, we don’t want them to have
access to personnel information or details about other
customers.

On the Directory tab, we’ll set Maximum number of multimatch
names to 0. This will make it impossible for customers to guess
the names of employees or other customers and search for them
through the Directory. For the moment, we’ll leave Allow this
group to view these groups blank, but we will be coming back to
it once we've created a conference group. We'll create a group
that will contain all customer conferences, then enter that group
name in this field. That will limit our customers’ view of the
Directory to only those conferences. Leave Do not allow this
group to view these groups blank.
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Customer - Directory

Customer, : Husky Planes.com

File Edit Format Message Collaborate

© Group name: |Customer|

Comments: Department group

Organizationsl unit:  |Level B Department

Allovy this group to view these groups:

(&) Customers CG

Mazimum number of muttimatch names:

Mane bl K

View  Admin  Help

-

Features | User Prefs | User Limits DifECTUVYlSecur'rty]Services

Use this tab to define the names that this group's Directory can list.

The Directory is unrestricted if this field
iz blank or contains the All Uszers, All
Conferences and All Calendars groups.

Mote: This may be overridden by
restrictions placed at a higher level.

L Require unicue names within this organizstional unit

fia | Model Desktop
Lay out users' Deditops

Legend

" overrides the previous
setting to turn on this
privilege

overrides the previous
setting to turn off thiz
privilege

leaves the status of this
privilege unchanged

Cancel
oK

We don’t need to change anything on the Security or Services

tabs.

Employees group
privileges

Employees need to communicate with each other and share
information within departments and projects. We won’t

designate this group as an organizational unit since it covers
everyone in the company.

Employees need more access privileges than customers, but
fewer than users in the IT group. In the Email, Special status,
and Access sections of the Features tab, we will leave everything
unchanged since we set these privileges at the All Users level.

Then we'll turn on the following features:

 Other privileges: Calendaring, View Resumes, Publish home

page

* Advanced: Create conferences, View user information.
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Employees - Features

Employee : Husky Planes.com

File Edit Format Message Collaborate Wiew Admin  Help

@ Group name:  Emplovee

Comments: Department group

Crganizational unit: — |Level 4 Company hal Reguire unigue names within this organizational unit

Features |User Prefs | User Limits Diredory]Secur'rty]Services

Uze this tab to define privileges for this group.

Email

Cther privileges

Private mail
Conferencing
Unzend

Make urgent
Mark a3 unresd
Set expiry
Receipt notification
Search

Uplozd
Dowenlozdd
Address hook

Chat
W« Calendaring
W Wiew résumes
W Publish home page

Advanced

« Create conferences
Wiew unlisted

» Wiew uzer information
Edit uzer information

Special status
Subadminiztrator

Does not expire

ACCEES
FirstClazs access
Irternet access
Command line access
waork offline
Y0ICE ACCESS

fia | Model Desktop
Lay out users' Deditops

Legend

" overrides the previous
setting to turn on this
privilege

overrides the previous
setting to turn off thiz
privilege

leaves the status of this
privilege unchanged

Cancel
oK

On the User Limits tab, we won’t change anything. Instead, we’ll
use the defaults we set on the System Profile and the All Users
Group Privileges form.

We only want employees to see conferences applicable to them,
but they should be able to see all the users on the system. So on
the Directory tab, we’ll add All Users user group and the
Employee send and Employee read conference groups to Allow
this group to see these groups. Leave Do not allow this group to view
these groups blank. We’'ll set Maximum number of multimatch
names to Default, so they can easily address mail.
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Employees - Directory

Employee : Husky Planes.com

File Edit Format Message Collaborate Wiew Admin  Help
@ Group name:  [Employes|
Comments: Department group
Crganizational unit: — |Level 4 Company hal Reguire unigue names within this organizational unit

Features | User Prefs | User Limits DifECTUVYlSecur'rty]Services

Use this tab to define the names that this group's Directony can list. fra | Model Desktop

Lay out users' Deditops
Allovy this group to view these groups:

@3 Al Users The Directory is unrestricted if this fisld Legend
@ Employee Send iz blank or contains the All Uszers, All
=) Employees Read Conferences and All Calendars groups. v overrides the previous
[Sisy
Note: This may be overridden by se_ﬂ'_ng ito (i &m i
privilege

restrictions placed at a higher level.
overrides the previous
setting to turn off thiz
privilege

Mazimum number of muttimatch names: leaves the status of this

Default hd K privilege unchanged
Cancel
ak.
Management group Managers, like employees, need to communicate and to have

privileges access to information. Since managers have sensitive

information, they should have a way of keeping it confidential
while making it available to those who need it.

Like the IT group, Management is an organizational division in
Husky Planes so we will give this group an organizational unit
designation of Department. We will also select Allow unique
names within this organizational unit. This will make it easier if
we have another employee with the same name in another
department (organizational unit).

The Management group will have the same features selected on
the Features tab as the Employees except they will also have
Chat. We'll be using conferences and Model Desktops to add
features to further distinguish the Management and Employee
groups.
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Managers - Features

Management : Husky Planes.com

File Edit Format Message Collaborate Wiew Admin  Help

@ Group name:  |Managemert|

Comments: Department group

Crganizational unit: — |Level 6 Department % | Reguire unigue names within this organizstional unit

Features |User Prefs | User Limits Diredory]Secur'rty]Services

Uze this tab to define privileges for this group.

Email Cther privileges Special status
Private mail ~ Chat Subadminiztrator

Conferencing
Unzend

Make urgent
Mark a3 unresd

Set expiry

W« Calendaring
W Wiew résumes
W Publish home page

Advanced

Does not expire

ACCEES
FirstClazs access

Irternet access

Model Desktop
Lay out users' Deditops

]

Legend

" overrides the previous
setting to turn on this
privilege
overrides the previous
setting to turn off thiz

~ Creste conferences Command line access privilege
Receipt notification .
= Wi unlisted wWark affling leaves the status of this
Search ) privilege unchanged
» Wiew uzer information Y0ICE ACCESS
Upload i ) )
Edit uzer information
Dowenlozdd

Address hook

Cancel
oK

Since management staff should be able to see everything on the
system, we won'’t set up any Directory filtering for this group.

Other approaches

Here are a couple of other ways to set up and configure the users
on your system:

* We could have ignored user groups entirely and modified
each user’s User Information form individually.

Note: This would take more time and any user changes
would have to be made on an individual basis,
instead of on an entire user group at once.

» We could have created user accounts with names like
Technical Questions and allowed customers to write to them.
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This would have meant giving customers Private mail
privilege. But we could have applied filters that only let them
see the accounts we wanted them to mail to. Employees could
then answer these questions, with responses being emailed to
the customers. We then could have created a conference in
which customers had read only permission and to which we
posted summaries of responses to customer questions.

Had we taken this approach, we would have had greater
control over what customers see and over their
communication with one another.

We could have done exactly what we described in the bullet
immediately above but with a conference to which customers
could post but which they could not read, rather than a user
account.

This list is not exhaustive. Your user structure should be tailored
to best suit your organization’s needs.
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Adding conferences and conference
groups

A conference is an online forum for user discussion. You can also
think of it as a shared Mailbox used as a repository for messages
on a particular topic. Conferences have permissions associated
with them to control access by individual users or groups of
users. They have expiry periods to delete old messages
automatically. Conferences can be shared with other FirstClass
servers, and can offer access to Internet newsgroups through
NNTP (for information, see FirstClass Internet Services
Administrator’s Guide).

Conferences are created in the General Conferences folder on 1 2
the administrator’s Desktop. This folder is invisible to every user

except the administrator and subadministrators. As the

administrator, you then make selected conferences within this

folder visible to the appropriate users or groups by granting
subscriptions, adding them to Model Desktops, or placing a link

to a conference in a public place.

If groups of users, or individual users, are given the Create
conferences feature, they can also create personal conferences,
which they can administer.

In this chapter we will:

» look at the structure and contents of the General Conferences
folder

* learn about using conference groups

» create and customize new conferences for the user groups
discussed in Chapter 11, “Creating and customizing user
groups”
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 learn how to control access to conferences through

subscribing users to conferences and by adding conferences to
Model Desktops

* learn how to use conference permissions.

The General conferences folder

When you install FirstClass, there are some conferences already
created in the General conferences folder. These conferences
can be used as they are, customized, or deleted to create a
structure that best fits your organization.

The existing conferences match the Department groups of the

default post office. There is an area (conference) for each
Department group.

General Conferences

4 General Conferences

File Edit Format Message Collaborate View Admin  Help

- o - o
[ Folder 2 Files 14 Folders  Husky Planes.com @ Sdministrstor W F
i

Employee Lounge

Client Services Area Finance Area [T Area HR Area  Marketing Srea Office Services Area Sales Ares

Management Lrea Consultant Area Customers

About the Webmaster &ccourt Wizbmaster  Ahout the Sub Admin Account Sub Admin
<

16 ftems.

Inside each of these conferences is a message archive folder to
move old messages to instead of simply deleting them, and a
group calendar for all users to contribute to. You can add as
many conferences to this folder as you wish, and you can add as
many subconferences within each conference as you require. We
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will explain how to give users access to conferences in
“Controlling access to conferences” on page 138.

Renaming conferences ~ Changing the name of the original icon for a conference deletes
the old name from the Directory, and adds the new name.
Changing the name of an alias does not affect the Directory
entry. However, messages addressed to the conference must be
addressed to the original conference name, not the alias.

Note: If this conference is being replicated over a
gateway, the remote administrators should also
change the name of their copy of the conference.
For more information about conference replication,
see “Setting up conference replication” on
page 173, and our online help.

Using conference groups

Conference groups allow you to assign permissions to several
conferences at once, the same way user groups allow you to 1 2
assign privileges to several users at once. Conference groups,

like user groups, are in the Groups folder on the administrator’s
Desktop. They are indicated by this icon:

&

There is one standard conference group, All Conferences. Like
the All Users user group, you should use it to set the standard
permissions that will apply to most conferences, then use the
conference groups included in the default post office, other
conference groups you create, or individual conferences to
change those permissions for selected groups or individuals.

In Chapter 9, “Understanding Directory filtering”, we discussed
filtering the Directory for groups of users or individual users. We
did this by listing the user groups that a particular user group, or
individual user, should be able to see on the Directory tab of the
Group Privileges form or the User Information form. You can
also use Directory filtering to control access to conferences using
conference groups. To filter the conferences available in a
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Directory listing, simply add the conference group as you would
a user group on the Directory tab. Users will only be able to see
conferences in that group.

In this example, we have added the Customers CG conference
group to the Customer user group’s Directory tab on the Group
Privileges form:

Directory filtering to conference
groups

Customer : Husky Planes.com

File Edit Format Message Collaborate View Admin  Help

@ Group name: |Customer
Comments: Department group
Organizational unit:  |Level 6 Department hal £ Require unique names within this organizational unit
Features | Uzer Prefs | User Limits  Directory lSecur'rty ] Services
Use this tab to define the names that this group's Directony can list. M Mocel Desktop

Lay out users' Deddops
Allowy thiz group to view these groups:

(&) Customers CG The Directory is unrestricted if this field Legend
is blank ar contains the All Users, All
Conferences and All Calendars groups. «  overrides the previous

MHote: Thiz may be overridden by setting to tum on this

restrictions placed at a higher level. privilege
overrides the previous
setting to turn off this
privilege

Maximum number of muttimatch names: leaves the status of this

Morne hd £ privilege unchanged

Cancel
oK

The only thing customers will see when they list the Directory
are conferences belonging to the Customers CG conference
group.

The default post office has nine conference groups. We’re going
to create two custom conference groups: Customer CG, and
Internet News CG. We're creating the last one because we know
some employees will want to read newsgroups and they will
need some slightly different settings. For more information, see
FirstClass Internet Services Administrator’s Guide.

136  Creating your FirstClass environment



AdConf71.fm

Adding conferences and conference groups

To create a new conference group:
1. Choose Admin > Add > Conference group.

2. If the Properties dialog box does not automatically open,
choose Edit > Properties and enter the name of the
conference group.

End the conference group name with CG to make its name
easily identifiable as a conference group.

3. Click OK.

Here’s the set of conference groups Husky Planes ends up with.

Husky Planes conference groups

@ Employee Send @ Employee Read
@ Client Services G @ Finance CG @ ITCG @ Human Resources & @ Marketing CG @ Internet Mews CG
@ Office Services CG @ Sales CG @ Management CG @ Consultant CG @ Customers CG @) Private Calendar

Adding conferences

We will create the following conferences for the following 1 2
groups in the General Conferences folder on the administrator’s
Desktop:

Customers There is currently no customers conference. We
will first create the Customers conference. Then
we will add the following conferences inside it:

¢ Technical Questions
¢ Purchasing Questions
» Feature Requests

Employees The Employee Lounge conference already
contains a Message archive folder, an Employee
Calendar, and a Buy & Sell conference. We want
to add three more conferences:

e Policy
¢ Announcements

¢ General Discussion
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Managers The Management area conference already
contains a Message archive folder and a
Management Calendar. We want to add four
more conferences:

* Personnel
¢ Management Policy
* Business Plan
e Budget
To create a new conference, choose File > New > New

Conference. For more information about creating and naming
conferences, see our online help.

Controlling access to conferences

By default, any user who has a subscription to a conference can
open it, send items to it, read items that have been posted to it,
and view message histories. When you add a conference to a
user group’s Model Desktop, you are subscribing every member
of that group to the conference.

Adding conferences to The default post office already contains Model Desktops for the
Model Desktops preconfigured groups. For information, see Chapter 8,
“Understanding Model Desktops”.

In this section we will add a conference to the Customer group’s
Model Desktop.

1. Double-click the Customer user group and click Model
Desktop.

2. Double-click the General Conferences folder on the
administrator’s Desktop.

3. Select the Customers conference.

4. Select Conferencing >Add to Desktop.

A copy of the conference will appear on the administrator’s
Desktop. Drag it to the Model Desktop and arrange it as

138  Creating your FirstClass environment



AdConf71.fm

Adding conferences and conference groups

appropriate. Remember, there are conferences along the left
side already.

¥ Customer, Model g@@

File Edit Format Message Collaborate View Admin  Help

Customers Model Desktop

&= O £
3 Folder OFiles 1 Folder  Husky Planes ; Administrator v
&b
[

Customers

12

5. Protect the alias on the Model Desktop by choosing File >
Properties and selecting Protected. This will prevent users
from deleting this item from their Desktops.

6. optional
If you want the conference to open automatically the first
time each user logs in, choose File > Properties and select
Auto open.

7. Close the Model Desktop.
8. Wait for modeling to complete.

Warning Do not log off until it has completed, or your
changes will not be applied to all members of the
group. You will see this message:
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1+ Customer

Applying Model to Users

Lo not log off until modeling has completed.

@1‘-'(; Working on user: Completed.

If you are unhappy with the look of the Model Desktop, you can
reopen it and rearrange it at any time. However, remodeling will
only occur when an object has been added or deleted, simple
rearrangement will not force it. Therefore, add and then delete
an object to force remodeling.

To add more conferences to any group’s Model Desktop, repeat
this procedure.

When users are in multiple groups, their Desktops are created by
combining the contents of all applicable Model Desktops. If you
are going to use multiple user groups to control access to
conferences, remember that each Model Desktop dictates the
exact location of icons on the users’ Desktops. Be sure to place
icons so that they do not overlap each other.

When a conference is added to a group’s Model Desktop, by
default, all users in that user group are subscribed to the
conference.

You can also subscribe individual users to conferences or
conference groups by adding the user’s name in the list of
subscribers on the conference permissions form. We will walk
through subscribing individual users to conferences in
Chapter 14, “Adding users”

Conference permissions

You might want to limit the access of specific users or groups to
a conference. For example, you might want all users to be able
to read messages in a certain conference, but you only want a
few users to be able to send to it. To control access to a
conference, you must set up permissions for the conference.
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You can set these permissions for individual conferences or you
can use conference groups to set permissions for a group of
conferences, much the same way you set privileges for groups of
users with user groups.

Permissions are similar to privileges. But while privileges allow
you to control access to a great many FirstClass features,
permissions relate exclusively to conferences. For a complete
explanation of the various permissions and how they interact
with privileges, see our online help.

The important thing to remember about permissions is that
when a user accesses a conference, FirstClass will stop checking
permissions the first time it comes across the user’s name or a
user group he belongs to (from the top down). Therefore, if you
want an individual user to have greater access to a conference
than the rest of the users in a user group he belongs to, enter his
name first in the list. No further checking will be done. The same
applies to two groups with different permissions but with
overlapping membership. An example would be the Employee
and Management groups. Since all managers are also
employees, they belong to both user groups. If you put the
Employees group first, no further checking would be done for
any of the managers.

Now that we have our conference groups, we should use them
to set standard permissions. Let’s start with Internet News CG.

1. Double-click the Internet News CG conference group.
2. Click Group Permissions.

3. Newsgroups can generate a lot of content very quickly. We
don’t want too much disk space taken up by such content.
We'll set Expire old messages when number of items reaches to
500. This will stop heavy usage newsgroups from getting too
cluttered.

4. Since some newsgroups have very little traffic, we’ll set
Default message expiry to 30 days. This will stop us from

having low volume newgroups with messages many months
old.
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In the Who field, we’ll enter the Employee user group. In the
associated Access field, we'll select Reader. This means all
employees (remember this includes all our Department
Groups except Customers) have Reader access to all
conferences that belong to this group. Of course, they still
can’t see the conference, but when they are subscribed to it,
by having it added to their Model Desktops, they will have
this access.

Now we'll enter Internet in the Who field and select
Contributor in the associated Access field. This will
specifically allow the Internet gateway (every system with
Internet Services installed will have a gateway named
Internet) to permit incoming mail.

Finally, we’ll enter All Users in the Who field and select
Disallowed. This ensures customers and all unauthorized
users cannot access this conference.

Note This practice should be followed for all conference
permissions as it ensures no unauthorized users
who have accessed the system can have access to
your conferences and the information in them.

Warning If a user adds a link to a conference on his home
page, it is then accessible by anyone who accesses
the home page. Disallowing All Users ensures that
only authorized users can follow the link and open
the conference.
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Internet News CG conference group

Internet News CG

File Edit Format Message Collaborate View Admin Help

Approval Size limit
Meszages require approval Limt messages above: Mo Limit )
Attachments require approval Handling: Reject Cuietly ll

E:xpiry

Expire old messages when number of tems reaches: 500 -

Message expiry (Default, Mever, or number of day) 30 i

Options

Form to use: - = Use List layout from server

Reply preference: R

Who Access Permissions

@) Employee Reader hd G P e Sl B
E Internet Cortrioutor ¥ 5 0 P e o 10 B
@ All Users Disallowed ¥

Now we’ll set some permissions for the Customer CG conference
group.

1. We select Attachments require approval since a customer 1 2
might inadvertantly upload a damaging file — one with a
virus, for example. This way, no customer can download the
attachment until an employee with approval permission
examines and approves the attachment.

2. We set Reply Preference to Automatic. This will direct all
replies to the conference alone. This is the way we want
customers to communicate with us.

3. We add the Customer and Employees groups and give them
both Contributor access. This will allow them to read and
post messages in the conferences that are part of this group.

4. Next, as described in the previous example, we’ll enter All
Users and choose Disallowed to protect the information in
this conference.
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Customer CG conference group

Approval
Meszages require approval

Attachments require approval

E:xpiry

Options
Form to use:

Reply preference:

File Edit Format Message Collaborate View Admin Help

Size limit
Limit mezzages above:

Handling:

Expire old messages when number of tems reaches:

Message expiry (Default, Never, or number of day):

-
&l

-
&

Use List lsyout from server

Mo Limit 4|~

Reject with MDN

El

Who Access Permissions

@) Customer Contr?butor hd @i f_i. pal= Y- gl ;:_ :Ea
@) Employee Contributor - ¥ i 55 L Eres NEa B
@ All Users Disallowed ¥

Setting individual
conference permissions

Now that we have set up our conference groups, we can start
adding conferences to them. We do this by entering the name of

the conference group on the specific conference’s permission
form. This is similar to the way we add users to user groups, by
entering the name of the user group on their User Information

forms.

1. Select the Technical Questions conference.

2. Select Conferencing > Permissions.

This form looks just like the Conference group permissions
form with two differences: the fields Conferenceis amember
of these groups and List of subscribers.

3. For Conference is amember of these groups, enter Customer
CG. Now this conference will inherit the settings of the
Customer CG conference group. We don’t have to set any
extra permissions here.

Note You can also make a conference belong to an

organizational unit by adding the organizational
unit name in this field.
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4. We'll leave List of subscribersblank for the time being since
we haven’t created any users yet.

We'll repeat this process for each of the conferences we created,
adding them to the appropriate group.

For a full description of all conference permissions settings and
options, see our online help.

By default, all conferences are added automatically to the
FirstClass Directory. Remember, just because the conference is
listed in the Directory, not all users can see it or address mail to
it. A user can only see a conference if he is subscribed to it, or a
link to the conference is placed on his Model Desktop or in a
public area (within another conference he has access to).
Directory filtering is also used to determine what a user or group
of users sees in the Directory. A user can only contribute to a
conference if he has permission to do so, based on the
conference permissions form.

Still, you may have conferences you do not want listed in the
FirstClass Directory at all. You can make the conference unlisted
by doing the following:

1. Open the conference permissions form.
2. C(lick Directory info.
3. Select Unlisted.

4. Click OK.

Other approaches

Here are a couple of other ways to create and configure
conferences:

» We could have not created any Model Desktops and used
permissions, privileges, and subscriptions to control access to
conferences. However, Model Desktops is an important
feature of FirstClass that makes organizing your system and
users much easier.
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* We could have subscribed individual users to conferences,
and controlled conference permissions for individual users
instead of groups. This would result in a system that is very
disorganized and difficult to administer.

» We could have used personal conferences, created by users
rather than the administrator, for confidential material. This
would add some security, but it would place a burden upon
the users to create and administer the conferences.

This list is not exhaustive. Your conference structure should be
tailored to best suit your organization’s needs.
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Using group and resource calendars

So far, we have created user groups and organizational units to
organize our FirstClass system, we have used Directory filtering
and Model Desktops to manage what users will see and how they
use our system, and we have created conferences to help our
users communicate within our organization. One resource we
haven't discussed using at the group level is calendars.

In this chapter, we will learn about the All Calendars group and
discuss how using group and resource calendars can enhance
your FirstClass collaborative environment.

Group and resource calendars essentially work like conferences,

in that one calendar can be used by groups of users to help users 1 3
communicate. In the case of calendars, users will be

communicating about scheduling meetings, booking meeting

locations, and booking resources for a group of users, instead of
engaging in online discussion.

Using the All Calendars group

Like the All Users and All Conferences groups, the All Calendars
group is a standard user group that resides in the Groups folder
on the administrator’s Desktop. All choices that you make for
this group become the defaults for all calendars created on your
system. This includes all personal calendars on users’ Desktops,
all group calendars and all resource calendars. You may wish to
create separate calendar groups to deal specifically with each
type of calendar, making your system easier to administer.
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FirstClass calendars work much like conferences. Just as you can
create a new conference, you can also create a new calendar for
a specific purpose. Group calendars enable you to organize and
schedule tasks and appointments for various projects and
activities. The difference between a personal calendar and a
group calendar is that a personal calendar is directly associated
with a user, and each user can have only one. A group calendar
has a unique name and enables a set of people to coordinate
their schedules and tasks.

Users on your system can use group calendars in tandem with
group conferences for collaboration purposes. As with
conferences, you can create group calendars and either set
calendar permissions specific to that calendar, or add the
calendar to an existing calendar group.

To create a group calendar:
1. Open the Conferences folder on the administrator’s Desktop.

2. Open the conference where you want to add a group
calendar.

3. Choose File > New > New Group Calendar.

4. Choose File > Properties to name the group calendar and
protect it.

5. Modify the permissions as required.

Once the group calendar is created and in place, users should be
made aware of its purpose and encouraged to use it accordingly
to improve collaboration and communication.

Using resource calendars

Aresource calendar is a public calendar that represents a specific
resource, such as a projector, or a meeting room. A resource
calendar is updated when users book the resource as part of
creating a calendar event.
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To create a resource calendar:
1. Open the Conferences folder on the administrator’s Desktop.

2. Open the conference where you want to add a resource
calendar.

3. Choose File > New > New Resource Calendar.

4. Choose File > Properties to name the group calendar and
protect it.

5. Modify the permissions as required.

When employees or managers set up meetings or presentations,

they can book a room and equipment at the same time on the
Scheduling tab, in the same way as they invite other

participants. However, instead of entering the name on the

Participants subtab, enter the resource calendar name on the

Resources subtab. The conflict resolution feature works with

Resource calendars as well as all other calendars, so users can be

sure the resources they are booking are available for the 1 3
duration of the meeting time.

Setting calendar permissions

As with conferences, you can create group calendars and either
set calendar permissions from scratch or add your calendar to an
existing calendar group.

Calendar permissions work much the same way as conference
permissions. You can control which groups or individuals can
view the calendar and to what detail, who can add tasks and
events, and who can modify tasks and events. When setting
permissions, you should consider the following:

» what groups or individuals will have access to the calendar?

» will the calendar be in a conference, or added to users’
Desktops?

» what types of access do you want groups to have (read-only,
modify, create, etc.)?
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Once you have determined how users will use a calendar, use
the Calendar Permissions form to set permissions. For a list of
the available permissions, see our online help.

Group collaboration using group and resource

calendars

Calendars are very helpful for employees working cooperatively
on group projects. Group work can be difficult to organize when
there are no, or few, face-to-face meetings. Group calendars can
go a long way in providing a strong project management tool.
Employees can use group calendars to book meetings and work
sessions, locations, and required resources. Both tasks and timed
events are posted and available to all employees with rights to
view these calendars. Furthermore, scheduling conflicts can be
resolved immediately at the time of booking.

Employees can easily fall behind in daily and weekly tasks. Due
to a lack of experience in managing their time, employees may
not plan their workload effectively. Group calendars provide
employees with the ability to view important dates and access
department calendars.

For example, at the beginning of a project the project leader can
input all due dates, meetings, and project timelines in a group
calendar. By placing this information in a public calendar in a
conference where all employees involved in the project can see
it allows them to manage their workloads effectively. As well,
proper scheduling can eliminate unnecessary surprises. Changes
can be updated immediately without employees having to wait
for the next meeting. Also, if employees have a conflict with
some of the dates, you can find a solution well ahead of
schedule.
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Now that we have our system structure defined and built, using
Directory filtering, Model Desktops, groups, conferences, and
calendars, we are ready to start adding users. If you have many
users to add to your system, we suggest you use batch
administration. For an overview of batch administration, see
Chapter 10, “Using batch administration”, and for detailed batch
administration commands and syntax, see our online help.

The number of users you can register on your system is limited

by the number of accounts, or FirstClass Desktops, for which

your system is licensed. You can increase this number by

purchasing more licenses from your Centrinity sales

representative or reseller. For more information about classes of 1 4
users and types of sessions, see Chapter 3, “FirstClass server

concepts”.

In this chapter, we're going to add one user to each of our user
groups. Their names are Joe Customer, Joe IT, Joe Manager, and
Joe Employee.

Adding a user to the customer group
1. Choose Admin > Add New User.
2. Enter the appropriate personal information.
We've given Joe Customer a user ID of Jcustomer.
Initials, Address, Tel, and Fax fields are optional.
3. Select the class of user.

Our customers use session licenses, so they are Remote
users.
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Joe Customer’s user information

For information about classes of users, see “Understanding
how users connect” on page 17.

Do not enter anything at Voice DN and Voice password.

Since we have not installed FirstClass Voice Services to

enable FirstClass Unified Communications, these fields will
be left blank. If you are a FirstClass Unified Communications
customer, see FirstClass Voice Services Administrator’s Guide.

On the User Groups tab, enter Customers.

This is the only group Joe Customer will be a member of,
besides the standard user groups. For information about
standard user groups, see “Standard user groups and how
they work” on page 73.

Click Ok.

Uzer IO
First name:
Last name:

il sliases:

Created:
Last logged in:

Address:

Titme Zone:

Comments:

woice Di:

File Edit Format Message Collaborate View Admin Help

User Infarmation

icust Pazsword: ***

- » Setup POP3 imported
ioe Initizls: .

custamer Class: Remate Liser |

20572002 10:37:17 Ak
32502002 4:10:34 P

User Groups | FesturesAser Prefs | User Limits/Directory

G | Mail import
Preferences

Edit users preferences

Where: -0- [-D-]

Client ID: 1621

Default

Our first customer.

Tel:

Fax:

“oice password:

@ Résumé

Edit uzers résumé

ﬂ Desktop

Open users Desktop

Cancel
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Joe Customer is now a user on our system. He is a member of the
All Users, Customers, and Remote Users user groups. When he
logs in, he’ll see this:

74 Desktop g@f@

File Edit Format Message Collaborate View Help

Joe Customer’s Desktop

=5 £ a a g e
TH Desktop OFiles 7 Folders Husky Planes.com : Joe Customer W &

Y | &

MailBio:: Customers
T
Addr.ess Book

Calendar

Home Page Folder 1 4

\&-_.
Bookmarks

&

Help

7 fems.

When he chooses Conferencing > Directory, he’ll see this:

Joe Customer’s Directory view

B Directo ry

File Edit Format Message Collaborate ‘Wiew Help

3 Pattern:
Showy:
» Local » Remote W Conferences
Rézumé Home Page
|name [Orgarization
@5 Customers

% Festure Requests
@ Purchasing Questions
@ Technical Questions
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Without having to modify Joe’s account at all, we’ve given him
precisely the features we wanted him to have, just by adding him

to the Customers user group.

Adding users with multiple user groups

Following the procedure described above, we’ll add an account

for Joe Manager. It’s just like the Joe Customer account except
Joe Manager is a Regular user, not a Remote user.

On the User Groups tab, there will be a significant difference
from Joe Customer’s User Information form. Since user groups
override the privileges set by groups above them in the list, we
have to order the user groups properly. Since Managers have
more Privileges than Employees, we place them lower on the

list.

Joe Manager User Groups

File Edit Format Message Collaborate Wiew Admin  Help

User Information  User Groups |Featuresilser F‘refs] Uszer Limits/Directory

@ User groups:

L = The list of groups to
@ Regular Users which this user

@ Employee belongs

@ Management

Membership in the
group provides the
features and options
of the group, and
applies the group's
todel Desitop to this
users Desdop

& | Mail import

Setup POP3 imported
mailboxes

Preferences

Edit usars prefarences

@ Rézumé

Edit user's résumé

@ Desktop

Open users Desktop

Cancel

When Joe Manager logs in, he sees this:
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%W Desktop g@@
File Edit Format Message Collaborate Wiew Help
g » daf & &Limi: o @&
T8 Desktop OFiles 8Folders Husky Planes.com : Joe Manager o

4‘30
' B
30

hiailBox:
Employee Lounge

&

Addr.ess Book

Calencar

IManagement Area

Home Page Folder
g
Bookmarks

&

Help

& tems.

Note that Joe Manager has both the Employees and Managers
conferences. Since he belongs to both groups, he gets a
combination of both Model Desktops.

Desktop modeling can become fairly complex as you add more
user groups and more Model Desktops. By combining different
user groups with different Model Desktops you can create a wide
variety of Desktops meeting the needs of many different kinds of
users.

Following the steps and principles used to create Joe Customer’s
and Joe Manager’s accounts, add accounts for Joe IT and Joe
Employee.

In “Subadministrators” on page 11, we said we were
deliberately keeping some administration tools away from the
subadministrators for security reasons. We’re going to make one
change to Joe Manager’s User Information form:
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1. Log into the main administrator account, not a
subadministrator account.

2. Open Joe Manager’s User Information form.
3. On the Features tab, select Secure and click Ok.

Now, subadministrators cannot easily look at Joe Manager’s
Desktop or Mailbox. If you removed the General Conferences
folder from the Sub Admin folder, subadministrators cannot
easily see the conferences managers are using. If you removed
the Groups folder from the Sub Admin folder, subadministrator’s
cannot easily see the Model Desktop for managers and
conferences on it. Subadministrators do not have the authority
to change the setting of the Secure field.

Warning We said “cannot easily”. Since nothing can be truly
hidden from an administrator (even a
subadministrator), there are ways for them to see
the conferences on the managers’ Desktops, but this
will at least make it more difficult.

No other users will be able to see or access these conferences
unless they are members of the Managers user group and have
been expressly given permission.

You may want some user accounts to be hidden in the Directory.
This way, other users cannot see the user to address mail to him,
and he will not appear in Who’s online. This could be useful for
administrators or subadministrators who want to work on the
system without distractions. To make a user unlisted, turn on the
Unlisted feature on the Features tab of the User Information
form.

Subscribing users to conferences

So far, we’ve used Model Desktops to make conferences
available to our users. However, if you open one of your user’s
Desktops and look at the permissions for one of the conferences
you have placed there, you’ll see he is listed as a subscriber.
Subscribing merely means placing a conference on a user’s
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Desktop. By default, all users with a particular conference on
their Model Desktop will be listed as a subscriber of that
conference.

To satisfy individual user needs, we can also subscribe individual
users to conferences. When you subscribe a user to a conference,
you are merely placing a link to that conference on the user’s
Desktop. You must also remember to give the user permissions
to use the conference in a way that is consistent with his role.

For example, Michelle Weeks is the webmaster for Husky Planes.
Although she is not a member of the Customers user group, she
will monitor the Purchasing questions conference to keep the

web site FAQs up to date. We will add the Purchasing questions
conference to her Desktop by subscribing her to the conference:

1. Log in as administrator.

2. Open General Conferences and Customer area.
3. Select Purchasing Questions.

4. Choose Collaborate > Permissions. 1 4
5. In the List of subscribers field, enter Michelle Weeks.

6. At Who, enter Michelle Weeks and select Reader at access.

7. Click OK.

8. Log in as Michelle Weeks.
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%W Desktop
File Edit Format Message Collaborate Wiew Help

@l 0 ddk L g @G

T8 Desktop OFies 9Falders Husky Planes.com : Michells Weeks " Wi

&l &b
<y &5
Employee Lounge Purchasing GQuestions

Addr.ess Book

Calencar
Wizh Master

Home Page Folder
%.
Bookmarks

&

Help

1 kem selected.

9. The Purchasing Questions conference has appeared on her
Desktop. She can open it and read messages, but cannot
send messages to this conference.
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Public mail lists and chats

There are two methods of communication that we have not
addressed: mail lists and chats. These communications tools
include both public and private versions. This chapter discusses
public mail lists and public chats. For information about the
private versions, see our online help.

Public mail lists

We said managers wanted a way to send direct communications

to all of Husky Planes. A mail list lets you broadcast messages

directly into people’s Mailboxes where they are likely to notice

them immediately. This way, you are sure users will get the 1 5
message.

For most regular communication and all two-way
communication, conferences are a better solution since they
decrease the number of messages in users’ Mailboxes and they
require less maintenance. When you add users to your system,
you have to remember to add them to the appropriate public
mail lists. If you use conferences and Model Desktops, they will
be added automatically. If a conference will meet your
communication needs, use it instead.

A mail list is an excellent solution for groups of users who do not
have mail addresses on the local server and may only log in from
time to time to view specific conferences. The mail list for these
users would be made up of mainly Internet email addresses.

For Husky Planes, a mail list is a good solution for our resellers,
since few of them have addresses on our local server and our

mail list will consist mostly of Internet addresses. If we want to
send all our resellers an important message and we want to be
sure they receive it quickly, we will send the message to the mail
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Public mail list

Controlling access to
mail lists

Using Directory filters and
privileges to control access

AdOther71.fm

list. If we have regular product updates, we can post this
information to the resellers conference instead.

For the steps involved in adding a public mail list, see our online
help.

Husky Planes’ Resellersmail list looks like this:

T New Mail List

File Edit Format Message Collaborate View Admin

Help
i# Global Mail List Cancel
Mame: Alumni

ok

B studerti@domain.com
H graduste@domain.com
H prevuseri@domain.com
H gradsi@domain.com

When you add a mail list, FirstClass adds its name to the
Directory. To prevent the names of private or sensitive mail lists
from appearing in the Directory, the administrator can use
Directory filtering and group privileges to control who sees
them, or make them unlisted or local only.

If you have been following the system setup in this book and you
add a public mail list called Resellers available only to managers
and the administrator, only managers will be able to see this
mail list in the Directory and address mail to it.

To add the mail list to a group:

1. Choose Admin > List Directory.
Select Other only at Show.

3. Click Search.

Double-click the mail list you want to change.
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Mail list Directory information

U Resellers g'i'@

9. Mail List Directory Information
Class: il Lizt w Unlizted

Mame: Resellers « Local only

Alizs:

T Member of:

The conference and user
J hlanagement
@ g groups to which this mail list

belangs

Membership gives groups
access to thiz mail list

Cancel | 1] 9 |

5. Add the School Admin group in the Member of field.

You can enter either conference group or user group names.
This allows you to create lists that are accessible to specific
groups and not to others.

The filtering rules that apply to the group are inherited by the 1 5
mail list. When logged in as Joe Employee, you will not see the
Resellers mail list in the Directory and cannot address a message

to it. When logged in as Joe Manager, you can.

Using groups to control ~ Another solution to keeping a mail list private is to do the
access to mail lists following:

1. Create a user group called Mail lists UG.

2. On the Directory tab, specify the groups who will be allowed
to see the mail list at Allow this group to see these groups.

3. Add the mail list you created to the Mail list UG group.
Making mail lists unlisted 1 you do not want to add your mail list to a group, you can still

or local only protect the privacy of your mail list by making it unlisted, or
local only.

If the mail list is unlisted, only users with the View Unlisted
privilege can see the mail list in the Directory.
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If the public mail list is local only, users on your server can view
the mail list in the Directory, but users connecting to your server
through a gateway cannot.

To make your mail list unlisted or local only, follow these steps:
1. Choose Admin > List Directory.

2. Select Other only at Show.

3. Click Search.

4. Double-click the mail list you want to change.

Unlisted mail list

U Resellers

9. Mail List Directory Information
Class: il Lizt w Unlizted

Mame: Resellers « Local only

Alizs:

L wember of;
The conference and user
groups to which this mail list
belangs

Membership gives groups
access to thiz mail list

Cancel | 1] 9

5. Modify the following fields as needed:

Unlisted Allows only users with the View Unlisted
privilege to send mail to this list. Other users
won’t see this list in the Directory.

Local Only Specifies that this is the local portion of a
distributed mail list, or a local mail list that is not
sent across gateways. On a multiple-server
network, you might prefer not to duplicate entire
lists on each server on the network. Instead, you
can set up a local list on each server. The local
list must contain the list members who are
registered on that server, plus an entry for every
other server having a local portion of the
distributed list.
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6. Click OK.

Public chats

FirstClass supports two types of chats: private chats, initiated by
users, and public chats, set up and maintained by the
administrator.

To add a public chat, choose Admin > Add > Chat file.

Public chats usually pertain to a specific topic. You might want
to add public chats for several topics. To organize the chats,
create a Chats folder inside the General Conferences folder.

To enter a public chat, double-click the associated icon. In
FirstClass, each public chat has an icon that looks like this:

e
&8

A red chat balloon beside the public chat icon indicates that one 1 5
or more people are currently participating in the chat.

In this example, Management discussions is a public chat in the
Management Area conference:
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Public chat

¥ Management Area |_| |E| f'5__<|

File Edit Format Message Collaborate View Help

a = O @ &% Le

485 Conference 1 File 6 Folders  Husky Planes.com : jos manager
SN[ [rams [ Size[E[Subject Last Modified =

Message Archive
s 2-’3
Management Calendsar
fbs
[ &)
Per=onnel
Edd
)
Management Policy

sdd
-

Busine=zz Plan
fbs
[ &)
Budget
&g

Management dizcussions

The red balloon indicates that there are currently people
participating in the chat.

A participant in a public chat can invite any other user to join the
chat, the same way as in a private chat. The invited party does
not need to have access to the conference where the public chat
is located to accept a chat invitation.
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Adding gateways

In Chapter 3, “FirstClass server concepts”, we discussed how
gateways work and how to use gateways to expand your
FirstClass system. In this chapter, we’ll be walking through a
simple gateway connection and looking at the basic tasks you’ll
perform after setting up a gateway. We'll examine some of the
issues involved in planning gateways and routes, and we’ll
discuss automatic and manual multisite mail considerations.

Note Before planning new gateways and routes, you
should know how all the servers in your FirstClass
network interact with each other. We recommend
that you prepare a map of your network. 1 6

Adding the Husky Planes - Avalon Academy gateway

Husky Planes needs to set up a server-to-server gateway with

one of its customers, an education site called Avalon Academy.
Before we begin there is some information we need to gather
and some decisions we have to make.

e We need the server serial number of the Avalon Academy
server. This number is displayed on the Server tab of the
System Profile.

* We need to tell Avalon Academy our server serial number.

* We need to find out Avalon Academy’s site name. This is the
name set on the Server tab of the System Profile.

* We need to tell Avalon Academy our site name.

* We need to tell Avalon Academy the password we are
assigning the gateway.
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» We need to find out the password Avalon Academy has
assigned its gateway.
* We need to decide how we are going to connect.

» Based on our connection decision, we need to get connection
information.

* We need to decide what schedule we want to have for
gateway connections.

* We need to decide how much information in our Directory we
want Avalon Academy to have.

With this information in hand, open the Gateways folder on the
administrator’s Desktop, and choose Admin > Add > Gateway
Settings.

Gateway Settings - Main

€ avalon Academy g
File Edit Format Message ollaborate Wiew Admin Help

hitain lConnedion] Scheduling] Muttizite ] Achsanced ]

Use this tab to set up a connection to a remote server or an external
gateway.

o

s
)

9 |Directory...

Acceass Directany information
Gatewyay name: and setthe incoming
pasamord for this gateway

Avalon Academ-ﬂ The site name specified in the

remote senwer's Systemn Profile
Remote server serial number: @ | Permissions...
9920002 When filled in, a gataway

. . . Limit access to the gateway
account is create d with this

number asthe User D

Uze the Directory button to set ﬂ Connect on Close

the gateway account password Connectto the remote

system after vou close this
form

Cancel

On the Main tab, we enter some basic information about the
gateway:

Gateway name Avaon Academy, this is the site name
Avalon Academy provided us with.
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Remote serverserial The serial number of the Avalon Academy

number FirstClass server.

Gateway Settings - Connection

. fvalon Academy @
File Edit Format Message Collaborate View Admin  Help

Msin Connection | Scheduling | Mutisie | Advanced |

Use this tab to configure the way the gateway will connect to the remote
SEMer.

Cannect via: TCP-P =

Use session: Ay Bvailable $)

1gate The pasanord used to log
inta the remote senver

Pazzwvard:

Metwork |madem /1SDM | Advanced ISDN | CammToalbes |
B 1CPAP, IPX, or AppleTalk connections

Server:

1921681255 The remote server's
name or [P address

Zone/Port:

The remote servers
zone of port

7 | Directory ...

Access Directory information
and set the incoming
paszaword for this gateway

@ | Permissions. ..

Limit access to the gateway

ﬁ Connect on Close

Connect to the remote
system after you close this

Mumber of retries: i} Ckd The number of retries if the farm
connection failz
Retry interval: 5 ﬂ minutes  The time FirstClass will wait

between retries

Cancel

16

On the Connection tab, we choose a connection method and
then provide the necessary configuration information.

Connect via TCP-IP, the preferred connection method.
Password This is the password our gateway will use to
connect to the Avalon Academy server.
Server The IP address of the Avalon Academy server.
Zone/Port If connecting by AppleTalk, enter the zone.
If connecting by TCP, enter the destination port.
Number of 3, if we can’t connect after 3 retries something
retries is wrong and will have to be investigated.
Retryinterval 5 minutes, enough time so any transient

difficulties will vanish.

167

FirstClass 7 Administrator’s Guide Business Edition




AdGate71.fm

Adding the Husky Planes - Avalon Academy gateway

Gateway Settings - Scheduling

B Avalon Academy

File Edit Format Message Collaborate Wiew Admin  Help

Main] Connection  Scheduling ]Munis'rte] Advanced]

Use this tab to specify when the gateway will autom atically connect to the
= remote server. The gateway can connect based on time schedules, a

demand sehedule, or both.

Time & | Time B | Demand |
When to connect
¢ Do not use this schedule
& Connect onthese days
First clay to connect:
Last dav to connect:
& Connect daily

If connecting weekly or daily

Start st 5:00 am
Stop at: |6:00 pm
Repeat: |10

Mondary
Fridary

Lo Lo

=
|
| The number of times to

connect between the start and
stop times

Lﬁ; Wieww Schedule. ..

K

B |Directory...

Access Directony information
and setthe incoming
pasamord for this gateway

@ | Permissions...

Limit access to the gateway

ﬂ Connect on Cloze

Connect to the remote
systam after yvou cloze this
foarm

Cancel

We're only completing one schedule on the Scheduling tab, since
we just have a simple gateway connection.

Connect on these
days

Start at

Academy’s school day.

Stop at

school day.

Repeat

We've chosen this option because Avalon
Academy is only open on weekdays.
8:00 am, the beginning of Avalon

6:00 pm, the end of Avalon Academy’s

10, since 8:00 am to 6:00 pm is 10 hours,

this means we will connect once every
hour. Since mail to and from Avalon
Academy isn’t urgent, this is sufficient.
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T Avalon Aca demy

File Edit Format Message Collaborate Wiew Admin  Help

Main] Connectian ] Scheduling  Muttisite IAdvanced ]
Q‘-(I Use this tab to enable Directorny synchronization in multisite environments.
Inbound ]Outbound]

Gateneayed server information to accept

Uzes all Directory information
from the gatewayed senmar

Uses only local Directony

Adding gateways

3

A | Directory ...

Access Directony information
and set the incoming
pasaword for this gateway

& Local information only

€ Mo informstion

information from the gatewayed
server; ignores remote names at
that site

@ | Permissions. ..

Limit access to the gateway

Does not accept any Directony
synchronization information

Exclude thiz gateway

Routing cost: Standard

91| manusl Sync

==

Hides this gateway from other sites ﬁ e & Slass
Connect to the remote
system after you cloze this
form

2|+ Uszed when caleulating the cost of 2
route

Synchronize the remote senver on
the next connection. Click Connect
on Close to force the connection.

Cancel

The decisions we make on the Multisite - Inbound tab will affect
how multisite mail works. You might want to read “Setting up
multisite mail” on page 176 before you make any further
decisions about your gateways.

Gatewayed server
information to accept

Exclude this gateway

FirstClass 7 Administrator’s Guide Business Edition

We only want to accept Directory
information from the Avalon Academy
site, not other sites gatewayed to it. So we
select Local information only.

This checkbox can be a little confusing. If
selected, it excludes the gateway we are
defining (in this case Avalon Academy)
from Directory synchronization with other
gateways. This way, we can keep this
gateway hidden from others. We've
decided this isn’t important to us.
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Routing cost

Manual sync

Gateway Settings - Multisite

QOutbound
. pvalon Academy

File

Inbound  Suthound ]

-
Restrict to these groups:
@ Emplaoyes

Expoart routes and gateways

Edit Format Message Collaborate

§nI Use thistab to enable Directory synchrenization in multisite enwironments,

For regular gateways, use Standard.

If this gateway is very expensive to use
(for example, an ISDN connection), or one
that you do not wish to use, enter a high
value for the Routing cost (>1000).

If this is a preferred gateway you wish to
use for all routing, enter a low value (1).

If you want the changes to this gateway to
be applied immediately, click Manual sync
then click Connect on close. The changes
will be applied when you close the form
and the gateway connects. If there is no
urgency, the changes will be applied on
the next scheduled connection.

X

View Admin  Help

Main] Connedion] Scheduling  Multisite ]Advanced]

9 |Directory...

Acceass Directany information
and setthe incoming
pasamord for this gateway

@ | Permissions...

Limit access to the gateway

All usernames are
exported if this fizld is
blank or contains the All
Users and All
Conferences groups

Exclude this gateway

Routing cost:

91| manual Sync

Standard

Hides this gateway from other sites ﬂ Connect on Close
Connect to the remote
system after vou close this
form

Used when calculating the cost of a
route

-

ik

Synchronize the remote sepver on
the next connection. Clide Connect
on Clese to force the connection.

Cancel
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On the Multisite - Outbound tab, we define what Directory
information we want to send to Avalon Academy when we
perform Directory synchronization.

Export Directory Yes, we want Directory synchronization with

names Avalon Academy. This means users at our site
will show up in their Directory. It will make
addressing email easier.

Restricttothese Avalon Academy only needs to deal with our

groups employees, so we are restricting the Directory
information we send them to members of that
User Group.

Exportroutes  Select this only if you want the remote site to
and gateways  have access to all our route and gateway names
in their Directory.

Again, the decisions we make on this tab will affect how
multisite mail works. You might want to read “Setting up
multisite mail” on page 176 before you make any further
decisions about your gateways.

16

Gateway Settings - Advanced

File Edit Format Message Collaborate Wiew Admin  Help

Main] Connection ] Scheduling ] Muttisite  Advanesd ]

m Use this tab to specify advanced gateway options. Be sure you understand
" the effects of these options before changing them.

Conference tems A | Directory ...

The items=to exportwhen a conference is subscribed to the gateway.
Access Directony information
and set the incoming
pasaword for this gateway

{~ Export new tems only Exports only items that are new since
the conference was subscribed

Exports all items in the conference
the first time it is replicated on the
remote sener @ Permizsions...

Remote names Limit aceass to the gateway

How to handle names to accommaod ate those third-party mail systems which
cannot manage extended names.

Remove site name from outgoing names & | Connect on Close
Removes the site name portion of a Connect to the remote
remote To/CofBec name system after you cloze this

B a R p form
Usze remate names to validate incoming meil

td akes FirstClazs check both local and
remote namesto determine the

recipients identity Cancel

Mazimum inbound message body size: Mo limit ]+
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Setting the password

Testing the gateway

Forcing a manual
connection

On the Advanced tab, we will set some options about
synchronization.

Since this is a simple gateway between two FirstClass servers
with no third-party software involved, we select Export existing
items. We want Avalon Academy to receive all the data in the
conferences we will subscribe them to.

Save the Gateway Settings form. You can set the name of the
gateway by using File > Properties (Windows) or File > Get Info
(Mac 0S).

Click Directory on the Gateway form. Enter the gateway
password in the appropriate field. This is the password the
Avalon Academy gateway will use to connect to our server.

The simplest way to check your gateway setup is to log into the
gateway account on both the local and remote servers.

To log into the remote server, use the serial number of your local
server as the user ID. To log into the local server, use the serial
number of the remote server as the user ID. In both cases, use
the gateway password as the login password.

Once you are logged in, you can perform the following tasks:

» prevent one or more messages in the gateway mailbox from
being transferred

To do so, remove the Unread flag by clicking the flag while
pressing Option (Mac OS) or Ctrl (Windows).

« force a message to be re-sent

To do so, click to the right of the Mail icon while pressing
Option (Mac OS) or Ctrl (Windows). The Unread flag will
appear beside the item.

« verify that the correct conferences are being replicated.

For more information, see “Setting up conference replication”
on page 173.

You might want to force a manual gateway connection
immediately after configuring the gateway, or during
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troubleshooting, to force conference replication. To force a
manual connection, see our online help.

Setting up conference replication

In addition to allowing you to exchange private mail between
servers, gateways also allow you to replicate conferences. This
means that a complete copy of a conference with all its contents
can be seen and used on both servers. Any messages posted to
the conference on the local server are replicated in the
conference on the remote server, and vice versa.

Note Deletions are not synchronized between replicated
conferences. Only new and existing items are
replicated. Therefore, if a message in a conference
must be deleted on all servers, the administrator of
the server where the message was deleted must
contact the administrators of all systems where the
replicated conference exists and tell them to also
delete the message. 1 6

Conference replication requires coordination between the
FirstClass administrators on all servers on which the conference
is to be replicated.

To replicate a conference from your server to a remote server,
follow the steps in our online help. To set up two-way
conference replication, follow the steps both on your server and
on the remote server.

Once conference replication has been set up and the remote
server contains a conference with the same name as the
conference you have set up for replication, items in the local
conference will be replicated to the remote conference the next
time the gateway connects.

Remember the administrator of the remote server must also set
up conference replication on the remote site for items in the
conferences on the remote server to be replicated to your local
conference.
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Avoiding replication A replication loop occurs when you replicate a conference to
loops another server, which replicates it to another server, which
replicates it back to your server.

Be careful you do not set up a replication loop. For example, you
might set up the following replication scheme for the Product
News conference:

Conference replication loops

Husky Planes
Boston

Husky Planes
Stockholm

Husky Planes
Takyo

In this example, an item posted in Tokyo is replicated to Boston,
which replicates it to Stockholm, which replicates it back to
Tokyo, which replicates it to Boston.

The FirstClass server detects loops in the item history. When it
finds a loop, it reports a Type 1 replication error (both in the
server window and in the log file), and breaks the loop. (In the
preceding example, the Tokyo server would report such an error
when it receives the item from Stockholm.) When this occurs,
contact the other sites participating in the conference to solve
the problem. (For example, this could be done by removing the
conference alias from the gateway connecting Tokyo and
Stockholm.)

To avoid replication loops, we suggest that you prepare a
diagram of your conference replication scheme. Look for servers
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that can replicate conferences over multiple paths, like Boston
and Tokyo. These two servers can replicate conferences directly,
or indirectly, through Stockholm.

If there are many conferences on your server, and several
different servers in your network, you may find that the
administrators of the other servers may not want or need to
replicate all of your conferences. In this case, you can allow the
other administrators to select only the conferences on your
server that they are interested in. This is called self-serve
replication.

To set up self-serve replication, see our online help.

Whenever you create new conferences or delete old ones,
update your self-serve conference and keep the other
administrators informed.

One of the standard user groups is named Other Sites. This
group contains all gateways and all users on remote servers. You
can use this group to increase daily time limits for your gateways
and you can also use it to prevent users on other servers from
contributing to conferences on your server.

For example, Husky Planes Toronto and Husky Planes Boston
have replicated the Sales Reports conference. Husky Planes
Toronto’s FirstClass administrator does not want users on Husky
Planes Boston to contribute directly to the Toronto conference.
(Normally, they could do so by addressing mail to “Sales
Reports, Husky Planes Toronto”.) The administrator wants
Boston users to contribute to their local conference. Therefore,
the Husky Planes Toronto administrator disallows access to the
conference by the Other Sites user group.

Remember that conference replication involves a certain
amount of communication between the administrators at each
site. Permissions are not passed from one server to the other
during conference replication. All messages in the conference at
the remote site are replicated into your conference, no matter
how you define your local conference permissions. Therefore, if
you are concerned about submissions from users who are
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permitted on the remote conference, but are not permitted on
your local conference, contact the other administrator to try to
make the conference permissions comparable at both sites.

Setting up multisite mail

Using the Multisite Mail feature of FirstClass, you can set up
large distributed mail networks consisting of many servers.
FirstClass automatically decides how to route mail from one site
to another through all of the intermediate server-to-server
gateways.

When a FirstClass server receives a piece of mail destined for
another site, it first determines whether it has a gateway to that
site. If it does, it delivers the mail to the gateway. If it has no
gateway, it checks to see if it has a route to that site. A route is
a pointer to the next gateway on the path to the destination. If it
has a route, it forwards the mail to the gateway specified in the
route.

You can only have a route if you have a gateway to another
FirstClass server which in turn has a gateway or route to the
server that is your final destination. Each intermediary gateway
is called a hop. The complete set of hops required to deliver a
piece of mail to the end-point of the route is called a path. To
add a route, you must first obtain the serial number and site
name of the final remote server. This can be obtained from the
administrator of the intermediary gateway, or from the
administrator of the server to which you are creating the route.

To add a route, see our online help.

Let’s look at the Husky Planes network:
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Baston
Routes to:
Stockholm
Tokya
Landan
Online

Routes to:
Stockholm
Tokyo
Toranto
Online
Gateways to:
Boston
Tokya
Routes to:
Taranto
Londan

Husky Planes
Boston

usky Planes
Stockhalm

Husky Planes
Onling

ateways to:
Boston

Online Routes to;
Gateways to: Stockholm
Tokyo Tokyo
Stockholm Toronto
Tororto Landon

Londan
Online

Online

Gateways to:
Boston
Stockhalm
Routes to:
Toronta

Londan

Online

On a multisite mail network, users can address mail to routes,
just as they can address mail to gateways. For example, a user at
Husky Planes Toronto is sending mail to a user at Husky Planes
Tokyo. The Husky Planes Toronto server delivers the message to
the Husky Planes Boston gateway and Husky Planes Boston
delivers the message to Husky Planes Tokyo.

You can also include remote names in your Directory. Remote
names are Directory entries for users on remote servers. If you
include remote names, users can address mail to the user’s name
only — they don’t need to include the route.

You can add routes and remote names to your Directory
manually, but this method is time-consuming and subject to
error. Instead, you might prefer to use Directory synchronization
to automate the sharing of Directories. Both methods are
described in the following sections.
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Using Directory
synchronization to
automate multisite mail

Directory synchronization
considerations
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Use Directory synchronization to set up automatic multisite mail
in a network. When you designate the users, routes and
gateways on your server that you want to synchronize, and then
enable synchronization, they are added to the Directories of all
the other servers. Users and remote names are defined as remote
names, and gateways and routes are defined as routes.

Directory synchronization uses FirstClass batch administration.
Each server’s Directory is exported from its source server and
imported into the target server using batch administration
commands. For more information about batch administration,
see our online help.

For the steps involved in setting up Directory synchronization,
see our online help.

Consider the following factors before enabling synchronization
on all the servers on your network:

« If your network is large, Directory synchronization can
produce very large Directories, containing many thousands of
names, making them more difficult to use.

* If your servers communicate over expensive connections, the
cost of doing full synchronizations can be high.

« If your Directories are large (2,000 names or more), the
Directory export process can slow down your server. Schedule
exports for a time when server activity is low.

« If your synchronized Directory will be very large (2,000
names or more), you must allocate more memory on your
server. As a guideline, for each session add 10 KB of memory
for every 1,000 names.

« If you want some of the benefits of synchronization, but you
want to limit the size of the lists, you can perform site
synchronization. This produces a smaller synchronization list
because it does not include remote names.

Based on these considerations, you may decide that you don’t
want to set up Directory synchronization on your network. You
can still send mail to users at remote servers by adding and
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Adding gateways

maintaining remote names and routes manually. For more
information, see “Manual multisite mail” on page 180.

You can schedule one of the following types of Directory
synchronization:

Periodic Full Directory Synchronizes your entire Directory, based

Synchronization on a schedule you define.

Demand Directory Synchronizes only when you add or delete
Synchronization an entry in your Directory.

Manual Directory Synchronizes only when you initiate it
Synchronization manually.

If you've decided you want to use Directory synchronization, the
next step is to plan your network. Design a propagation scheme
for your network, like the one in the following illustration, and
be careful not to create replication loops.

Here again is the Husky Planes network, this time with Directory
synchronization enabled (shown as a “D” on each server). 1 6
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Designing your network

Gateways to:
Boston
Tokya

Husky Planes
Boston

usky Planes
Stockhalm

Husky Planes
Onling

ateways to:
Boston

Gateways to:
Tokyo
Stockhalm
Taranto

London

Online
Gateways to:

K Pl Baston
USKY FIENES o ockholm

Note that even though the Stockholm and Boston servers have a
direct gateway, the Directories are replicated through the Tokyo
server to avoid replication loops.

Manual multisite mail The previous section described how to set up automatic multisite
mail on your FirstClass network using Directory
synchronization. If you decide that you do not want to use site
or Directory synchronization, you can still send mail to users at
remote servers by adding and maintaining remote names and
routes manually. These tasks are described in our online help.
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Working with multiple volumes

Large FirstClass systems may require a post office that spans
multiple volumes. Additional volumes can be any hard disks
installed on your computer, and any network drives to which the
computer has read and write access. You cannot use diskettes as
additional volumes. When using Mac OS, you might have
multiple volumes mounted on your desktop. Typically, each
volume corresponds to a physical hard disk. You can also use
disk formatting software to create multiple volumes on a single
physical disk.

This chapter provides information about using multiple
volumes, why you might need multiple volumes, and volume 1 7
statuses.

Why you might need multiple volumes

You might choose to install post offices on multiple volumes in
one of the following situations:

* You have a large FirstClass system.

If you have only a small percentage of your disk available for
use, or you run out of disk space, your FirstClass system may
be too large for its current hardware configuration.

* You want to control the amount of space available to specific
users or conferences.

For example, a FirstClass server might have three volumes:
* internal users located on the master volume

« external users, such as customers and suppliers, on the first
secondary volume

 replicated conferences on the second secondary volume
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Multiple volume
considerations

If either secondary volume becomes full, internal users will
not be affected.

Note A multi-volume post office is more complicated to
administer. There are no performance, reliability,
or feature enhancements if using the multi-volume
feature when it is not needed. You should use a
single volume if possible.

You should remember two things when assigning users and
conferences to volumes:

* When a user sends a message, FirstClass keeps one copy of the
message. This copy stays on the sender’s volume until the
sender and all recipients have deleted it, or until it expires.

 If you are using conference replication, any conference items
received from other servers are stored on the volume
containing the conference.

Users who habitually send large attachments, or post large
messages to conferences, should be assigned to volumes with
ample disk space. Similarly, large, replicated conferences should
be placed on volumes with sufficient free space.

Changing the usage status of volumes

Before you can assign users or conferences to a volume, the
volume must have a status of Full use. When you install your
server, only one volume has that status — the volume on which
you installed the FirstClass server. This volume is the master
volume.

Trash collection is performed only on Full use volumes. The
trash collection task does not check other volumes, even if they
contain post offices. This means, a volume that had a status of
Full use and was later reduced to Limited use or Browse only will
not be checked during trash collection.

You can make Full use of any hard disks installed on your
computer, and any network drives to which the computer has
read and write access. You cannot make Full use of diskettes.
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To change the status of volumes see our online help.

You can add users and conferences to any Full use volume.

If you subsequently change the status of a Full use volume to
Limited use or Browse only, the folder containing the FirstClass
post office is not deleted. The volume will not appear on the list
of available volumes for your system and the volume will behave
as described in the following sections, “Limited use volumes” on
page 183 and “Browse only volumes” on page 183.

When a volume’s status is Limited use, you cannot create new
conferences or users on the volume, but you can create aliases.
The volume will not be checked during trash collection, and
conference information on the volume will not be accessible.
Once all items on the volume expire, the volume will disappear.

When a volume’s status is Browse only, you cannot create any
new users, conferences, or aliases. The volume will not be
checked during trash collection, and conference information on
the volume will not be accessible. Once all items on the volume
expire, the volume will disappear.
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Monitoring your system

One of the most important day-to-day activities you will perform
as administrator is monitoring your system. Understanding the
monitors and log files, and the information they provide will
help you proactively maintain your FirstClass system to avoid
downtime and major restores.

Checking the Server Monitor

The Server Monitor provides information about how your
system is performing by displaying:

» what tasks the server is currently running 1 8
* the current load on your hardware

» asummary of what has happened since the server was last
restarted.

The Server Monitor also provides information about FirstClass
services and mirrored volumes, helping you monitor your entire
FirstClass system quickly and easily from one place.

On the administrator’s Desktop, double-click Monitors and then
Server Monitor to open the Server Monitor form.

The following fields are accessible from all tabs:

Cortral

Refresh interval: | 34| seconds Reset LED=
Refresh Now Click to refresh all values on all tabs of the

form immediately.

Refreshinterval Set the number of seconds between automatic
refreshes.
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Reset LEDs Click to reset the LEDs on all tabs. For further

details, see the individual fields.

Server Monitor -

Summary tab

& Server Monitorn

Server SUmmary
@ FirstClass server

@ Cwerall status

Performance summary

Last server start time:
Current server time:

Server time Zone:

Summary ]Deliveries] Queues] Users] Adivﬂy] Volumes] Files ] Tasks] System]

Husky Planes.com

£.2 Bleta (Build 39)

@ Irternet Services
@ Mirror status

@ “oice Services

Active sessions: 5 430 - Q 0 modem

Task load (%) 13 | @ 735 ps
Dizk load (%) Idle ] 0 ms
Server delay (%) Iddle [~ ] 0 ms

Monday, March 25, 2002 2:09:23 PM
Monday, March 25, 2002 4:59::51 PM
[5MT-5:00) Eastern Time (US & Canada)

Cortrol

Refresh how Refresh interval

14| secands

Reszet LEDs

The server name and software version number are displayed at
the top of the form. This avoids confusion when monitoring
multiple servers on one machine.

FirstClass server The green LED indicates your FirstClass server
is running.

Internet Services The green LED indicates Internet Services is
running. A black LED indicates it is off, or not
installed.

Voice Services The green LED indicates Voice Services is
running. A black LED indicates it is off, or not

installed.
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Overall status The green LED indicates the overall server
components are functioning correctly. If any
LED on any tab of this form is amber or red,
this LED will be also be amber or red and you
should investigate where the problem is on
your system.

Mirror status The green LED indicates mirroring is
functioning normally. A black LED indicates
mirroring is not working, or not configured.

Activesessions  The number of network and modem sessions
currently in use vs. the number of configured
sessions. The LED is green in normal use,
amber when load reaches 90% of capacity, and
red when 100% is reached. The LED will stay
at the highest color reached until you click
Reset LEDs.

If the LED is often amber or red, you should

consider increasing the number of concurrent

sessions allowed on your system. For

information about session limits, see

“Understanding sessions” on page 16. 1 8

Task load The percentage of computer capacity the
FirstClass server is using. The LED is green in
normal use, amber when load reaches 90% of
capacity, and red when 100% is reached. The
LED will stay at the highest color reached until
you click Reset LEDs.

If the LED is often amber or red, you should
consider upgrading your hardware.

Disk load The LED is green in normal use, amber when
load reaches 90% of capacity, and red when
100% is reached. The LED will stay at the
highest color reached until you click Reset
LEDs.
If the LED is often amber or red, you should
consider upgrading your hardware.
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Server delay The LED is green in normal use, amber when
load reaches 90% of capacity, and red when
100% is reached. The LED will stay at the
highest color reached until you click Reset
LEDs.
If the LED is often amber or red, you should
consider upgrading your hardware.

Server Monitor -
Deliveries tab @ Server Monitorn

Summary Deliveries ]Queues] Users] Adivﬂy] Volumes] Files ] Tasks] System]

Message delivery statistics

= . .

M Incremertal Since reset  Since startup
Messages sent: a 16613 16613
Message recipierts: a 2214 214
Confirmed message deliveries: 1 26655 26655

Delivery performance (projected - excludes idle time)
Messages processed per second: a 16 16

Message deliveries per second: a 21 21

Message delivery [ receipt rates

Hew messages read per minute: 20 12 12

Last reset: Wednesday, May 01, 2002 5:51: 30 AW

Cortrol

Refresh Mow Refresh interval: 3 #| seconds Rezet LED=

Messages sent The total messages sent by all users since
lastrefresh (Incremental), since last Reset,
and since startup.

Message recipients The total messages received by all users
since last refresh (Incremental), since last
Reset, and since startup.

Confirmed message  The total number of receipt notifications
deliveries received.
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Messages processed  The total number of messages processed

per second per second since last refresh
(Incremental), since last Reset, and since
startup.

Message deliveries The total number of messages delivered

per second per second since last refresh
(Incremental), since last Reset, and since
startup.

New messagesread  The total number of new messages read by

per minute all users per minute since last refresh
(Incremental), since last Reset, and since
startup.

Last reset: Click Reset to return all values in the Since

Reset column to 0.

Server Monitor - Queues

tab & Server Monitorn E'E'@

Summary ] Deliveries Qusues ]Users] Adivﬂy] Volumes] Files ] Tasks] System]
Message gueue statistics summary 1 8
E_ -2’5 Tl awvaiting i liate delivery:  Mone
Status of immediste message queues
Urgert messages: Emgaty @
Mormal messages: Empaty @
Bulk mezzages: Empaty @
Junk messages: Emmpaty @
Statuz of other message queues
Held mezzages: Empaty @
Delayed mezsages: 11 @
Corntral
Refresh interval: 3 #| seconds Rezet LED=
Message queue The total number of messages queued for

statistics summary immediate delivery.
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Status of immediate
message queues

Status of other
message queues

192  Maintaining your FirstClass server

The current status of the various message
queues. The LED is green in normal use,
amber when load reaches 90% of capacity,
and red when 100% is reached. The LED
will stay at the highest color reached until
you click Reset LEDs.

The capacity of your message queues
depends on the amount of memory you
have. If the LED is often amber or red, you
should consider increasing the amount of
memory on your system.

Some messages to other email systems
and the Internet may not be reachable
immediately. The message is queued for a
later delivery attempt. As well, messages
to other sites that depend on a gateway
connection will be queued until the
gateway connects at its scheduled time.
The LED is green in normal use, amber
when load reaches 90% of capacity, and
red when 100% is reached. The LED will
stay at the highest color reached until you
click Reset LEDs.

The capacity of your message queues
depends on the amount of memory you
have. If the LED is often amber or red, you
should consider increasing the amount of
memory on your system.
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Server Monitor - Users

tab B Server Monitor E'E'@

Summary ] Deliveries] Queues Users ]Adivﬂy] “olumes ] Files ] Tasks] Sys{em]

User status
v

@ Logins since startup: 26

Session limit (kB) per user: 191

Session Monitor

Uszer activity
Login activity: Logout iparent
User activity: Close acdmin
Last login:

Session licenses for remote users

Session licenses in use: oz @)
Control
Refresh Mow Refresh interval: 3 #| seconds Reszet LED=

18

Logins sincestartup  The number of logins on your system since
the server was last started.

Session limit (kB) per  The session memory limit in kilobytes per
user user.

Session Monitor Click to see the Session Monitor. For more
information, see “Checking the Session
Monitor” on page 199.

User activity Information on the most recent login.
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Session Licenses for
Remote Users

Server Monitor - Activity
tab

& Server Monitorn

Background activity

Trash collection:

0%

Batch admin:
0%

Message activity:

Etror summary
Last error reported:

Summary ] Deliveries] Queues] Users Activity ]\f‘olumes] Files ] Tasks] System]

This tab showes activity by the FirstClass servers internal badiground tasks as
opposed to the activity of users on the previous tab.

The total number of session licenses in use
(remote users currently logged in) vs. the
total number of session licenses
configured. The LED is green in normal
use, amber when load reaches 90% of
capacity, and red when 100% is reached.
The LED will stay at the highest color
reached until you click Reset LEDs.

If the LED is often amber or red, you
should consider purchasing additional
session licenses, or changing the most
active Remote users to Regular users.

lelle:

Ielle:

lelle:

1035 Invealicl Password

Sezz 118

Cortrol

Refresh how

Refresh interval:

3 #| seconds

Reszet LEDs

Trash collection
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If trash collection is not currently running,
the status will be Idle.

If trash collection is currently running, the
details will be displayed. The status bar
represents the percentage of completion.
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Message activity

Error summary

ServerMonitor-Volumes

Monitoring your system

If batch admin is not currently running,
the status will be Idle.

If batch admin is currently running, the
details will be displayed. The status bar
represents the percentage of completion.

If a message is in the process of being
delivered (sent/unsent) the activity will
be displayed here.

If trash collection or batch administration
is running, it will be displayed here.

Information on the last error reported by
the FirstClass server.

tab & Serven Monitor, E]|§|@

Summary ] Deliveries] Queues] Users] Activity Yolumes ]Files ] Tasks] System]
“olume information for primary wolume
Pritmary wolume: [ w4
Disk usage: [ | @
597 MBI/ T8 MB
Dizk mirror status: Synchronized and active @
Synchronization progress:
“olume information for secondary volumes
Secondary volumes: :
Disk usage; @
[e=F) GB
Disk mirror status: Mot mirrared @
Synchronization progress:
Cortrol
Refresh Mow Refresh interval: 3 #| seconds Rezet LED=

Primary volume

The name or location of your primary

volume.
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Disk usage

Disk mirror status

Synchronization
progress

Secondary volume

Disk usage
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The amount of used disk space on your
primary volume vs. the total available space.
The LED is green in normal use, amber when
load reaches 90% of capacity, and red when
100% is reached. The LED will stay at the
highest color reached until you click Reset
LEDs.

If the LED is often amber or red, you should
consider increasing the amount of disk space
on the primary volume, using multiple
volumes, or decreasing the disk usage limit,
or expiry limits of users. If the disk usage
increase occurs suddenly, use the Disk Usage
Report, located in the Stats.Dir folder within
the FCPO folder (Windows) or FirstClass
Post Office folder (Mac OS), to isolate the
user with the high disk usage.

The current status of the disk mirror. The
LED is green for an active synchronized
mirror, amber when mirroring is paused,
reconnected or continuing, red if it is
inactive or failed, and black if there is no
mirroring configured.

The status bar indicates the synchronization
status. When it is full, synchronization is
complete.

The name or location of your secondary
volume (if applicable).

The amount of used disk space on your
secondary volume vs. the total available
space. The LED is green in normal use,
amber when load reaches 90% of capacity,
and red when 100% is reached. The LED will
stay at the highest color reached until you
click Reset LEDs.

If the LED is often amber or red, you should
consider how your volumes are configured,
or increasing the amount of disk space on
this volume.
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Disk mirrorstatus  The current status of the disk mirror. The
LED is green for an active synchronized
mirror, amber when mirroring is paused,
reconnected or continuing, red if it is
inactive or failed, and black if there is no
mirroring configured.

Synchronization The status bar indicates the synchronization
progress status. When it is full, synchronization is
complete.

Server Monitor - Files tab __
% Server Monitor g|§|@
Summary ] Deliveries] Queues] Users ] Adivity] Yolumes  Files lTasks] Sys{em]

File statistics (incremental)

L; Opens this period: 4 Filz buffer in use:

Files currently open: 1167 4836 KB/ 16000 KB
Reads Wirites
Reruests: J04 Requests: 12
Cache hits: 100 % Cache hits: 100 %
Transferred: 386 KB Transterred: 781 hytes

18

File totals (totals since reset)

Reads Wirites

Reguests: 70514409 Requests: ar41054
Cache hits: 99 % Cache hits: 99 %
Transferred: 26 GB Tranzferred: 7410 MB

Last reset: Wednesday, May 01, 2002 5:51:30 AM

Control
Refresh Mow Refresh interval: 3 #| seconds Reszet LED=
Opens this period The number of files opened since the last

refresh.

Files Currentlyopen  The number of files currently in use.

File buffer in use The amount of file buffer space currently
in use and the total available.

Reads The number of file reads since the last
refresh.
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Server Monitor - Tasks
tab

Writes The number of writes to files since the last
refresh.

File totals Totals of reads and writes since the last
reset, or the last time the server was
restarted.

Reset Click to reset the data in the Filetotas
fields.

& Server Monitorn

Summary ] Deliveries] Queues] Users] Adivﬂy] Yolumes | Files Tasks ]System]

The information on this tab is intended for use by yvour reseller ortechnical support in
rezalving tachnizal problems you may encountar.

Task statistics (incremental)

Tasks scheduled: 408396 Full task terations: 20445
ldle scheduled: 0 vake due to idle: 1]
11D requests: 139  Async VO requests: 134
"Hat 10" zcheduled: 0 Tazks suspended: EE3

Task statistics (totals zince reset)

lelle schedulad: 47 Wake due to idle: o
10 reuests: ST213565  Async VO requests: 26442665
"Hat 112" scheduled: 1262729  Longest latency (ms): G40

Worker threads (since reset)

Peak workers used: 17 1) 114 Waits for & warker: 1]
Auerage wait: 0  Longest wait: a
Last reset: Wednesday, May 01, 2002 5:51:35 AM {Glokal Reset:
Cortrol
Refresh Mow Refresh interval: 3 #| seconds Rezet LED=

If required, your reseller or Centrinity’s customer support team
may ask for information contained on this tab during
troubleshooting.
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Server Monitor - System )
tab % Server Monitor E|§|@

Summary ] Deliveries] Queues] Users ] Adivity] “olumes ] Files ] Tasks System ]

System status
E windowes NT (Version 4.0, Build 1 381 Service Pack 6

2 processors installed running st 999 MHZ
Server is running as an normal application (not as an MNT service).

lemory summary

Yirtual Memory Physical Memary
4011 hiB tatal 2045 MB tatal
3330 MB available 1804 WMB available

“fou can alse get the information on this tab, plus a complete summany of yoursenrer
configuration, by using the FirstClass Tool's Diagnostics command. FirstClass Tools allows
you to save that information to a text file.

Control

Fefresh Mow Refresh interval: 3 #| seconds Reszet LED=

18

System status Information about the operating system and
installed processors.

Memorysummary  The amount of virtual and physical memory
available.

Checking the Session Monitor

The Session Monitor is a real-time online display showing the
names and activities of logged-in users. To start the Session
Monitor, choose Admin > Session Monitor, or double-click
Monitors and then Session Monitor.

The Session Monitor displays a row for each active session.
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Session Monitor

B Session Monitor: Husky Planes _||’E|E|
File Edit Format Message Collaborate Wiew Admin  Help

=] D[ = £ |Mame [User 1D |#ction  |Lest Object |open Objects [~

E] 100 4% Addminiztrstor achmin Open Monitors ® e =

E Rl Internet 1000000000 Praw 0

B 102+ Intermet 1000000000 Open MailBios: =3

B 10345 Internet 1000000000 Open DeskTop a

ERRIE: ] joe customer jcust Open Address Book =g

B 105} Jack Gerb ierk Open DeskTop [az=15]

B 1064 Internet 1000000000 3
&) 3 .

2 Connection  An icon indicates the connection protocol used
Protocol to connect to the FirstClass server.

ID The session ID. For information, see FirstClass
Tools Reference.

Connection  An icon indicates the type of connection. Note

type that all Internet connections have a single icon
with characters indicating different protocols.
For more information, see the Connection type
icons table.

Kl Empty/Full Indicates whether the user is approaching his
daily connection limit or the inactivity limit.
For information, see Daily connection limit in
our online help.

Name The user’s name.
UserID The user’s user ID.
Action The action the user is currently performing. If

the field is blank, the user has performed no
action in the last minute.

Last Object The last object the user has used.
Open Objects All objects the user has open.

Connection type icons
Mac OS Windows

&

= Gateway = Voice Services

200  Maintaining your FirstClass server



AdMon71.fm

Monitoring your system

v Internet Services G Java

HTTP LDAP
"\.-"H e L

NNTP 1 FTP
#M FTR

Finger IMAP4
#F #' 1

SMTP
#'5

Daily log files

FirstClass creates a log file of the console activities for each day

that the server is active. These files can be helpful in

troubleshooting an ongoing problem. Log files can be viewed

while logged into FirstClass, or by using a text editor if you are 1 8
not logged in.

Log files are named yymmmdd (the date the log file was
created). In Windows, the extension .txt is added. In Mac OS,
there is no extension. These files are stored in the logfiles folder
within the FCPO folder (Windows) or FirstClass Post Office
folder (Mac OS).

For more information about log files and how to view them, see
our online help.

Server statistics files

The server statistics file is a summary of all server events that
have occurred since the server was first installed. This file is
updated after each trash collection. You can view statistics files
using FirstClass or a text editor. You can also import them into a
spreadsheet or database program for processing.
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Viewing a server
statistics file using
FirstClass

Resetting and deleting
server statistics

AdMon71.fm

The server statistics file is presented in standard, comma-
delimited format, and contains the following information:

* Remote user statistics
» Network user statistics
e CLUI user statistics

¢ Server statistics

Server statistics files are named Stats.txt and are in the
STATS.DIR folder within the FCPO folder (Windows) or
FirstClass Post Office folder (Mac OS).

For information on how to view the file from within FirstClass,
or using a text editor, see our online help.

Note We suggest you view a copy instead of the original,
because problems could occur if the application you
use to view the report acts in an irregular manner
and the server is running while you view the file in
its original location.

To reset server statistics, make a backup copy and then delete
the original server statistics file.

You should delete statistics files regularly to maintain disk space
availability. We suggest you back up these files before deleting
them in case you need them later to troubleshoot an ongoing
problem.

Warning Do not delete a statistics file unless you wish to reset
the server statistics counters.

User statistics files

FirstClass lets you collect daily server and Internet statistics on
selected user activities. This can help you see how users are
using their FirstClass environment and may also help when
troubleshooting an ongoing system problem.
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For information about the types of statistics you can track, how
to specify which statistics you want to track and how to view
user statistics files, see our online help.

Disk use statistics

When FirstClass performs a trash collection, it produces a Disk
Usage report. This report records how much hard disk space is
used by each of your users.

Disk Usage reports are named DiskUse.txt and are in the
Stats.Dir folder within the FCPO folder (Windows) or FirstClass
Post Office folder (Mac OS). You can view statistics files using
FirstClass or a text editor. You can also import them into a
spreadsheet or database program for processing. The report
contains a single-line entry for each user with the following
information:

* User ID

 Volume 1 8
» Total Space

* Total Files

» Referenced Space

* Referenced Files

* Privileges.

For information about viewing disk usage reports, see our online
help.

Releasing disk space In your System Profile, you configured the minimum free disk
space required on each volume on your server. When the
amount of free disk space on a volume is less than or equal to
this amount, the server refuses to accept messages from users or
gateways on that volume.

There are several ways you can free up space:

 Use the Disk Usage report to identify users who are using
excessive space. Ask these users to clean out their Mailboxes.
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Note Users should unsend messages with large
attachments and delete the attachments before
deleting the messages.

 Set disk usage quotas.
 Look for and delete files with large attachments.

« Make sure all aliases of a deleted item are also deleted. The
space an item takes up is recovered only when all copies are
deleted. Deleting a large file recovers no space unless the alias
is also deleted from the sender's Mailbox (and from the
Mailboxes of all other recipients).

Open the user’s Mailbox, unsend the message, delete the
attachment, and then delete the message.

» Decrease the expiry period on the System Profile form, Group
Privileges form, or on the Permissions forms of your busiest
conferences.

« Delete old statistics files (see “Server statistics files” on
page 201 and “User statistics files” on page 202) and log files
(see “Daily log files” on page 201). Remember to back up
these files before you delete them, in case you need to
troubleshoot a recurring problem.

To recover freed disk space, trash collection must be run after
files are deleted. You can force a trash collection immediately,
or wait until the next scheduled trash collection takes place.
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Trash collection

Trash collection performs the following important functions in
your FirstClass server:

» removing deleted items,
» removing expired items,
* deleting expired user accounts,

» performing automatic updates and repairs to your FirstClass
server.

The amount of time trash collection takes to run depends on the

size and complexity of your post office. It can range from hours

for a large post office to a few minutes for a small one. To find 1 9
out how long trash collection takes on your FirstClass system,

check the server log files. For information about daily log files,

see “Daily log files” on page 201 and our online help.

By default, FirstClass is set to perform automatic trash collection
once a day (see “Automatic trash collection” on page 207). If
required, you can also force trash collection to run immediately
(see “Manual trash collection” on page 208).

Removing deleted items

The FirstClass server stores only a single copy of each message.
For example, if you send a message to six different users,
FirstClass saves only one copy of the file containing the message
on the server and places a link to that file in each recipient’s
Mailbox. When a recipient opens the link from his Mailbox or a
conference, FirstClass opens the original file on the server. This
method helps reduce disk space requirements when large
messages are sent to multiple recipients.
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When a recipient or the sender deletes the message from his
Mailbox, the actual file is not deleted, only that user’s link to the
message is deleted. A file can only be deleted when there are no
more links to that file. For example, the file for a message sent
to six people is deleted only after the sender and all six recipients
have deleted it.

The undelete command allows users to recover files they have
deleted. However, these files cannot be recovered once trash
collection has occurred. You should inform users of this and of
the time at which trash collection regularly occurs. You might
also want to give users the opportunity to undelete items before
performing a manual trash collection.

Removing expired items

Trash collection also deletes expired files. Every item in your
system has an expiry date — a date after which it will
automatically be deleted from the server. When trash collection
finds a file (or a link) whose expiry date has passed, it deletes
the item. The expiry date is calculated by adding the expiry
period to the date that the item was last edited.

You, as administrator, can set an expiry period for private mail
and conference items in the System Profile. You can also set
specific expiry periods for the entire contents of a conference.
For information about setting conference content expiry periods,
see our online help.

Users can edit the expiry period for individual messages in their
Mailbox using File > Get Info (Mac OS) or File > Properties
(Windows). You can also grant users the Set Expiry privilege
(see our online help), allowing them to set expiry periods for
messages they send. These expiry periods override all previous
settings.

Use expiry periods to avoid disk space shortages. The length of
the expiry period should be based on the amount of disk space
available on your server machine. If you have ample disk space
and low traffic, consider a long expiry period (such as several

206  Maintaining your FirstClass server



AdTrash71.fm

Trash collection

years). If you are short of disk space, use a short expiry period
(such as 30 days).

Trash collection automatically deletes expired items, even if they
have not been read by all recipients.

Removing expired user accounts

You can configure trash collection to delete inactive user
accounts. In the System Profile, specify the maximum period for
which user accounts can be inactive. For more information, see
our online help. User accounts inactive for this length of time or
longer are automatically deleted from your Directory, along with
the contents of their Mailboxes.

FirstClass server updates and repairs

When trash collection runs, a number of log files and statistics
reports are generated about the activity on your system and how
your system is processing data. These log files and statistics
reports are an essential tool in troubleshooting system errors.
For information about these files, see Chapter 18, “Monitoring
your system”, and our online help.

In addition, trash collection makes general system repairs to
your FirstClass server.

Automatic trash collection

FirstClass can deliver messages during trash collection.
However, the trash collection task may slow down your server.
Trash collection cannot be performed on items in use. For these
reasons, you should schedule automatic trash collection for a
time of day when there are usually few users online. By default,
trash collection runs daily at 3:00 AM. Change the scheduled
time on the System Profile.

Note Since trash collection performs repairs to your
system, never disable this function or stop it from
running once it has started.
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If you run out of disk space, you must delete unnecessary files,
ensuring that all aliases pointing to a particular message are also
deleted. (Remember, the file for a message sent to six people is
deleted only when the sender and all six recipients have deleted
it.) The disk space released as a result of these deletions,
however, is not available immediately. To make it available, you
must force a trash collection.

To force a trash collection, choose Admin > Control > Trash
Collection.

We suggest that you disable all logins before starting a manual
trash collection (choose Admin > System Profile, and select
Disable all logins on the Server tab) because sessions on slow
servers might experience communication link failures and be
dropped. Since server performance is decreased during trash
collection, you should only force a manual trash collection when
necessary; usually, it’s better to wait for automatic trash
collection.
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Backing up your server

Knowing how to back up, rebuild, and restore your FirstClass
server in case of emergency are three of your most important
responsibilities as an administrator.

In this chapter we discuss:

» why backups are essential

 backing up your server and post office
« configuring automated backups

« using post office mirroring to simplify server backups.

The next chapter discusses restoring your post office from a 20
backup.

Why you should always be prepared

Since FirstClass is easy to administer and dependable,
emergencies are rare, but should an emergency arise, you must
be prepared to deal with it.

Accidents happen. A power failure or a computer malfunction
could destroy everything on your FirstClass server. Without a
backup, your users could lose important messages and files, and
you could be faced with having to reinstall, reconfigure, and
recreate your entire FirstClass system.

To avoid this complicated task, we recommend that you back up
your system regularly. It’s also wise to back up your server
before upgrading your FirstClass software or your computer
hardware.
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Why should you perform
backups?

Choosing a backup
schedule

There are several instances in which you may require recent
backups, making it imperative that you backup your system
regularly:

e security

The most common reason to do a backup is to guard against
natural disasters, system malfunction, or software bugs. For
example, if you have a hard disk crash and you have not
backed up your FirstClass server to another medium, all of the
information in your system will be lost. This is also true if
there is a disaster at your server site. Fires, floods, electrical
storms, and accidents can all cause partial or total destruction
of your system. Finally, bugs in both application and system
software may cause malfunctions that render your system
unusable. In all cases, planning ahead and backing up ensures
that you will be able to get your system running again as soon
as possible.

hardware or software upgrades

If you are upgrading software (FirstClass or other system
software), changing CPUs, or adding hardware, you should do
a complete backup first in case there are any problems during
the upgrade.

major FirstClass system changes

Before making significant changes to your FirstClass system,
such as adding many users or a gateway, or running a large or
complex batch administration script, ensure you backup your
system completely and have the backup on hand. If you make
an error in the process that is difficult to undo, you can restore
your system to what it was before the error and restart the
process.

Your backup schedule depends on the value of your data, the
likelihood that data will be lost, and the difficulty of doing a
backup. For example, let’s look at the backup schedule of Husky
Planes. The organization’s management has decided that they
cannot afford to lose more than one day’s worth of FirstClass
data. It has set up the following backup process:

 The FirstClass system is backed up to tape every night.
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 Backups are retained for two weeks.

» Every Monday morning, the Sunday night backup is sent to an
off-site storage facility.

 All other backups produced during the two-week period are
stored in a fire-proof safe on site.

We recommend that you store your backup on a different
medium from the one containing your FirstClass system (such as
a DAT tape). If you store your backup on the same drive as your
system, and the drive is damaged, neither the FirstClass system
nor the backup will be available.

Backing up your server

Once you have installed and configured your server, you should
back up the FCPO and FCServer folders (Windows) or the
FirstClass post office and FirstClass Server folders (Mac OS). For
more information about the FirstClass system files and folders,
see “The FCServer/FirstClass Server folder” on page 34.

If you have approved additional volumes, you should also back
up the FirstClass post office or FCPO folder on each of those
volumes. For more information about multi-volume post offices,
see Chapter 17, “Working with multiple volumes”. Mirroring
only needs to be paused while backing up the mirrored post
office and should be resumed when the backup is complete.

Warning Never back up an active server. If you are backing
up the server, shut the server down first.

You should schedule regular backups to ensure that you do not
lose data due to hardware malfunctions or other problems.

Backing up your post office

When you back up your post office, you make a copy of all the
FirstClass data that it contains. This includes messages, the
Directory, and the system configuration.
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You should set a regular backup schedule and store your backup
in a safe place (ideally off-site). You can use any third-party
backup utility, such as Retrospect (Macintosh), or the NT
Backup application (Windows) to back up your FirstClass server.

Make sure you back up the following folders:

* the folder containing the FirstClass post office on the master
volume (the volume on which you installed the FirstClass
server)

* the folder containing the FirstClass post office on any other
approved volumes

+ any additional files or folders you may have modified, such as
the Inetsvcs.fc file and the CONFIG or CGI-BIN folders.

Warning Back up all your volumes at the same time. If you
don’t, some of them might be inconsistent and
therefore unusable when you restore them.

Warning Never back up an active post office. Back up a
paused mirror volume, or shut down the server
before performing the backup.

Automated backup

Automated backup on
Windows

You can automate the backup process using a combination of the
mirroring feature, backup software, scripting software, and the
appropriate commands based on your operating system and
whether you are running the server as a Windows NT service.
For information about mirroring, see “Mirroring your FirstClass
post office” on page 213 and our online help.

You can use the FCUtil utility to automate backups whether you
are running as a Windows service or not. The commands needed
would be FCUTIL PAUSE and FCUTIL CONTINUE. The FCUtil
utility is installed in the same folder as the server executable.
FCUtil supports other commands, allowing you to automate a
variety of features. You can get a complete list of commands and
syntax by opening a command prompt, changing the path to the
path of your executable folder, and entering FCUTIL.
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You can use the AppleScript utility to create a script to control
mirroring and automate your backup process. Select the server
application with your script editor to get a list and description of
available commands.

Mirroring your FirstClass post office

What is mirrored

To simplify your backup procedures and allow you to keep your
server running during backups, you can mirror your post office
contents to the volume of your choice, pause the mirror, then
back up the mirror contents while your server continues to run
normally. The FirstClass server maintains a synchronized system
by continuously building a list of files to copy on the main
volume(s) and copying them to the volume designated to hold
the mirrored content. Your server continuously mirrors
information until you pause the mirror to perform your backup.

If you are running FirstClass as a Windows service, you can use
the PAUSE and CONTINUE commands to perform the pause and
continue functions:

* to pause mirroring, issue the command NET PAUSE FCS

* to resume mirroring, issue the command NET CONTINUE
FCS.

For more information on running FirstClass as a Windows
service, see “Running your FirstClass server as a Windows
service” on page 53.

All the folders in your post office folder are mirrored with the
following exceptions:

» FCPO\SERVER\DBEXT (Windows) or FirstClass post
office:Server:DBEXT (Mac OS)

* FCPO\FCAS (Windows only)
* FCPO\FCRAD (Windows only)

¢ FCPO\NOMIRROR (Windows) or FirstClass post
office:NOMIRROR (Mac OS)

» LogFiles folder
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» Stats.Dir folder

« Internet Services files, such as en.fc and mimetype, which you
may have modified.

For more information about mirroring see our online help.
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Restoring your post office

You should do backups as a matter of course, using the schedule
and media you chose in the preceding chapter. Backups are of
little value, however, unless you know how to use them in case
of emergency.

If a problem with your post office occurs, you can do several
things, in the order listed below, to detect and solve the
problem.

1. If there is a reason to do so, rebuild the Directory using the
standard rebuild procedure. For information on rebuilding
your Directory, see FirstClass Tools Reference.

Warning Never attempt a rebuild without first contacting
your reseller or Centrinity Customer Support.
Failure to do so can cause irrepairable damage to
your post office.

2. If the standard rebuild is unsuccessful, rebuild the Directory
using the advanced rebuild options. For information on
advanced rebuild options, see FirstClass Tools Reference.

Warning Never attempt a rebuild without first contacting
your reseller or Centrinity Customer Support.
Failure to do so can cause irrepairable damage to
your post office.

3. Ifall rebuilds are unsuccessful, you will need to restore your
post office from a backup.

Rebuilds (suggestions 1 and 2) can be performed without using
your backup, but if you need to do a restore (suggestion 3),
you’ll be glad you have it.
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Warning Never use the File > Restore Old User Directory
menu command to restore your post office from a
backup. This is used only in conjunction with a
rebuild attempt.

A restore recreates an image of your post office as it was when
it was last backed up. Any changes made to your post office since
then will be lost. Therefore you should only do a restore when

absolutely necessary. This becomes a larger issue the older your
backup is.

When to perform a restore

There are several situations in which you should restore your
post office from a backup:

« if you try to rebuild your Directory, first using the regular, and
then the alternate index, and both rebuilds fail (which means
that both indices are damaged)

« if the hard drive has failed

If you use a Mac OS, try using a disk utility like the Norton
Disk Doctor for Macintosh (also known as Symantec Utilities
for Macintosh), or Alsoft’s Disk Warrior for Macintosh.

If you use Windows, try using a disk utility like Norton Disk
Doctor or Dr. Watson.

« if you are moving your post office to a new drive.

Performing a restore from a backup
To restore your post office from a backup, follow these steps.
1. Make sure the server is shut down.

2. Copy the following folders from your backup medium to
your hard drive, replacing the existing damaged versions:

* the folder containing the FirstClass server

* the folder containing the FirstClass post office on the
master volume (the volume on which you installed the
FirstClass server)
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* the folder containing the FirstClass post office on any
other volumes you have approved.

3. Although not required, it’s a good idea to rebuild your
Directory after restoring your post office. Follow the
procedure in FirstClass Tools Reference. Be very sure you do
not select any options at the bottom of the form.

Warning Never attempt a rebuild without first contacting
your reseller or Centrinity Customer Support.
Failure to do so can cause irrepairable damage to
your post office.

Selectively restoring objects in your post office

Performing a Selective
Restore

You can selectively restore objects in your post office for your
users. This selective restore feature allows you to use the Export
batch admin command to restore selective items, such as mail,
documents, conferences, folders, and so on, which have been
deleted from your system by trash collection. This feature should
be used sparingly and only in emergency situations, as it takes a
great deal of time and resources.

Warning Before beginning a partial restore, ensure your
entire post office is backed up to another machine.

Once the backup is complete, issue a batch admin export
command to the administrator to individually move items from
the backup to your original post office. The batch admin
command must contain a batch admin script identifying exactly
what you want to restore and how you want to restore it. For
details on using the Export batch administration command,
batch administration syntax, and detailed batch admin
commands and scripts, see our online help.

In FirstClass 6, through batch admin, you can do a selective
restore of entire container objects (conferences, folders,
calendars, etc.) and individual items (Address Book entries,
messages, documents and so on) but not user accounts. Versions
earlier than 6.0 require a full FCPO restore to perform any
recovery.
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Option 1

Option 2

For both options

Note The batch administration section of our online help
contains important information about this feature.
Ensure you have read and understand the
information in our online help before attempting a
selective restore.

When doing a selective restore, you have two options:

Warning Do not perform these steps on the same drive where

your live post office is installed.
Shut down your server and Internet Services.

Copy your FCPO backup to another hard drive and, if the
FCPO folder is named differently, rename it to FCPO.

Map your restored FCPO to a FirstClass server.

Reinstall the server from your CD in the same location as the
restored FCPO.

Go to step 4.

Shut down your server and Internet Services.
Rename your live FCPO folder.

Copy your FCPO backup to the same location as your server
and, if the FCPO folder is named differently, rename it to
FCPO.

Go to step 4.

4.

In the restored FCPO, search for the container or item to
restore. If you already know the names of the items you
want to restore, skip this step.

Note If you are restoring an entire container, for example
a Mailbox or Application Server folder, the
container with the same name must already exist on
your Desktop. We recommend that you create a
temporary container for your restored information
and then drag items from this container to where
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you want them to reside. This avoids the problem of
overwriting or creating duplicates of existing items.

5. In the restored FCPO, start the server, log in as
administrator and send the following Export command to
batch admin:

export desktop <userid> "item" +r

where:
<userid> is the user ID of the user for whom you are
restoring data,

"item" is the container or individual item you wish to
restore,

Note If your item has a space in the name, you must use
quotes (" ") around the item name. Item names are
not case sensitive.

+r (recursive) means to restore all items (do not use this
variable to restore individual items).

Note If you don't use desktop and <userid> in the script,
the server considers administrator the default user.

The remaining steps will be done on your live FCPO. Disable
the restored FCPO and rename your live post office back to
FCPO.

6. Copy and paste the batch admin script into a message on
your live server or forward the batch admin message to your
live server.

7. Replace <objdesc> (angle brackets included) in the batch
admin script with the path to the correct location, and send
the message.

8. Check that the items were restored.

Roy Allen has deleted an important email (Financial Report)
from his Mailbox. Following the steps described above, Husky
Planes's administrator was able to restore Roy's individual item
to his Mailbox. Using the same syntax as in Step 5, the
administrator sent this batch admin script to export to batch
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admin the email item 'Financial Report' located in the user's
Mailbox:

export desktop rallen "Mailbox:Financial Report"

The administrator received the export script from batch admin.
Next, working in the live server, the administrator copied and
pasted the batch admin script into a message and changed the
<objdesc> line to:

SetBase desktop rallen mailbox

to point the batch admin email to the correct path on Roy Allen's
Desktop and restore the email item 'Financial Report' to his
Mailbox. The administrator sent the message to batch admin
and Roy now has his important email back in his Mailbox.

Amanda Clark, another Husky Planes employee, is leaving the
company. She wants to export all of the contacts in her Address
Book to Roy Allen, as he is taking over her responsibilities.
Following the steps described above, Husky's administrator was
able to export to batch admin Amanda's entire Address Book and
send it to Roy. Using the same syntax as in Step 5, the
administrator sent this batch admin script to export to batch
admin Amanda Clark's Address Book, located on her Desktop:

export desktop aclark "Address Book" +r

The administrator received the export script from batch admin.
Next, working in the live server, the administrator copied and
pasted the batch admin script into a message and changed the
<objdesc> line to:

SetBase desktop rallen "Address Book2"

to point the batch admin email to the correct path on Roy Allen's
Desktop where Amanda's Address Book will be copied. Then the
administrator sent the message to batch admin. Remember, Roy
Allan must have a container called "Address Book2" already
created on his Desktop before running the batch script.

Roy now has a complete copy of Amanda Clark's Address Book
and all of the contents that reside within it. Notice that the
temporary container is a different name from the original
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container. This is so Roy's original Address Book will not be
affected in any way. Roy can now pull contacts from the

temporary container and place them in his resident Address
Book at his leisure.
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